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Introduction

Welcome – and thanks for your interest in authoring Beatnik interactive audio.

Quick Start for Editor 2.0 Users: Be sure to review What’s New in Version 2.1.

Note: If you run into difficulty installing, registering, or using the Beatnik Editor, and ca
find an answer in the Online Help or User’s Guide, then contact Customer Support via
Beatnik Web site:

http://www.beatnik.com/?editor-support
This document you’re reading is the Beatnik Editor User’s Guide. It explains how to use the pro-
gram, and includes detailed reference materials and links to further information at the Beat
Web site.

The Beatnik Editor is the leading tool for preparing RMF-format music and sound content f
Beatnik Platform interactive audio players – chiefly the Beatnik Player for Web browsers. It
big program that different kinds of people tend to use in different ways:

Musicians and Sound Designers: Think of the Beatnik Editor as a patch editor/librarian fo
the MIDI synthesizer included in all Beatnik playback software, plus a tool to convert y
samples, MIDI files, and Beatnik patches into RMF format. The Beatnik Editor includes
same synthesizer, with a Live MIDI Input that you can play from a MIDI sequencer progra
or external instrument – just like any MIDI synth in your studio.

Web content designers: Think of the Beatnik Editor as a file converter that turns standar
audio and music files (MP3, WAV, AIFF, AU, and MIDI) into RMF files for use on the W
You can control RMF file playback interactively using the Music Object interface for Ja
cript in Web browsers, or for Lingo in Shockwave and Director movies.

Topics:
How to Read this User’s Guide
About the Beatnik Editor
About Beatnik and the RMF File Format
Where to Go Next? 
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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How to Read this User’s Guide
Nobody likes reading manuals – but we recommend you read through this short Introduction 
before using the Beatnik Editor. 

After the Introduction you can go a couple different ways, depending on your needs and exp
ence level – the Where Do You Go From Here? section will link you to the next information you 
need.

Other Reference sections to be aware of include the FAQ, the Menu Reference and Window Ref-
erence, and maintenance information including Versions and Updates, Troubleshooting, and 
Removing the Beatnik Editor. 

Musicians and sound designers will be interested in Advanced Techniques like Creating Banks of 
Triggerable Samples (RMFX) and Automatic Looping and Track Muting, the list of Built-In Instru-
ments, and the MIDI Implementation Chart.

Beyond this User’s Guide, the Beatnik Web site includes many Online Resources you’ll find help-
ful as you learn to create Beatnik soundtracks. If you’re not sure where to get music and so
content to use in your RMF files, remember that Beatnik publishes a huge library of top-quality 
audio and MIDI content that you can use in your RMF files – available live on the Web for brows-
ing & licensing 24 hours a day, 7 days a week.
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



  

Beatnik Editor User’s Guide / 4

  

tion 

       

 to 
usic 

  

ound 
ng 
ned 

them 
 else-

AV, 
ur 
ingle 

  

 easy as 

      

a 
tnik 

  

 

About the Beatnik Editor
The Beatnik Editor is a powerful program that works a little differently from any other applica
you’ve ever used before. It’s three different things, all at the same time:

• A MIDI- and Audio-to-RMF File Converter
• An Editor/Librarian for Beatnik Instruments
• A Live MIDI Synthesizer

If that sounds like it might be too much stuff to worry about, you can relax – you don’t have
master the whole thing. In fact, most people use the Beatnik Editor strictly for converting m
and sounds into the RMF format – and that part’s easy.

A MIDI- and Audio-to-RMF File Converter
It’s important to understand that the Beatnik Editor isn’t a tool for creating RMF music and s
files from scratch – its Sample Editor is very simple, and there aren’t any facilities for buildi
MIDI songs or editing individual MIDI events (like notes). Instead, the Beatnik Editor is desig
as a tool for collecting your existing MIDI files and audio sample files, and then converting 
into the RMF format for secure, interactive playback on the Web in the Beatnik Player (and
where).

To create an RMF file, you first import your Standard MIDI Files and/or digital audio files (W
AIFF, AU, Sound Designer II, or MP3) into a Beatnik Editor Session document, then add yo
copyright notices, credits, and other information – and finally export the whole bunch as a s
RMF file.
 

Drag-and-drop operation and streamlined processes make converting to RMF as quick and
possible.

An Editor/Librarian for Beatnik Instruments
If you’re a musician, sound engineer, or sound designer, then the Instrument Editor window and 
Sample Editor window are meant for you – they’re the parts of the Beatnik Editor that act as 
patch editor for the expressive and flexible software MIDI synthesizer at the heart of all Bea
Platform players.

The Instrument Editor window is a workspace where you can apply the Beatnik synthesizer’s

Beatnik Editor
Session File

Export

RMF File

Import

Import

Type In

Your Audio
Sample Files

Copyright & Credit
Information

Your
MIDI Files
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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powerful sound shaping capabilities to your own imported sound Samples, and save the co
tions as custom Instruments for use in RMF files. The Sample Editor window gives you tools for 
cleaning up imported Samples, to make them – and the Instruments that use them – sound

A Live MIDI Synthesizer
You can also play the software wavetable synthesizer inside the Beatnik Editor software liv
real time – using either the onscreen keyboard in the Player window, or a MIDI connection from 
an instrument or controller. Or from another MIDI program running at the same time – which
you compose and arrange your music in your MIDI sequencer, using the Beatnik Editor as
sound module, at the same time you’re also editing your instruments in the Beatnik Editor –
all on the same computer, if you want. It’s a much faster way to make MIDI music.
 

Key Concepts
Before we can get very far, it’s important that you understand a few key concepts regarding
Beatnik Editor. 

The Beatnik Editor is Different from the Beatnik Player
You may have heard of the Beatnik Player, Beatnik Xtra, Beatnik Audio Engine, and other B
nik Platform playback software. It’s important to understand that the Beatnik Editor is differ
from these players:

• The free Beatnik Player is Beatnik’s Web browser plug-in. RMF content can be played i
eral different Beatnik Platform players, but more RMF content is created for the Beatnik
Player for Web browsers than any other target (see RMF Playback Platforms). The Beatnik 
Player handles RMF playback with interactive user control, but doesn’t include any file c
ation or editing functions.

• The Beatnik Editor, by contrast, is a professional authoring tool for making RMF files an
custom Instruments and Samples they contain.

Beatnik Editor

MIDI
Input

or other controller

Beatnik

Audio Out

L

R

MIDI
Synthesizer

Onscreen
Keyboard

MIDI
Keyboard

MIDI
Input

Live

MIDI
Sequencer

Program
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The Beatnik Editor is Similar to the Beatnik Player
Despite very different appearances, the Beatnik Player and the Beatnik Editor also have m
common. Both contain the exact same synthesizer engine, and the Beatnik Player comes w
same set of built-in Instruments, Samples, and ‘Groovoids’ you’ll find in your Beatnik Editor
sion documents. Understanding these similarities is very important – they’re the reason wh
sounds you create and hear in the Beatnik Editor are exactly the same as what your audie
hear when your RMF content plays in Web browsers.

Beatnik Editor Session Documents are Different from RMF Files
You already know that the purpose of the Beatnik Editor is to create RMF files, but it’s cruc
remember that the Beatnik Editor’s Session files are different from RMF files.

• Beatnik Editor Session files are the Beatnik Editor’s own file format. They contain, in unpr
tected and (usually) uncompressed form, collections of the music and sound resources 
into the RMF files you create. Whenever you use the New or Save command in the Beatnik 
Editor, that’s a Session file and not an RMF file. When you’ve got those resources soun
the way you want, then you’re ready to export an RMF version of them.

• RMF files are the compressed, encrypted files that you can safely deploy for playback in
browsers, Shockwave movies, and all the other Beatnik Platform players – without riski
your intellectual property. The Beatnik Player never sees a Session file, only RMF files.
export RMF files from the Beatnik Editor.

Guard Your Session Files!
It’s critical to understand that once you’ve converted your music and sound resources into an 
RMF file, you can never extract those resources back out. The original resources for making any
RMF file are kept in Beatnik Editor Session files, so losing the Session file means losing th
ity to make changes to the RMF file.

This means you shouldn’t think you can safely discard your Beatnik Editor Session docume
(.bsn file) once you’ve generated your RMF file and uploaded it to your Web site. If you do, 
later, when you need to change some sound or music for the site, you’ll realize your origina
resources are gone and you can’t make the change! 

The moral of this story is: Never delete your Session documents, back them up regularly, and 
generally guard them against damage or loss.

Import

Import RMF File
Export

Secure, CompressedNot Secure, Not Compressed

Your MIDI Files
Beatnik Editor

Session FileYour Audio
Sample Files
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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About Beatnik and the RMF File Format
Beatnik makes the Beatnik Platform software that works with Web browsers and other prog
and devices to make interactive music and sound possible. We also make software tools fo
paring RMF music and sound content for the Beatnik Platform, and for making it easy for W
page creators and other developers to control Beatnik playback. 

Interactive audio means music, sound effects, and speech that can trigger instantly, or chan
instantly, in response to actions that the user takes while browsing and interacting with you
duction. For example, an audio logo that plays whenever the mouse moves over your logo g
– or a piece of music that changes mood when the user goes to a different page in your We

Beatnik Interactive audio is fundamentally different from the other two basic types of Web audio

• Streaming audio is like listening to a live radio program over the Internet, using 
your computer as the radio. The program is pre-produced and you can only listen, 
not change it as it proceeds – no interactivity. The audio quality is sometimes 
poor or not suitable for music.

• MP3 audio is like collecting CDs, using your computer’s hard drive as your 
record shelf. Audio quality is good to excellent, but you have to deliberately 
select what to listen to, and when. 

With Beatnik Interactive Audio and the RMF format, by contrast, content designers and mus
automatically furnish the listener with whatever soundtrack they want to provide, in high fid
by weaving the music and other sounds directly into the Web pages – with rich control over
the user’s audio experience unfolds as the site is explored. 

Only Beatnik offers this powerful combination of instant response, high quality, and flexible 
control – plus, Beatnik technology keeps the audio file sizes and download times quite rea-
sonable.

These features are available under JavaScript control in Web browsers, under Lingo contro
Shockwave, and in Flash. Beatnik’s Music Object interface enables all our advanced featur
ease the programming burden, exceptional tool support is available in the form of plug-ins 
ActionSets for major Web site authoring packages including Macromedia Director, Macrom
DreamWeaver, Adobe GoLive, and NetObjects Fusion, and several tools generate custom c
paste HTML and JavaScript code.

RMF Playback Platforms
Beatnik Interactive Audio playback is also available to multimedia developers using Director
to software developers using JavaSound, the BeOS, and the Beatnik Audio Engine. Beatni
RMF format is used in the Beatnik Player, Beatnik Xtra, and Beatnik Audio Engine, JavaSo
the Be OS, and set-top boxes including Liberate and WebTV.

All these systems use Beatnik’s unique RMF music and sound file format, Rich Music Format, 
which guarantees identical playback on all players – bridging all differences between comp
processors, and operating systems.
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Where to Go Next?
If you’re... Then go here...

New to music and sound on 
computers

• You might want to start out by visiting the Tutorials page 
on the Beatnik Web site, where basic concepts like digita
audio and MIDI are explained:

http://www.beatnik.com/to?wida

http://www.beatnik.com/to?miditutorial
• Then read Getting Started. It’ll make a lot more sense 

once you have that background.

Experienced with MIDI or 
audio production, but new to 
Beatnik

• Jump straight to For Musicians for an overview of Beat-
nik’s MIDI and sampling facilities.

• Then read Getting Started to see how to use the Beatnik 
Editor to create media to drive them.

• Later you may also want to learn about Advanced Tech-
niques.

A Web developer or Multime-
dia developer

• Proceed to Getting Started. It should explain everything 
you need to know for most uses of RMF you’ll encounter

• You’ll also need to understand how the RMF content you
create with the Beatnik Editor relates to your Web autho
ing world. If you’re working in JavaScript for Web brows-
ers, you’ll need Beatnik’s Web Authoring Documentation 
– or if you’re working in Lingo for Shockwave/Director, 
get familiar with the Beatnik Xtra User’s Guide and, if 
you’re working in Flash, the Flashnik Tutorial.

 http://www.beatnik.com/to/?music-object-doc

http://www.beatnik.com/to/?xtra-doc

http://www.beatnik.com/software/tutorials/
flashnik_authoring.html

A Software developer using 
BeOS, JavaSound or the 
Beatnik Audio Engine

• Proceed to Getting Started, which should cover every-
thing you need to know for most uses of RMF you’ll 
encounter.

• To understand how the RMF content you create with the
Beatnik Editor relates to your programming world, please
consult your BeOS or JavaSound documentation, or the 
BAE Developer Reference.
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Getting Started

Explains the Installation and Registration process, and how to convert files to RMF.

Topics:
Installing the Beatnik Editor
Registering the Beatnik Editor
Using the Beatnik Editor
How Do I...
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Installing the Beatnik Editor
A guide to the Beatnik Editor installation process.

Topics:
System Requirements
Running the Beatnik Editor Installer Program

System Requirements

Mac OS

Minimum system:
• PowerPC Macintosh, 604 processor or later, 180 MHz or better

• System 8.6 or later

• 64 megabytes of RAM - 10 megabytes free for Editor 2.0

• 8 megabytes of free hard drive space for installation

• Netscape, Microsoft Internet Explorer, or AOL Web browser, version 4.0 or higher (for on
help)

• 16-bit or higher color display

Recommended:
• PowerPC Macintosh, G3 processor or later

• Mac OS 9.0.4 or later

• 128 megabytes of RAM

• 15 megabytes of free hard drive space for installation

Windows

Minimum system:
• Pentium Pro Processor, 200 MHz or better

• Windows 95

• 64 megabytes of RAM

• 7.3 megabytes of free hard drive space for installation

• Netscape, Microsoft Internet Explorer, or AOL Web browser, version 4.0 or higher (for on
help)

• 16-bit or higher color display
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Recommended:
• Pentium III Processor, 300 MHz or better

• Windows 98

• 128 megabytes of RAM

• 15 megabytes of free hard drive space for installation

Running the Beatnik Editor Installer Program

The installation steps depend on your operating system:
Installing For Windows
Installing For Mac OS

Installing For Windows
For Windows, the Beatnik Editor installer is distributed as a program called beatnik-editor-2.0-
install.exe.

To install the Beatnik Editor:
1. Launch the installer program, beatnik-editor-2.0-install.exe.

2. Follow the onscreen instructions.

3. If you want to drive the Beatnik Editor’s Live MIDI Input feature with a MIDI sequencer pro
gram running on the same computer, you’ll need to install a free MIDI routing utility suc
MIDI Yoke or HUBI. For detailed instructions, see the section Setting Up for Live MIDI Input

Installing For Mac OS
For Mac OS, the Beatnik Editor installer is distributed as a StuffIt archive file called beatnik-edi-
tor-2.0-install.sit.

To install the Beatnik Editor:
1. Unstuff the file beatnik-editor-2.0-install.sit, using any of the StuffIt utilities from Aladdin 

Systems.

For a free copy of a StuffIt utility, see the Aladdin Systems Web site:

http://www.aladdinsys.com
Unstuffing the file produces an application called Beatnik Editor Installer.

2. Launch the installer program, Beatnik Editor Installer

3. Follow the onscreen instructions.

4. In your Mac OS Memory Control Panel, make sure Virtual Memory is turned off.

5. If you expect to use large Sessions or large amounts of MP3 data in the Beatnik Editor
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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increase the Beatnik Editor’s minimum memory requirement by a few megabytes:

In the Finder, select the Beatnik Editor application icon, and then select Get Info from 
the File menu. In the Beatnik Editor Info window that appears, select Memory from the 
Show: menu, and then increase the number in the Minimum Size: box by a few thou-
sand, and close the Info window.

6. If you want to use the Beatnik Editor’s Live MIDI Input feature, you’ll have to install the Open
Music System (OMS) MIDI routing utility. Performer users will also have to install Free
MIDI. For detailed instructions, see the section Setting Up for Live MIDI Input.

7. If you want to use a Netscape browser to view the Beatnik Editor’s online User’s Guide
Help, be sure Netscape’s minimum memory requirement is set to at least 26,000 K by

In the Finder, select the Netscape application icon, and then select Get Info from the 
File menu. In the Netscape Info window that appears, select Memory from the Show: 
menu, and then type 26000 into the Minimum Size: box and close the Info window.

Note for Beatnik Editor version 1 Users:
Installing version 2 of the Beatnik Editor does not remove your version 1 installation, so
can have both versions on you machine if you like. With both versions installed, you'll 
notice the following behavior:

• Session documents created with version 2 have a new icon.

• Session documents created with version 1 will open in version 1 when double-
clicked in the Finder.

• Session documents created with version 2 will open in version 2 when double-
clicked in the Finder.

• To update a Session document from version 1 to version 2, open it in version 2.

If you want to remove version 1 from your machine – for example, to recover disk spa
just drag the Beatnik Editor Folder to the trash, as well as the BeatnikEditorPrefs file (in the 
Preferences folder, which is inside your System Folder).
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Registering the Beatnik Editor
How to get a Registration Key and enable the Export RMF and Export as Audio features.

When first installed, the freely distributable Beatnik Editor is fully functional – except that th
File menu commands Open, Save, Save As..., Export RMF... and Export as Audio are disabled. 
These features – which are essential for using the Beatnik Editor in professional Web and m
media development – are reserved for users who purchase a Registration Key.

To register your copy of the Beatnik Editor:

1. Using your Web browser, purchase a Registration Key from the Beatnik Web site:

http://www.beatnik.com/to?editor
Follow the instructions on the Web page, and you will receive a Registration Key – a 
sequence of numbers, letters, and dashes that looks something like this:

TX6F-H3RRTF8-Q32U-X9M2D
2. Launch your installed copy of the Beatnik Editor.

A new Untitled Session document window appears.

3. Open the About Beatnik Editor dialog box. This step depends on your operating system:

• On Windows, go to the Help menu and select About Beatnik Editor.
• On Mac OS, go to the Apple menu and select About Beatnik Editor.

4. In the About Beatnik Editor dialog box, click the Register button.

The Registration dialog box appears.

5. In the Registration dialog box, enter your User Name, Email Address, and Registration Key.

Note: Be sure to enter exactly the same User Name and Email Address that you used when 
purchasing the Registration Key, and type the exact Registration Key you received. If even 
one letter is different, the program will not register successfully.

6. Click the OK button.

If the Beatnik Editor detects a problem with your information, it will ask you to re-chec
your entries. Otherwise, your copy will be registered and the Export RMF... and Export as 
Audio... commands will be enabled.

If you run into difficulty registering the Beatnik Editor, then contact Customer Support via th
Beatnik Web site:

http://www.beatnik.com/?editor-support
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Using the Beatnik Editor
An Introduction to the Beatnik Editor, and how to use it for the jobs you care about.

We’ll begin with an Orientation explaining the program’s main windows, and the basics that a
Beatnik Editor users need to know.

We’ve found that Beatnik Editor users fall in two major groups, so we’ve split the rest of this
tion into two parts:

• The fundamentals of RMF conversion are covered first, under two Basic Operation headings.

• People who need to work with the Beatnik Editor’s more advanced features should also
the Advanced Editing section.

If your Beatnik projects don’t call for anything beyond the basics, feel free to skip the Advanced 
Editing section.

Topics:
Orientation

Basic Operation: Converting a Sample File to RMF

Basic Operation: Converting a MIDI File to RMF

Advanced Editing:

The Sample Editor
Working with Instruments
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Orientation
In the Beatnik Editor, you’ll mainly be working with two windows: 

The Player Window and Session Document Windows

Once you understand these windows, you’ll be in a better position to see The Big Picture.

The Player Window
You’ll use the Player window to listen to the music and sound elements going into your RMF
– and to watch them too. Besides the controls, the Player window has real-time displays of
activity in MIDI channels and voices, the audio output, and the CPU load. There’s only one P
window in the Beatnik Editor.

• You can play musical notes by clicking on the keyboard, using any available Instrument
notes play, the keys light up.

• You can play imported MIDI and RMF Songs, and Solo and Mute their channels.

Note: The Mute and Solo buttons control the triggering of MIDI notes on the indicated 
MIDI channel – not the channel’s audio output. As a result, when you turn a Mute butto
the channel’s sound will not return immediately – only when the next MDI note occurs
that channel. In some cases this lag can be fairly long, for example in pieces using slo
pos or long notes. The lag may be especially noticeable if you’re using music pre-mix
ples (such as beat loops) which won’t retrigger until the MIDI file loops.

• You can control the overall playback settings: volume, sample rate, mono/stereo, bit de
and reverb type.

• If you have a MIDI keyboard (or other controller) connected to your computer, or are run
a MIDI sequencer program, the Player window will respond to them, acting as a waveta
synthesizer. As MIDI notes play, the keys light up.

See also: Player window in the Window Reference.

Session Document Windows
The second important window type in the Beatnik Editor is the Session document window. 
can have multiple Session windows open at once if you want, up to the limits of available m
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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Beatnik Editor Session documents are different from RMF files. You’ll use Session docume
manage and develop all the music and sound resources destined for the RMF files you cre
your Songs, Instruments, and Samples. Think of a Session as the workspace where you bu
tom Instruments, audition imported Songs, and manipulate imported Samples.
 

On disk, Session documents are .bsn files:

In the Beatnik Editor, you can manipulate Session documents in many ways:

Beatnik Editor

Export as RMF

RMF File

Custom
Songs

Session
Document Instruments

Custom

Custom
Songs Instruments

Custom

Samples
Custom

Samples
Custom
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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• You can resize the window to show more or fewer items at once.

• To select an item in the Session window, just click on it.

• To select multiple items, shift-click.

• To add single items to the selection, or remove them, control-click (for Windows) or cmd
click (for Mac OS).

• You also can rename, copy, paste, and delete items in any Session window – except th
in Songs and Samples can’t be copied, and none of the built-in items can be modified.

Note: When you copy a Custom Instrument, a dialog box appears, offering the option o
copying the Samples used in that Instrument.

Note: When pasting an Instrument into a Session document would result in more than
Instrument with the same MIDI program number, the Beatnik Editor will renumber the
liding Instruments and alert you.

Topics:
Tabs for Songs, Instruments, and Samples
Access to Built-In Songs, Instruments, and Samples
Within Each Tab, ‘Show:’ Displays a Category
What are Songs?
What are Samples?
What are Instruments?
The Big Picture

See also: Session windows in the Window Reference.

Tabs for Songs, Instruments, and Samples
Each Session document window organizes your music and sound resources under three ta
the tabs on file folders: a Songs tab, an Instruments tab, and a Samples tab. Each tab holds a list of
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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resources – to see what’s inside a tab, just click on it:

To work on any item in the list, you’ll click on it once to select it, and then select a menu co
mand – either from the application menus, or from the context menu.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

Access to Built-In Songs, Instruments, and Samples
Besides the music and sound elements that you’ll import and create in the Beatnik Editor, e
Session document also gives you access to the music and sound resources in the built-in B
Bank – the same resources available in every Beatnik Player for Web browsers – and that’s 
material:
 

Although you can’t edit the built-in Songs, Instruments, and Samples, you can copy the bui
Instruments to use as starting points for your own variations.

Within Each Tab, ‘Show:’ Displays a Category
To help you focus on the right things at the right times, all three tabs include a Show: pop-up 
menu that controls what categories of items appear in the list – for example, in the Samples tab 

Songs Instruments Samples

Beatnik

Samples
73 512 144

(‘Groovoids’)

InstrumentsSongs
Built-In

Resources
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.
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you can view just Custom Samples, just Built-In Samples, or All Samples:

See also: Instrument Bank Organization.

What are Songs?
Songs are stored music performance data. That is, they’re computer recordings of all the in
ual MIDI notes that add up to the performance of a piece of music. Like sheet music, but in
form of lists of events stored in computer memory rather than of notes on a page.

Most Songs are based on Standard MIDI Files that you’ll create in another program (a MID
sequencer) and then import into the Beatnik Editor. (The Beatnik Editor doesn’t include too
editing the individual notes and other events within a MIDI file.) When you import a MIDI file
the Beatnik Editor creates a new Song to hold it.

Note: Built-in Songs are called Groovoids.

What are Samples?
Samples are stored digital audio data. That is, they’re computer recordings of actual sound

Custom Samples Built-In Samples All Samples
(Custom + Built-In)
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sounds at all. Like tape recordings, but made in digital memory instead of on recording tap

Because they’re recordings, Samples can reproduce any kind of sound – music recordings
effects, or speech. That’s why every sound Beatnik makes is stored internally as a Sample
Beatnik playback software comes with a large library of built-in Samples that you can acce

Your own Custom Samples are based on digital audio files (WAV, AIFF, AU or MP3 files) tha
you’ll create in another program (a sound file editor) and then import into the Beatnik Edito
When you import a digital audio file, the Beatnik Editor creates a new Sample to hold it – as
as a new Instrument and a new Song that you can use if you want to play the sample at its
pitch. You can also use the Beatnik Editor’s built-in Sample Editor to further massage the 
imported Sample.

Two things to keep in mind regarding Samples:

• Compression – Unfortunately, high-fidelity Samples tend to be really big – and that can b
problem on the Internet, where bigger files take longer to download. That’s why Beatnik 
several options for reducing the size of the sample data in your RMF files – a wide rang
compression technologies is available (including MP3). Sample compression gives you 
to keep RMF file sizes manageable, and still achieve high fidelity.

• Samples are Accessed through Instruments – In RMF files, you’ll never find a Sample with-
out an Instrument – because Samples are never played directly, only by means of Instru
Even a very simple RMF file made from a Session containing just a single Sample will a
include an Instrument to trigger the Sample.

What are Instruments?
Beatnik Instruments are where Songs and Samples meet. They’re the virtual musical instru
on which the Song’s MIDI notes are played – and their sounds come from playing modified
ples. Like real-world musical instruments, each individual Beatnik Instrument can have a co
pletely unique sound – the only difference is that Beatnik Instruments exist only inside the 
computer.

See also: Instrument Bank Organization.

The Big Picture
The Songs, Samples, and Instruments in your Beatnik Editor Session documents correspo
Songs, Samples, and Instruments in RMF files. Now that you understand about all those p
the following illustration should help you see how all these elements relate to one another a
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eration 
the Beatnik playback software that will play your RMF files.
 

That about covers the fundamentals. Now that you’re oriented, we can explain the basic op
of the Beatnik Editor.

Import

Beatnik Editor

Import

Export as RMF File

Your WAV, AIFF,
AU, SDII Files

Your MIDI Files

Instruments

MIDI Synthesizer

Beatnik
Player

RMF File

Software
MIDI

Bank 2

(Built in Editor)

Custom

L

R

Type In

Session File

Song Info

Songs

Copyright
& Credit Info

Custom
Samples

MIDI Playback
Sequencer

Events

Custom
Instruments

Custom
Songs

Load RMF File

Samples
Custom
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 Basic Operation: Converting a Sample File to RMF
The most frequent use of the Beatnik Editor is to convert a digital audio sample file into the
format. This involves importing the file into a Beatnik Editor Session file, typing in any desir
copyright and credit information, and exporting as an RMF file. In most cases you’ll also wa
compress the sample.

Here’s how, in six easy steps:

1. Launch the Beatnik Editor.

Double-click the Beatnik Editor program icon on the desktop. The program will launch, d
play the splash screen, and create a new Untitled Session window. You’ll use this Session 
document to hold audio content for your RMF file, then Export as RMF.

2. Import your digital audio file into the Session.

Drag your file from the desktop into the Songs tab of the Untitled Session window. (You 
could also select the Import command from the File menu, or drag it in from another Sessio

Beatnik Editor
Session File

Import

Export
Your Audio
Sample File

Type In

Copyright & Credit
Information

RMF File
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The import produces a new Sample in the Untitled Session document, and a new Instrumen
and a new Song – all with the same name as your audio file.

3. Play your newly imported Song, as a check.

In the Songs tab of the Untitled Session window, select your new Song; then go to the 
Player window and click the Play button. You should hear your imported sample playing 
not, see the Troubleshooting section). To stop before the Song plays all the way to the en

Songs Instruments Samples
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click the Stop button.

4. Compress the Sample.

In the Samples tab of the Untitled Session window, select your newly imported Sample, 
then select Compression from the Sample menu. The Compression dialog box will appear, 
offering many data compression options:

Each of these compression types presents a different size vs. quality trade-off, and ea
is useful for a different kind of sound material. As you become more familiar with the B
nik Editor you’ll learn more about the compression types – but for now, just select MPEG I 
layer 3, 128k bits from the list, and then click the OK button.

5. Add your copyright notice and other text information.

Every Song can include a copyright notice and other ‘meta-data’ describing the Song.
information is encrypted into RMF files that include the Song, and can be displayed w
the Song is played on the Web in the Beatnik Player. To enter this data for your RMF fi
to the Songs tab of the Untitled Session window, select the newly imported Song, and the
select the Song Info... command from the Song menu. The Song Info dialog box will appear, 
with fields where you can enter a copyright notice and other text information for the R

Play buttonStop button
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file:

Fill in the info for your Song, and then click the OK button.

Note: If you want to change the Song’s title, or set playback volume or tempo, or 
reverb type, a separate Song Settings dialog box is also available from the Song menu.

6. Export the Song as an RMF file.

Go back to the Songs tab of the Untitled Session window, make sure your new Song is stil
selected, and then select the Export RMF... command from the File menu. 

The Export RMF File dialog box will appear, asking which Instruments to include in 
the RMF file. Click the Custom button, and then click the OK button.

When the Save RMF File dialog box appears, set your desired name and location for the
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exported RMF file, and then click Save:

When you Save, the Beatnik Editor produces your RMF file:

That’s It – You’re Done!
You’ve just successfully created an RMF version of your sound file. You can play your new 
file with any Beatnik Platform player – including the Beatnik Player for Web browsers, the B
nik Xtra for Shockwave and Director, BeOS, and JavaSound for Java2 – with the same hig
ity sound on every platform.

Remember, though: RMF files are encrypted, so after creating one you can’t open it later
further editing. To ‘change’ an RMF file, you’ll have to go back to its Session documen
make your changes to the individual Songs, Instruments, or Samples, and then Export RMF... 
again – replacing the previous RMF version.

You may want to spend a little time getting familiar with generating RMF files – feel free to 
experiment with importing different kinds of digital audio files. When you’re finished, go on 
the next section.
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 Basic Operation: Converting a MIDI File to RMF
The second most frequent use of the Beatnik Editor is to convert a Standard MIDI File into 
RMF format. This is similar to converting an audio sample file to RMF, but even simpler. Th
basic steps remain the same: Import your MIDI file into a Beatnik Editor Session file, then ty
any desired copyright and credit information, and finally export as an RMF file.

Here’s how, in five easy steps:

1. Launch the Beatnik Editor.

Double-click the Beatnik Editor program icon on the desktop. The program will launch, d
play the splash screen, and create a new Untitled Session window. You’ll use this Session 
document to hold MIDI content for your RMF file, then Export as RMF.

2. Import your MIDI file into the Session.

Drag your MIDI file from the desktop into the Songs tab of the Untitled Session window. 
(You could also select the Import command from the File menu, or drag it in from another 
Session document.)

The import produces a new Song in the Untitled Session document, with the same name a

Beatnik Editor
Session File

Import

Export
Your

MIDI File

Type In

Copyright & Credit
Information

RMF File
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your file.

3. Play your newly imported Song, as a check.

In the Songs tab of the Untitled Session window, select your new Song, then go to the 
Player window and click the Play button. You should hear your imported file playing – if 
not, see the Troubleshooting section. To stop before the Song plays all the way to the en
click the Stop button.

4. Add your copyright notice and other text information.

Every Song can include a copyright notice and other ‘meta-data’ describing the Song.
information is encrypted into RMF files that include the Song, and can be displayed w
the Song is played on the Web in the Beatnik Player. To enter this data for your RMF fi
to the Songs tab of the Untitled Session window, select the newly imported Song, and the
select the Song Info... command from the Song menu. The Song Info dialog box will appear, 
with fields where you can enter a copyright notice and other text information for the R

Play buttonStop button
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Fill in the info for your Song, and then click the OK button.

Note: If you want to change the Song’s title, or set playback volume or tempo, or 
reverb type, a second Song Settings dialog box is also available from the Song menu.

5. Export the Song as an RMF file.

Go back to the Songs tab of the Untitled Session window, make sure the new Song is still 
selected, and then select the Export RMF... command from the File menu.

The Export RMF File dialog box will appear, asking which Instruments to include in 
the RMF file. Click the Custom button, and then click the OK button.

When the Save RMF File dialog box appears, set your desired name and location for the
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exported RMF file, and then click Save:

When you Save, the Beatnik Editor produces your RMF file:

That’s It – You’re Done!
You’ve just successfully created an RMF version of your MIDI file. You can play your new R
file with any Beatnik Platform player – including the Beatnik Player for Web browsers, the B
nik Xtra for Shockwave and Director, BeOS, and JavaSound for Java2 – with the same hig
ity sound on every platform.

Remember, though: RMF files are encrypted, so after creating one you can’t open it later
further editing. To ‘change’ an RMF file, you’ll have to go back to its Session documen
make your changes to the individual Songs, Instruments, or Samples, and then Export RMF... 
again – replacing the previous RMF version.

You may want to spend a little time getting familiar with generating RMF files – feel free to 
experiment with importing different kinds of MIDI files. When you’re finished, exit the Beatn
Editor.
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Advanced Editing
Advanced Editing means anything beyond the simple RMF file conversions just described u
Basic Operation.

There are two major areas here:

The Sample Editor and Working with Instruments.
Note: To get much use out of the Beatnik Editor’s advanced features, you’ll need 
understand the basic concepts of MIDI files and digital audio files. If these terms
new to you – or if you could use a refresher – you might want to visit the Beatnik 
site to read two Tutorials: What is MIDI? and What Is Digital Audio?

http://www.beatnik.com/to?miditutorial

http://www.beatnik.com/to?wida
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 32

’s why 
 on 

t 
ample 
any 

n 

s the 
the end 

and 
l will 

rding 

g 
 and 
ample   
The Sample Editor
Producing high-quality music and sound playback requires high-quality Samples – and that
the Beatnik Editor includes a basic Sample Editor. It’s a workspace for doing clean-up work
your imported Samples, for use in Instruments for your exported RMF files.

Just a Simple Tool – While the Beatnik Editor’s Sample Editor may help you learn how to edi
sounds creatively, it’s intended mainly as a convenience tool. If you need to do extensive s
editing, you’ll probably prefer to use a separate full-featured sample editor program – or, m
people like to use cleanly prepared samples obtained from a professional source.

See also: The Sample Editor window section in the Window Reference, and the Editing 
Samples section in For Musicians.

Why Edit a Sample?
The Sample Editor gives you editing tools good for fixing several common problems that ca
make a Sample sound bad:

• Dead Space – Samples should usually start at the first audible sound, and end as soon a
sound is completely over. Dead space at the start throws off timing, and dead space at 
wastes memory and download time.

• Clicks – A sample should smoothly begin and end with silence, even if the initial fade-in 
terminal fade-out are very short. Any sample that starts or ends away from the zero leve
produce a click.

• Low Level – A sample should usually be normalized – that is, the highest peak in the reco
should take full advantage of the available range. Small signals produce weak sound.

Loops are another reason to use the Sample Editor. In order to be able to hold arbitrarily lon
notes, Instrument designs often require a section of a Sample to loop – that is, repeat over
over – for as long as the note is held. The Sample Editor gives you control over whether a S
will loop, and where in the Sample the loop start and end bounds should be.
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Working with Instruments
The Beatnik Editor includes an Instrument Editor – a workspace where you can build your own
custom musical Instruments for use with your RMF songs. You build Instruments by combin
Samples – usually recordings of musical instruments or tones – with musical sound shapin
cesses like envelopes, filters, and modulators.

See also: The Instrument Editor window section in the Window Reference, and the Editing 
Instruments section in For Musicians.

How Instruments and Samples are Related
The Beatnik playback software uses the MIDI wavetable synthesizer technology, which defi
the relationship between Instruments and Samples.
 

• All Instruments are based on Samples – Every Instrument uses at least one Sample.

• An Instrument can use Multiple Samples – An Instrument can use up to 128 Samples. In th
illustration above, Instrument 1 uses one Sample, Instrument 2 uses two Samples, and
ment 3 uses three Samples. You’ll assign each Sample to a MIDI note range with the Ke
page of the Instrument Editor.

Instrument 3

Instrument 2

Instrument 1

Sample Y

Sample Z

Sample W

Sample X

Sample V
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• Instruments and Samples are Independent – Separate Instrument and Sample pools are 
present in Beatnik Editor Session files and RMF files, and any Instrument you create ca
any Sample(s) – including built-in General MIDI and Beatnik Special Samples.

• Multiple Instruments can share the same Samples – For example, Sample X is used by both
Instrument 2 and Instrument 3.

• Samples can only be played by means of Instruments – To use your own Sample in an RMF 
file, you’ll need to import the sample into your Session document and use it in an Instru
This is necessary because RMF doesn’t provide any way to play Samples directly. The 
way to play a specific Sample is to play a MIDI note on an Instrument that uses that Sa
That note can come from playing the RMF file’s Song, or by way of the Music Object 
noteOn()  or playNote()  methods. (The only place where this dependency on Instrumen
doesn’t exist is in the Sample Editor window, when you’re working on the Sample directly.)

• Instruments can modify the pitch and sound of Samples – Most Instruments will play a Sam-
ple at different pitches, depending on the MIDI note being played. Instruments can also
dynamically shape the sound by applying volume envelopes, filtering, moving the sound
between the left and right speakers, and altering the pitch independent of the note bein
played. The Instrument Editor pages contain all the controls for the processing and modific
tion blocks available in each synthesizer voice:

 

Technically, an Instrument definition is a collection of settings for these same synthesizer v
blocks – the set of Samples needed for an Instrument, the Keymap that specifies what Sam
use for each received MIDI note, and the values to use for all the block parameters. 

Instrument Bank Organization
Like many musical instruments, the Beatnik playback software includes built-in Instrument 
nitions – in this case, over 300 of them. Instruments are divided into three Banks: the built-in
eral MIDI and Beatnik Special Banks, and the Custom Bank space for Instruments that you
and included in your RMF files.

Each Bank consists of two sets of 128 Instruments each. Melodic Instruments are numbere
127, and are ‘normal’ Instruments that can be played at pitches ranging across the keyboa

The Percussion Instruments are treated differently. The 128 Percussion Instruments in eac
make up a ‘drum kit’ that puts a different Instrument on each of the 127 MIDI note numbers
with Percussion Instruments, playing different notes produces different Instruments, instea
playing a single Instrument at different pitches. This Percussion behavior is a part of the Ge

L

R

.
Sample

Pitch

Keymap Filter

Sample

..
Volume

Freq ToneQ Volume

Envelope Output

Pan

Modulators

Synthesizer Voice
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MIDI standard, and is ordinarily used only on MIDI channel 10; however, in Beatnik playbac
software any set of MIDI channels can use it (see MIDI Channel Modes).

Bank Number and Name Built-
In? Description

Bank 0: General MIDI Melodic Yes The first bank is organized according to
the General MIDI specification, for 
compatibility with all Standard MIDI 
Files.

Percussion

Bank 1: Beatnik Special Melodic Yes The second bank is organized similarly 
to the GM bank, but includes unique 
sounds beyond the GM set, and Web-
appropriate sound effects, all created by
Beatnik artists.

Percussion

Bank 2: Custom Melodic No The third bank provides room for your 
own Custom Instruments, including 
variations on the built-in instruments.Percussion
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How Do I...
Quick-Start tips for the most common Beatnik Editor tasks.

Topics:
How Do I...
...Get some Help?
...Make an RMF File from a WAV or AIFF file?
...Make an RMF File from a MIDI file?
...Link the Beatnik Editor with my MIDI Sequencer?
...Make my own Instruments?
...Change the Built-In Instruments?
...Change the Built-In Samples?
…Get my MIDI and Digital Audio Files into my Session?
...Make my Samples Smaller?
...Enter my Copyright Notice?
...Enter the Song Title and Performer Credits?
...Encrypt / Protect my Music?

...Get some Help?
If you run into difficulty installing, registering, or using the Beatnik Editor, and can’t find
answer in the Online Help or User’s Guide, then contact Beatnik Customer Support vi
Beatnik Web site:

http://www.beatnik.com/?editor-support

...Make an RMF File from a WAV or AIFF file?
Follow the steps above, under Basic Operation: Converting a Sample File to RMF.

...Make an RMF File from a MIDI file?
Follow the steps above, under Basic Operation: Converting a MIDI File to RMF.

...Link the Beatnik Editor with my MIDI Sequencer?
Follow the steps for your sequencer in the Linking to Your Sequencer section.

...Make my own Instruments?
Create a new Custom Instrument in the Instruments tab of your Session document, then ed
it with the Instrument Editor (select the Instrument, then select Edit Instrument from the 
Instrument menu). For advice on making better Instruments, see Editing Instruments.

To use your own Samples in the Instrument, you’ll first have to import them into the Sam-
ples tab of your Session document.
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...Change the Built-In Instruments?
Strictly speaking, you can’t edit the built-in Instruments – but you can do something al
as good. Just copy any built-in Instrument to your Custom Instrument bank, then make
changes to the copy, and include the instrument in your exported RMF file. You’ll be sta
from the exact same high-quality Instrument used in the Beatnik Bank files for the Bea
Player, Beatnik Xtra, and the other Beatnik Playback player software. This is a good w
keep your RMF files small – your Instrument can use the built-in Samples, without havi
include them in your RMF file.

...Change the Built-In Samples?
Sorry, you can’t copy or alter the built-in Samples – although you can create your own
instruments that use them in ways different from the built-in Instruments (see previous
item).

…Get my MIDI and Digital Audio Files into my Session?
There are several ways to import MIDI and audio files into your Session:

• Drag any number of MIDI files and/or audio files from the desktop into the Ses-
sion window. (To import MIDI, the Songs tab must be showing.)

• Go to the File menu and select the Import command, the use the dialog box to 
navigate to any directory and open any number of MIDI and/or audio files.

• Drag a Song, Instrument, or Sample from one Session window to another Session 
window.

• Copy a Song, Instrument, or Sample in one Session window, then Paste it into 
another Session window.

Importing a file creates one or more new items in your Session document:

• Importing a MIDI file into a Session produces a new Custom Song.

• Importing an RMF file into a Session produces an Imported RMF Song – a special 
kind of Song that can only be played, not edited, due to the security of the RMF 
format. This is useful mainly for testing exported RMF content.

• Importing an audio file (MP3, WAV, AIFF, or AU) into a Session produces a new 
Custom Sample.

If the Instruments tab of the Session window is showing at the time, the import als
produces a new Instrument that uses the newly imported sample.

If the Songs tab of the Session window is showing at the time, the import also pro
duces both an Instrument that uses the newly imported sample and a Song that 
that Instrument at the Sample’s natural pitch for the duration of the sample. This 
makes it easy to convert a sample to RMF: to hear the sample at its natural pitch
you have to do is play the RMF file.
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...Make my Samples Smaller?
You can make a Sample smaller by:

• Using the Compression... command in the Sample menu.

• Using the Sample Editor window to reduce the Sample length by trimming away 
unnecessary material from your sample’s attack, loop and release segments.

• Converting stereo Samples to mono in another sample editor program.

• Reducing the sampling rate in another sample editor program. Although Beatnik 
supports sample playback rates as high as 44.1 kHz, in many cases you can get 
acceptable results with 22kHz or lower rates. 

• Limiting the number of Custom Samples used in each Song.

Note: Reducing the number of bits from 16 to 8 isn’t recommended, unless you re
like junky sound. Data compression (see above) will give you far greater space sa
and much better sound than linear 8-bit audio provides.

...Enter my Copyright Notice?

...Enter the Song Title and Performer Credits?
In the Songs tab of your Session document, select your Song and then select Song Info... 
from the Song menu. The Song Info dialog box will appear, where you can enter your text
information for the exported RMF file.

...Encrypt / Protect my Music?
You don’t have to take any extra, special steps to protect your music – whenever you’
working in Beatnik, that’s automatic. Every RMF file you create is always encrypted.
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For Musicians

Worried it might be hard to make music with Beatnik? Well, relax – if you’ve done any MIDI 
duction, you already know almost everything you’ll need to know to get great results. This For 
Musicians section will explain the rest, one topic at a time:
 

Heading... Covers...

Orientation Basic concepts of the Beatnik musical environment

The Beatnik MIDI Playback 
Sequencer

How the programmer controls the playback sequencer

The Beatnik MIDI Synthesizer Playing it, special features, creating Instruments

Production Technique Tips General guidance on making music for Beatnik
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Orientation
Producing music and sounds for Beatnik is a lot like working with a small MIDI studio. The B
nik software gives you a playback-only MIDI sequencer, a 64-voice multi-timbral stereo MID
wavetable synthesizer, and a mixer with reverb and chorus effects.

The Beatnik MIDI Synthesizer comes with built-in Banks containing hundreds of Instrumen
patches and Samples. You can also use your own Custom Instruments, which you create w
Beatnik Editor, based on built-in Samples, your own custom mono or stereo Samples, or b

Custom Samples can be anything from short instrumental sounds to long audio mixes, with
taining loops if you want. (Long custom Samples are good for adding vocals to a MIDI piec
for building interactive multi-track audio remixers.)

Key Concepts
While many aspects of Beatnik will be pretty familiar, you should keep a few new concepts
mind:

The Beatnik MIDI Synthesizer
• The Beatnik Editor includes the Beatnik software synthesizer – and you can play it in re

time using MIDI as you work on your composition and arrangement in your MIDI seque
or play your controllers. This ensures that the music your listeners hear will be the mus
intended. (See Linking to Your Sequencer.)

• The Beatnik synth can be “played” by several different things at once: by your musical s
or by programming on your Web site, game, Shockwave movie, etc. Even if more than o
source is triggering notes, there’s just the one synthesizer to play them all. So, program
changes on a given MIDI channel will affect all notes played on that channel, regardless
where those note messages “came from.” 

• The same is true for mixer volume, pan and effects settings, such as reverb. If your seq
assigns a reverb send level to a particular channel, sounds played through the same cha
the Web page will share the same reverb settings.

Beatnik Beatnik MIDI Synthesizer
Wavetable   64 voice

Beatnik

Reverb & ChorusSequencer

L

R

64 x 2MIDI

The Beatnik Playback Software includes all this:

Stereo Multitimbral
Audio MixerMIDI Playback

Space for
Custom Bank

Built-In
Banks
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The Beatnik Editor
• The Beatnik Editor provides sequence playback only, not MIDI recording or editing, so y

won’t build your composition in the Beatnik Editor. Instead, you’ll create your music in so
other MIDI sequencer program, export the sequence as a Standard MIDI File, and impo
MIDI file into your Beatnik Editor Session document. The imported MIDI file becomes a 
Song in your Session.

• In addition to the imported MIDI notes, you can assign each Song a mix level and reverb
to use when played.

• You can also use the Beatnik Editor to modify the built-in Instruments, or to add new Sam
and create your own palette of sounds – essentially, as a patch editor/librarian for Beatn
Instruments. You probably know that large Samples can produce slow downloads – and
why Beatnik also gives you data compression tools for juggling each Sample’s size aga
quality, to find the best trade-off for each one.

RMF Files
• All Beatnik playback software is optimized to play Rich Music Format files (RMF) – and the 

purpose of the Beatnik Editor is to create them. A typical RMF file includes your MIDI fil
and any custom Instrument patches and Samples you’re created for that song. RMF file
also embed copyright, licensing information, composer and performer credits, and simil
information. The entire RMF file is encrypted, to help you control your intellectual prope

• You’ll deliver your music and sounds as RMF files, not audio recordings like DAT, CD-R
WAV files, etc. (Actually, you can export digital audio versions of your Beatnik songs from
the Beatnik Editor – but the files get huge, and they’re not interactive. RMF is almost alw
the better choice.)

• For Beatnik on the Web, a webmaster will place the RMF files you create onto the Web 
and add commands to its Web pages so that your music and sounds trigger and play as
users browse the site. (If you’re versatile, the webmaster may be you!)

Interactivity
• Interactivity is a major element of Beatnik. Your Song can play the same way each time

(yawn), or it can change dynamically in response to your listener’s actions (wow!). For e
ple: special sounds triggered by mouse-clicks, or musical arrangements that change dy
cally over time.

• Interactivity is not defined in the Beatnik Editor. Instead, the programming that makes up
Web site, movie or game will monitor the user’s actions and send commands to the Bea
Player. These commands (in JavaScript, if you’re interested) can mute or unmute MIDI 
tracks or MIDI channels, trigger built-in or custom sounds, start or stop song playback, 
much more. See Playing the Beatnik MIDI Synthesizer.

• Unless you’re a programmer as well as a musician, the interactive control of your Song
probably be implemented by someone else. You’ll hand off RMF files to your programm
Web page author, along with suggestions on where and how each Song should be used
ing involved and maintaining good communication with your programmer is critical to 
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achieving good interactive results!

• It’s possible to create an RMF file that has only Instrument and Samples, but no musica
(no MIDI file). This would be appropriate when the Web site needs to play sound in resp
to user actions, but doesn’t use a traditional music track. This form of RMF file is called
RMFX.

That’s the high-level view of what working with Beatnik is like for a musician. The rest of thisFor 
Musicians section explains all the details.
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The Beatnik MIDI Playback Sequencer
All Beatnik player software includes a simple MIDI sequencer that’s used to play back the 
imported MIDI files embedded in your RMF files.

Because this is a playback-only sequencer, there’s no way to record or add new tracks, no
other MIDI events while a Song is playing. There’s also no way to directly control starting, s
ping, pausing, or resuming from within your MIDI file.

The sequencer’s ‘transport controls’ are instead handled with the Music Object programmin
interface – in JavaScript for Web pages, or in Lingo for Director, Shockwave, and Flash pro
(C and C++ developers can achieve the same results with the Beatnik Audio Engine Client
It’s completely up to the Web page developer, Director author, or C/C++ developer to tie the 
actions to the musically correct starting and stopping operations. In other words, the progra
mer’s the one who gets to press the ‘play button’. RMF files are usually made to start playin
immediately upon loading, but the programmer has control over that too.

This means that your MIDI file is essentially a resource that gets used by the playback seq
– the MIDI file doesn’t get to touch the transport controls on its own.

Note: To a designer of interactive music, that means that nearly all interactive, adaptive
effects will have to be achieved using just the tracks, notes, and other MIDI events sto
the Standard MIDI File – basically, you need to put all your dynamic variations and alt
tives into the MIDI file, and rely on interactive track and channel muting to control whic
parts are exposes and when. This muting and unmuting is also controlled not from the
file itself, but with the Music Object interface (or Beatnik Audio Engine Client API). Aga
the Web page developer, Director author, or C/C++ developer must make the musical
rect link between user actions and muting and unmuting operations.

Tip: The one exception to this rule of developer control is the Advanced Technique we call 
Automatic Looping and Track Muting. This involves using your MIDI sequencer program 
place certain markers and MIDI controller events in your MIDI files before you import th
into the Beatnik Editor. When the Beatnik Audio Engine encounters these items in RM
files, it interprets them as embedded ‘instructions’ that define the starts and ends of lo
regions, and then selectively mutes and unmutes a different set of your tracks at each
through the loop. (See Automatic Looping and Track Muting for the details).

L

R

Beatnik Beatnik

Sequencer

MIDI
MIDI Playback MIDI Synthesizer

RMF File

MIDI File
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The Beatnik MIDI Synthesizer
All Beatnik playback software uses the same sound generator: a high-quality, multitimbral w
able synthesizer implemented completely in software. It includes a built-in General MIDI so
set Bank, plus a ‘Beatnik Special’ Bank of more interesting alternatives. You can also creat
own Custom Instruments using either the built-in Samples or your own Samples. The synth
respond independently to all 16 MIDI channels, with a separate Instrument for each chann
up to 64-voice polyphony.

You can think of the Beatnik Editor as patch editor/librarian for this synthesizer – you’ll use
Beatnik Editor to create your own Custom Instruments and variations on the built-in ones. Y
collect Beatnik Instruments and Samples in your Beatnik Editor Session documents, and w
them using the Beatnik Editor.

The rest of this section explains all the details of working with the Beatnik MIDI Synthesizer
ken down by topic:

Heading... Covers...

Synthesizer Voice Architec-
ture

The Keymap, Envelopes, Filter, and other elements that ma
up the synth voice

Playing the Beatnik MIDI 
Synthesizer

High-level view of how the synthesizer responds to MIDI – 
from RMF files or from live MIDI input in the Beatnik Editor

Instrument Bank Organiza-
tion

Including a quick survey of the built-in Instruments

Controlling the Mix How to control level, pan, and effects

MIDI Implementation Low-level details of how the synthesizer responds to specifi
MIDI messages

Building Your Own Patches High-level view of how Instruments and Samples are orga-
nized, and how to work with them in the Beatnik Editor

Editing Instruments Specific techniques for improving your patches

Samples

Beatnik MIDI SynthesizerMIDI In

Bank 0 Bank 1 Bank 2

Audio Out

General
MIDI
Bank

Beatnik
Special
Bank

Custom
Instrument

Bank
Instruments

Built-In Custom
SamplesSamples

L

R

RMF
File

Your
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Synthesizer Voice Architecture
Like all wavetable synthesizers, Beatnik Instruments are created by combining one or more
ples, spread across the keyboard. A large number of built-in Samples are provided, and yo
also add your own. Samples are played through a resonant Comb Filter, a Volume Envelope
Pan control into Beatnik’s internal mixer.

Modulation
Up to five modulators per voice are also available – and they’re really flexible. Each modula
has two sources: an LFO (low-frequency oscillator) and an envelope. You can pick just the L
just the envelope, or use both with the envelope acting as an LFO depth control. You can s
LFO shape and frequency, and you can edit the envelope.

Each modulator can send to any one destination: the Instrument’s Volume, Pitch, Pan, or a
three Filter parameters. Each of these destinations can receive from any combination of th
modulators, which gives you room to create extremely complex modulation effects if that’s 
you want to do.
 

.
Sample

Keymap

Sample

..
Gain

PanVolume

Synthesizer Voice

Envelope Output

Pitch

L

R

Filter

Freq ToneRes

Modulators

Pan

.
Sample

Keymap

Sample

..
Gain

Each Modulator
can send to one
destination

Each destination
can have up to
five Modulators,
summed together

Up to five
Modulators are
available per
voice

Envelope

Modulator 1

Modulator 2

Modulator 3

Modulator 4

Modulator 5

Output
L

R

Filter

VolumePitch Freq ToneRes Pan
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Playing the Beatnik MIDI Synthesizer
The Beatnik MIDI Synthesizer generates sound in response to MIDI events received from a
ety of sources. The MIDI sources available in the Beatnik Editor – that is, at authoring time
different from the MIDI sources that will be available when the RMF file is played back in a 
page, Shockwave movie, or application.

At playback time – that is, in the Beatnik Player, Beatnik Xtra, BAE or other Beatnik playba
software – MIDI input can come from two different sources:

• From playing the MIDI sequence in an RMF file.

• From individual MIDI note events arriving from the Web page code, Shockwave movie, 
application program.

In the Beatnik Editor – that is, as you’re working on your Instruments and Samples – MIDI 
can come from three different sources:

• From the Live MIDI Input.

• From The Onscreen Keyboard in the Player window.

• From playing the Songs in your Session files.

In both of these situations, all MIDI events arriving at the Beatnik MIDI Synthesizer are han

Sources of MIDI Events

Web Page JavaScript code,
Shockwave Lingo code,

or Application

Audio Out

Beatnik Player for Web browsers,
Beatnik Xtra for Director and Shockwave,
Beatnik Audio Engine for C and C++

Live MIDI Events

L

R

MIDI In
RMF Files

At Playback Time in the:

Beatnik MIDI Synthesizer

Sources of MIDI Events

(In Player window)

Songs

In the Beatnik Editor:

Keyboard

Live MIDI Input
Sequencers or Controllers

Audio Out

L

R

Beatnik MIDI Synthesizer

MIDI In
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in exactly the same way. This section explains how the synthesizer responds to those MIDI 

See also: MIDI Implementation and MIDI Implementation Chart.

Note: When the Beatnik MIDI Synthesizer is listening to a musical score and interactiv
input at the same time, both sources are playing the same synthesizer. Program change 
messages and level or effects adjustments arriving from either MIDI source will affect 
playback of both of them.
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Instrument Bank Organization
Like many musical instruments, the Beatnik playback software includes built-in Instrument 
nitions – in this case, over 300 of them. Instruments are divided into three Banks: the built-in
eral MIDI and Beatnik Special banks, and the Custom bank for Instruments that you make 
Beatnik Editor and include in your RMF files.

Every Bank consists of two sets of 128 Instruments each:

• Melodic Instruments are numbered 0–127, and are ‘normal’ Instruments that respond to 
128 MIDI note numbers by playing the corresponding melodic pitches.

• Percussion Instruments are treated differently. The 128 Percussion Instruments in each b
make up a ‘drum kit’ that puts a different Instrument on each of the 128 MIDI note numb
So with Percussion Instruments, playing different notes produces different Instruments, 
than playing a single Instrument at different pitches.

This Percussion behavior is a part of the General MIDI standard, and is ordinarily used
on MIDI channel 10; however, in Beatnik playback software you can put any set of MI
channels into this mode if you want to (see MIDI Channel Modes).

When you create a new Session in the Beatnik Editor, the Custom bank will be empty, and
other two banks (GM and Beatnik Special) will be full. You can’t change anything in the first
banks, however – to modify an existing Instrument, you’ll have to copy it to the Custom Ins
ment bank, and modify the copy there.

Note: You can drag and drop Instruments and Samples between Session files.

Bank Number and Name Built-
In? Description

Bank 0: General MIDI Melodic Yes The first bank is organized according to the
General MIDI specification, for compatibil-
ity with all Standard MIDI Files.Percussion

Bank 1: Beatnik Special Melodic Yes The second bank is organized similarly to 
the GM bank, but includes unique sounds 
beyond the GM set, and Web-appropriate 
sound effects, all created by Beatnik artists

Percussion

Bank 2: Custom Melodic No The third bank provides room for your own 
Custom Instruments, including variations 
on the built-in Instruments.Percussion
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Controlling the Mix
The Beatnik MIDI Synthesizer gives you control over everything you need to create a finely-
mix: the relative balance between Instruments, their positions in the stereo field, their effect 
and the effects processor program. There isn’t any traditional EQ (equalization, or bass and
controls), but each Instrument does have a Filter that you can control.

The Beatnik Editor doesn’t have any traditional “mixer window” for working on your mix 
(although the Player window does have Mute and Solo buttons and a Reverb setting menu). 
Instead, you mainly control the mix by means of MIDI controller messages – which you can
either include in your Song’s MIDI sequence, or send in real time from the Web page’s Java
(or from the game code, Shockwave movie Lingo code, etc.).

Outside of MIDI, the system-wide effects processor program can be set when individual So
are played (see the Song Settings dialog box), and most of the mix parameters can also be ind
pendently modulated on a per-voice basis (see the Instrument Editor window).

Note: Like most MIDI systems, the channels and effects processor in the Beatnik MIDI
thesizer and Audio Mixer always retain their most recent settings. That means that if y
listener plays some other RMF file before listening to yours, they’re likely to have volu
and reverb send settings “left over” from the previous Song. That’s why it’s a good ide
always start your Songs’ MIDI tracks with your desired values for MIDI Continuous Co
trollers 7, 10, and 11 for every MIDI channel you use, and to set the effects controllers
each (MIDI Continuous Controllers 91 and 93).

Topics:
Volume

Pan

Effects: Reverb and Chorus

Volume
MIDI Continuous Controller number 7 sets the volume on a per-Instrument (that is, per MID
Channel) basis. The dynamic volume of individual voices (notes) can also be affected inde
dently with modulators in the Instrument definition, and each Instrument has a constant Vol
setting on the Output Page page of the Instrument Editor window.

Note: If you’re used to using the “expression” controller (MIDI Continuous Controller nu
ber 11) to create smoothly changing volume effects like fade-ins/fade-outs, or crescen
decrescendo, be advised that this won’t work in Beatnik. The Beatnik MIDI Synthesize
interprets controller 11 in an unusual way: values 0–126 are ignored, but a value of 12
boosts volume by 25%. This means that if you want to use a MIDI controller for smooth
ume changes, you have to use controller 7, not controller 11.

Muting MIDI Channels
Although the Music Object programming interface includes Mute commands, and the Player win-
dow includes onscreen Mute buttons, there is no direct equivalent that can be encoded in M
events. The nearest thing would be to use MIDI Continuous Controller 7 (the volume contro
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to set a channel’s volume to 0 temporarily; however, doing this would risk getting the volum
wrong when it comes time to un-Mute, as you may not know how the volume controller has
set in the meantime.

See also: Automatic Looping and Track Muting.

Pan 
MIDI Continuous Controller number 10 sets the stereo pan position on a per-Instrument (th
per MIDI Channel) basis. The dynamic pan position of individual voices (notes) can also be
affected independently with modulators in the Instrument definition, and each Instrument h
constant Pan setting on the Output Page page of the Instrument Editor window.

Effects: Reverb and Chorus
The Beatnik Audio Mixer has a built-in effects processor that provides a range of preset rev
programs, some of which include a parallel chorus effect. MIDI Continuous Controller numb
sets the program for this system-wide effects processor, and you can also use the Song Settings 
dialog box to pick an effects program for each Song. Because there’s only one effects proce
all Instruments (that is, all MIDI channels) will receive the same effect – however, you can t
each channel’s effects send on and off independently. For the effects programs that offer s
neous chorus and reverb, you also have independent, continuously variable reverb and cho
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send controls on a per-MIDI-channel basis.

Effects Send Controls
Any MIDI channel can use the reverb and chorus, with an independent send control for eac
MIDI channel.

Reverb
MIDI Continuous Controller number 91 is used as the reverb send control, but it’s used in tw
ferent ways. 

• For reverb types 2 through 7, the reverb send for each MIDI channel is either completely
completely off – there’s no fine control over the reverb send. Values of 14 or less for MID
controller 91turn a channel’s reverb send off, values of 15 and above turn it on.

• For reverb types 8 through 11, you have much finer control (Early Reflections, Baseme
Banquet Hall and Catacombs – the higher-quality programs). A value of 0 for MIDI contr
91 means no reverb send, and higher settings gradually increase the reverb send level,
the maximum of 127.

Note: Many people have found 10 to be a good starting effects level, and send levels o
to be too high for many situations – but let your own ears be the judge.

Reverb
Number Name Description

1 No reverb Mono reverbs, no chorus. 
Effect send either on or off.

2 Closet

3 Garage

4 Acoustic Lab

5 Dungeon

6 Cavern

7 Small Footprint

8 Early reflection Stereo, with chorus. Variable send 
levels.

9 Basement

10 Banquet hall

11 Catacombs

Note: Reverbs 8 – 11 are only available when the Beatnik Audio Engine is 
operating in stereo.
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Chorus
For reverb types 8 through 11 only (Early Reflections, Basement, Banquet Hall and Cataco
MIDI Continuous Controller number 93 is used as the chorus send control. This is complet
separate from the reverb send. The chorus send has the same fine-resolution control as th
send: a value of 0 for MIDI controller 93 means no reverb send, and higher settings gradua
increase the reverb send level, up to the maximum of 127.

Note: Chorus is only available when reverb type 8, 9, 10, or 11 is in use, and the Beatn
Audio Engine is operating in stereo.
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MIDI Implementation
The Beatnik MIDI Synthesizer, although a piece of software, behaves as if it were a Genera
sound module. It responds to the following standard MIDI messages, arriving on any of the
MIDI channels:

• Program Change and Bank Select

• Note Events

• Pitch Bend

• Several Continuous Controllers

You can use any MIDI sequencer to create a Standard MIDI File containing these message

See also: MIDI Implementation Chart

Program Change and Bank Select 
The Beatnik MIDI Synthesizer responds to MIDI Program Change messages, which set the
Instrument that each MIDI channel will use to play its notes. Each channel tracks its own pro
number independently, and all notes played on a channel will use the channel’s current pro
Instrument programs are numbered from 0 through 127.

The Beatnik MIDI Synthesizer also responds to MIDI Bank Select messages, which involve
concept of program Banks. Because 128 Instruments really isn’t enough to hold all the use
musical Instruments in the world, the need arose to for a way to access more of them. So in
a Bank is defined a set of up to 128 Instruments, and a MIDI synthesizer can provide multi
Banks – for example, the Beatnik playback software furnishes three Banks. The MIDI Bank
Select message (implemented as a Continuous Controller event for controller 0) determines
of the available Banks a MIDI channel will look to when it receives a MIDI Program Change
message. Each channel tracks its own Bank number independently, and all Instruments us
channel – as accessed by MIDI Program Change messages – will be fetched from that Ban
and unless a different Bank Select message is received.

In Beatnik, MIDI Program Changes access Bank 0 (General MIDI) by default, so:

• If you’re only accessing General MIDI instruments in a given channel, you don’t need to
include any Bank Select messages, but

• If you want to access Beatnik Special Instruments (Bank 1) or Custom Instruments (Ba
in your RMF file, you’ll have to place a Bank Select message before any Program Chan
messages.

For example:

Controller #0, 1 – Selects Bank 1, which is Beatnik Special
Program 1 – Change to instrument 1, Reflection Piano, in the Beatnik Special bank
Program 2 – Change to instrument 2, Flange Piano, in the Beatnik Special bank
Controller #0, 0 – Selects Bank 0, which is General MIDI
Program 1 – Change to instrument 1, Bright Piano, in the General MIDI bank
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Program 2 – Change to instrument 2, Electric Grand, in the General MIDI bank

See also: List of Built-In Instruments in the General MIDI and Beatnik Special banks.

Note Events
MIDI treats every played note as two separate events: one Note On message that specifies
number and velocity, and a separate Note Off message arriving some time later (also spec
the note number). Any MIDI channel can play any number of notes simultaneously, howeve
synthesizer does have an overall maximum (usually 56 voices).

Velocity
In the Beatnik MIDI Synthesizer, the velocity in the Note On message always affects the no
volume.

MIDI Channel Modes
MIDI Channel Mode determines how a channel will interpret MIDI note events. In addition to
two MIDI channel modes used in the General MIDI scheme (Normal Percussion and Norm
Melodic modes), the Beatnik MIDI Synthesizer offers a third mode, Pitched Percussion. Ea
channel tracks its own channel mode independently, and all notes played on a channel will
using the channel’s current channel mode. By default, all channels start up in General MID
Mode.

To change a channel’s MIDI channel mode, send a Non-Registered Parameter Number (N
with MSB (controller 99) of 5 and LSB (controller 98) of 0, followed by a Data Entry (contro
6) with your desired mode number:
  

See also: the Advanced Techniques section.

Data Entry 
Controller Mode Effect

0 General MIDI Mode
(for that channel)

On Channel 10, puts the channel into Nor-
mal Percussion Mode; on all other chan-
nels, puts the channel into Normal Melodic 
Mode

1 Pitched Percussion Mode Program Changes select Percussion bank 
sounds, note numbers transpose them as 
though they were Melodic Bank Instru-
ments

2 Normal Percussion Mode Note number selects Percussion bank 
sounds (ala General MIDI Channel 10)

3 Normal Melodic Mode Program Changes select Musical bank 
sounds, note numbers transpose them.
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Pitch Bend
Like most instruments, the Beatnik MIDI Synthesizer responds to MIDI Pitch Bend events. 
channel tracks its own pitch bend value independently, and all notes played on a channel w
the channel’s current pitch bend value. Value range is 12 bits, with a default depth of 2 sem

To change a channel’s pitch bend depth, send a Registered Parameter Number (RPN) with
(controller 101) of 0 and LSB (controller 100) of 0, followed by a Data Entry (controller 6) w
your desired bend range in semitones.

For example, to set a channel’s pitch bend range to one octave:

Controller #101, 0 – RPN MSB of 0 – Select Pitch Bend Depth as Data Entry destination
Controller #100, 0 – RPN LSB of 0
Controller #6, 12 – Set depth to 12 semitones, via Data Entry controller
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Continuous Controllers
The following table summarizes the Beatnik MIDI Synthesizer’s response to MIDI Continuo
Controller messages. Each Continuous Controller message contains a controller number a
value. For further details, see the MIDI Implementation Chart.

MIDI 
Controller Number & 

Description
Notes

0 Bank Select (MSB 
Only) 

Beatnik only responds to the most significant byte (MSB).

Values: 
0 – General MIDI Bank 
1 – Beatnik Special Bank
2 – Custom Instrument Bank (in RMF file)

1 Modulation If the Instrument uses a Pitch modulator, this controller affects its 
depth; otherwise, it affects a built-in uneditable Pitch LFO.

Value Range:
0 (no modulation) – 127 (maximum modulation)

6 Data Entry Used after NRPN 640 (Controller Numbers 98/99) to set the MIDI 
Channel Mode for note events.

Values:
0 – Channel's normal General MIDI mode: On Channel 10, puts the
channel into Normal Percussion Mode; on all other channels, puts t
channel into Normal Musical Mode
1 – Pitched Percussion Mode: Program Changes select Percussion
bank sounds, note numbers transpose them
2 – Normal Percussion Mode: Ala General MIDI Channel 10, note 
number selects Percussion bank sounds
3 – Normal Musical Mode: Program Changes select Musical bank 
sounds, note numbers transpose them. 

7 Volume Value Range:
0 (no sound) – 127 (maximum volume).

10 Pan
(stereo position)

Value Range:
0 (full left) – 127 (full right). Center is 64.

11 Expression Value Range:
0 – 126: No effect on volume
127: Volume is boosted by 25%

Note: This behavior is different from most other MIDI synthesizers.

64 Hold1
(Sustain)

Ordinary sustain pedal.
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87 

Beatnik Loop & 
Mute

(Available during file playback only)
When stored in a MIDI or RMF file, Controllers 85, 86, and 87 can b
used to loop sections of MIDI data and selectively mute a different s
of tracks at each pass through each looped region.

See Automatic Looping and Track Muting.

90 Master Reverb 
Type 

Sets the Reverb Type. See Effects: Reverb and Chorus.

Value Range:
0 – 11

91 Reverb Send Value Range:
For Reverb Types 2 through 7 – Each channel’s reverb send is either
On (Controller 91 values 15 and above) or Off (Controller 91 values
below 15).

For Reverb Types 8 through 11 – Each MIDI channel has indepen-
dent send levels ranging from 0 (no reverb or “dry”) to 127 (maximum
reverb or “wet”).

See Effects: Reverb and Chorus.

93 Chorus Send Reverb Types 8 through 11 include a Chorus effect. Each MIDI cha
nel’s chorus send level can be set independently from its reverb sen
level.

Value Range:
0 (no chorus or “dry”) – 127 (maximum chorus or “wet”).

See Effects: Reverb and Chorus.

98,
99 

NRPN
(LSB, MSB) 

Controller 98 – Least Significant Byte (LSB)
Controller 99 – Most Significant Byte (MSB)

100,
 101

RPN
(LSB, MSB) - 
Reserved

Controller 100 – Least Significant Byte (LSB)
Controller 101 – Most Significant Byte (MSB)

121 Reset
All Controllers 

Equivalent to sending the following set of Controller messages:

Bank Select0 (General MIDI)
Mod Wheel0 (off)
Volume127 (full)
Pan64 (center)
Expression0 (off)
Sustain0 (off)
Reverb Level14 (normal)
NRPN0
RPN0

123 All Notes Off Standard ‘Panic Button’ to kill all playing notes. Value is ignored.
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Building Your Own Patches
Eventually, you’ll want to use a sound that doesn’t exist among Beatnik’s built-in instrumen
When this happens, it’s time to create your own Instrument.

This can be a pretty involved process, so you may find it takes a little practice to get the be
results. You’ll need to decide if your sound requires new custom Samples, or if you can just 
the built-in Samples and modify them with your Instrument parameters. In many cases you
be able to get the sound you’re after by copying one of the existing built-in Instrument and c
ing some of its parameters.

To build your patches in the Beatnik Editor, you’ll use the Instrument Editor window, and perhaps 
the Sample Editor window. For introductions to these editors, see the Production Technique Tips 
and Editing Instruments sections below.

Overview for Sound Designers
If you’ve spent time working with a multi-timbral MIDI sampler or wavetable synthesizer, yo
find Beatnik’s software-based sampling and synthesis environment very familiar. Alternately
may be helpful to think of Samples as the equivalent of a multitrack tape player and the rest
Instrument definitions as your signal processing and mixing tools.

Each Instrument starts with one or more Samples. Whenever your Instrument receives a M
note one Sample is played – and its pitch is optionally transposed – depending on a Keym
you design. The Sample is then processed by three further blocks (two of which are option

• The Filter block (optional)

• The Gain Envelope block (optional)

• The Output block

This block contains controls for the Instrument’s default pan position and volume.

The Filter, Gain Envelope, and Output blocks can also be affected by Modulators, which we
talk about shortly.

Beyond the individual voice, each MIDI channel also supports several MIDI Continuous Co
lers that affect the audio of all notes being played on that channel – including volume, stere
and other parameters that have parallel controls in the Instrument design. For details, see Continu-
ous Controllers.

Finally, all Instrument are mixed together in the Beatnik mixer (not shown above), which pro

.
Sample Keymap

Sample

..

Gain

PanVolume

Synthesizer Voice

Envelope
Output

Pitch

L

R

Filter

Freq ToneRes

Modulators

Pan

(optional) (optional)
(default pan 

& volume)
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 59

I chan-
optional reverb and chorus effects with an independent send control for each of the 16 MID
nels – see Effects: Reverb and Chorus.
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 Editing Samples

Samples are the basic building block of all Instrument sounds. While the Beatnik built-in Ins
ment banks contain a huge number of Samples, composition-specific sounds like speech, s
sound effects, and featured musical sounds generally require custom Samples. To use cus
Samples in an RMF file, you must import them into the Beatnik Editor Session file.

Often you’ll find that the Samples you’ve imported need a little cleaning-up before they’ll wo
well in Instruments. You can use the Beatnik Editor’s built-in Sample Editor window for most 
such basic work – deleting unwanted parts, creating fade-ins and fade-outs, adjusting over
ume, and setting loop points for sustaining. However, if you need to do any more elaborate s
editing – for example, converting sample rates or turning stereo samples into mono – you’l
a separate, full-featured sample editor software package.

About Sample Sizes
Custom Samples can bring your projects a unique edge – but you should be aware that the
also greatly increase download times, which carries the risk of irritating your users on the W
the Sample Editor, the size of each Sample is shown as bytes used on disk in the info display at 
the bottom of the window.

See also: How Do I ...Make my Samples Smaller?

Working with the Sample Editor

The Sample Editor window should feel pretty familiar if you’ve ever used any sample editing 

.
Sample Keymap

Sample

..

Gain

PanVolume

Envelope
Output

Pitch

L

R

Filter

Freq ToneRes

Modulators

Pan

(optional) (optional)
(default pan 
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application before. The middle section of the window is a waveform editing display that you
zoom into – on both the time axis and the level axis – and scroll left and right. The loop poi
markers appear above the waveform, with a Loop on/off button and editable start and end n
fields below. To edit the waveform, you make a selection by dragging across your desired r
(or using the Select All command), and then use either the Volume Handles, the context me
Sample menu, or the Delete command (in the Edit menu). You can also set the playback sa
rate, and set the Root Key that the Beatnik Editor will use whenever you ask it to make a n
Instrument using this Sample – automatically correcting for pitch in the Keymap it generate

Sound Editing Controls
The context menu and the Sample menu contain both edit commands and view control com-
mands, which are explained in the Window Reference section for the Sample Editor window:

The Volume Handles are a little different from any other sample editor you’ve seen. Whenever
make a selection, three Volume Handles appear across the top:

From left to right, these are the Fade-In Handle, the Fader Handle, and the Fade-Out Hand

To create a fade-in: Click in the Fade-In Handle and drag to the right, releasing the mouse
button where you want the fade-in to finish.

To create a fade-out: Click in the Fade-Out Handle and drag to the left, releasing the mous
button where you want the fade-out to start.

To adjust the level: Click in the Fader Handle and drag up or down to turn the level up or 
down.

Note: Be sure to listen critically to your sample after boosting, since excessive volume
boosts will cause digital distortion. To boost a selection to its maximum before distorti
use the Normalize command.

Fade-In
Handle

Fader
Handle

Fade-Out
Handle
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Looping Tips
Creating a smooth loop can be the most challenging part of creating a custom musical inst
Sample. Here are a couple of tips:

• Good loops need very similar timbre and pitch at the start and end of the looping region
erwise the splice between end and beginning will sound jarring. The best loops are usu
found some time after the sound’s initial attack – specifically, after the initial transients h
died down and a stable, pitched tone remains.

• Try setting your loop markers at the positive zero-crossing of one or more cycles of this
pitched tone. For example, in the following illustration two waveform cycles have been 
selected as the loop, and the loop stat and end are both at places where the signal cros
zero line, moving upwards.

Once you find the right pitch, you may need to shift the loop left or right to find a place
where the timbre is stable enough to work well. To move the looping region without ch
ing its length, drag the middle Loop Handle.

Two Waveform
Cycles Selected
for Loop
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Editing Instruments
Editing Instrument parameters is usually quicker and easier than editing the underlying Sam
themselves. In addition, creating Custom Instruments (as opposed to custom Samples) ha
ligible effect on user download times. We would encourage you to experiment with Instrum
editing, even if you aren’t creating your own Custom Samples.

Note: You can only edit Custom Instruments, not the Built-In Instruments. You can crea
new Instruments from scratch, or copy built-in Instruments to the Custom bank, then e
them. Instruments can be copied and pasted (or dragged and dropped) between Sess

The Instrument Editor has five Pages:

Heading... Covers...

Keymap Assigns specific Samples (built-in or custom) to ranges MID
notes

Filter Sets the peak frequency spacing and resonance used by B
nik’s comb filter, and the tone control

Volume Controls the amplitude envelope applied to each note

Output Sets the Instrument’s position in the left-right stereo mix

Modulation Defines up to five modulation sources to further manipulate
an Instrument’s sound

.
Sample Keymap

Sample

..

Gain

PanVolume

Envelope
Output

Pitch
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Keymap

The Keymap Page defines which Samples are played across an Instrument’s keyboard. As a
ple is played further from its original pitch, transposition artifacts become more apparent. S
modern samplers and wavetable synthesizers use multiple samples to create a single Instr
For instance, a piano could use half a dozen samples originally recorded across a range of 
An Instrument can contain from 1 to 128 of these zones.

See also: Keymap Page in the Instrument Editor window section.

Filter

The Filter Page is the second block in the signal path. Each Instrument can use its own Com
ter and tone control. The Comb Filter has both peak frequency spacing and resonance set

In general, the Filter can liven up the sound of an Instrument, as well mask aliasing or nois
Sample. The only drawback is that each Filter uses some CPU power, particularly when its
nance is turned up. When you have a Song that uses a lot of Instruments with Filters, keep
on the CPU Load meter in the Player window to make sure it’s performing within acceptable lim
its.

The most important Comb Filter setting is its peak frequency spacing. A comb filter has mu
fixed peaks evenly spaced across the frequency spectrum. Frequencies in between the pe
turned down, removing those components. Peak frequency spacing can be set to a fixed fre
from 175 to 11,200 Hz. The sound will get progressively brighter and duller as you play acro
keyboard from low notes to high notes, depending on how wide the spacing is.

There is an alternate to a fixed frequency spacing: The Track Pitch option causes the filter fre-
quency spacing to increase and decrease as the pitch of the played notes goes up and dow
keyboard. When Track Pitch is enabled, you can allow all notes to have a similar tonal charac

Another important filter control is Resonance. Resonance creates a hump or frequency boo
tered around the cut-off frequency. The higher the resonance setting, the more audible this

.
Sample Keymap

Sample

..

Gain

PanVolume

Envelope
Output

Pitch

L

R

Filter

Freq ToneRes

Modulators
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(optional) (optional)
(default pan 

& volume)
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becomes. The resonant frequency will follow behavior of the cut-off frequency as described
Track Pitch option.

In addition to the Comb Filter, there’s also a Tone Control – a gentle high or low frequency r
filter with a Depth setting:

• When the Tone setting is positive, the Tone Control rolls off high frequencies.

• When the Tone setting is negative, the Tone Control rolls off low frequencies, and the C
Filter is bypassed.

Note that you have the option to dynamically sweep any or all of the continuous filter settin
(comb filter frequency peak spacing and resonance, and tone control) – see the Modulation sec-
tion.

See also: Filter Page in the Instrument Editor window section.

Player Sample Rate and Filter Frequency
Note: An Instrument with prominent filtering will sound significantly different depending 
whether the listener’s Beatnik playback software is operating at 22kHz or 44.1 kHz.As
result, you should set the Player window playback settings to the same sample rate as th
playback system where you plan your music to be played. For the Beatnik Player for W
browsers, this is 22kHz. For the Beatnik Xtra, JavaSound, or the Beatnik Audio Engin
check with your programmer to see what sample rate they intend to use. As you work
your Instrument in the Beatnik Editor, you may want to listen to your song at a numbe
different sample rates, evaluate the sound character of each.

Volume

The Volume Page contains a flexible Envelope Generator that controls the attack, sustain an
release levels of each Instrument’s sound. These levels are shown as an editable, graphica
defining the note’s overall volume contour over time.

See also: Volume Page in the Instrument Editor window section.

.
Sample Keymap
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Output

The Output Page is the simplest part of the Instrument editor. Here, you can set the Instrume
default Stereo Pan position. You can also disable reverb for the Instrument.

See also: Output Page in the Instrument Editor window section.

Modulation
 

Modulators can make an Instrument more dynamic and interesting, but they make no soun
their own. Instead, they work by changing (modulating) various parameters of the instrume
dynamically in real time. Parameters like volume, filter settings, or pitch can be modulated b
frequency oscillators (LFO’s) and envelopes. You may have up to five simultaneous modula
per instrument; it’s also OK if your instrument doesn’t use any.

See also: Modulation Page in the Instrument Editor window section.

As you may know, modulation is a two-part proposition; each modula-tor controls a modula
if you will. Beatnik has four different types of modulators, and six different Instrument param

KeymapSamples
Gain

Each Modulator
can send to one
destination

Each destination
can have up to
five Modulators,
summed together

Up to five
Modulators are
available per
voice

Envelope

Modulator 1

Modulator 2

Modulator 3

Modulator 4

Modulator 5

Output
L

R

Filter

VolumePitch Freq ToneRes PanModulation
Destinations

.
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Modulator Destinations

Volume
Modulating the volume of an instrument creates a fluctuation in the Instrument’s level. Thos
familiar with the classic guitar amplifier tremolo effect will know exactly how this sounds. 

Pitch
Normally, an Instrument’s pitch is controlled by the MIDI note being played, and the pitch b
wheel (if used). Applying a modulator to the pitch of an Instrument will add a pitch vibrato, w
ble, bend or other gesture to every note played.

Stereo Pan position
There are three ways to adjust the stereo position of an Instrument’s sound: The Stereo Po
setting in the Instrument Output tab, the use of MIDI controller 10 (pan) and a modulator se
control Stereo Pan position. Using an LFO to change an Instrument’s pan is an effect often
with electronic pianos, giving the sound a back-and-forth motion.

Filter Tone
Use care when modulating the Filter Tone, especially when going back and forth between p
and negative values. The Comb Filter is disabled when the Tone control value is negative, 
bad-sounding artifacts can occur when the Comb Filter suddenly cuts in or out. 

Filter Frequency
Modulating the filter peak frequency spacing of an Instrument allows you to create electron
swishing and sweeping sounds, without altering the note’s fundamental pitch – sounds you
ognize from electronic dance music. This effect is most apparent on Instruments with highe
resonance settings.

Filter Resonance
Modulating filter resonance tends to add a pulsating character to each note. If you turn on 
Pitch (on the Filter page), then you can create a pulsing harmonic at a pitch above or below
key played by using a semi-tone offset.

Modulator Source Types Modulation Destinations

Low Frequency Oscillator (LFO)
Envelope
LFO with Depth Modulator (Envelope)
Offset Modulator

Volume
Pitch
Stereo Pan Position
Filter Tone Control
Comb Filter Frequency Spacing
Comb Filter Resonance

(Choose One per Modulator) (Choose One per Modulator)
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Note that filter resonance is perhaps the most subtle modulation destination. When the filte
set to Track Pitch, the effects of resonance in general vary depending on the pitch of the no
played. When Track Pitch is enabled, the behavior of different pitches is more consistent. 

Modulator Types
The Beatnik synthesizer supports four different modulator types, all of which are based on 
signal sources – a Low Frequency Oscillator (LFO) and an Envelope generator. Choosing 
ulator type is easier once you understand how they differ:

Modulator Type. Description

Low Frequency Oscillator (LFO) An LFO applies a continuously repeating wiggle to an 
Instrument parameter, such as pitch or volume. This wigg
continues as long as the note is held.

You can think of an LFO as an invisible monkey turning an
Instrument control knob up and down at a certain rate. If th
knob the monkey is turning happens to be “volume,” you’l
hear the level of that instrument rise and fall periodically, 
like the tremolo effect on an old guitar amp. 

LFO’s have three important settings: how fast the knob is 
wiggled, how far the knob gets wiggled relative to its start
ing position and the “shape” of the wiggling gesture. In the
Modulation window, these three parameters are represent
by Period, Depth and Shape.

Envelope An Envelope applies a one-time gesture to each note. Onc
the envelope is complete, the note continues normally unt
released. Use envelopes for any gesture that begins anew
each time a note is struck – for example: a filter sweep, a
pitch bend, etc.

The difference between an Envelope and an LFO is that 
LFOs produce a continuously repeating wiggle; by contras
Envelopes happen just once per note, regardless of how 
long that note is held.

If you’ve worked with MIDI or digital audio software that 
supports mix automation, you might want to think of an 
Envelope as an automation curve. When a note is triggere
the envelope will begin playing, modulating the Instrumen
parameter to which it is attached. The difference between
envelopes and automated mixing is that the envelope has 
option to “freeze” during the sustain portion of the note, 
then continue after the note is released.
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Modulation Tips
Modulation is a classic synthesis technique. Here’s how to get some familiar modulation-ba
effects:

• Vibrato: Use an LFO mapped to Pitch. Usually the LFO depth will be set quite low. Note
if there is a Pitch Change LFO present in an Instrument, the Mod Wheel (MIDI controlle
will affect its depth. Otherwise, Mod Wheel will activate a default Pitch Change LFO that
not be edited by the user. Using an LFO with a Depth Modulator envelope that slowly ra
up or down can be very effective. 

• Stereo Panning Effect: Use an LFO mapped to Stereo Pan. This can be an adequate sub
for using a stereo sample; the triangle wave shape offers the smoothest result, square a
tooth are more striking. Using an LFO with a Depth Modulator envelope that slowly ramp

LFO with Depth Modulator 
(Envelope)

LFO with Depth Modulator uses the Envelope to vary the 
Depth parameter of the LFO. This creates a wiggling effec
who’s intensity changes over time. Notice how the shape 
combines elements of the previous two modulator types –
the envelope modulates the LFO’s depth, but not it’s fre-
quency or shape.

The actual result of this type of modulator is determined b
multiplying the LFO’s Depth setting (0-100%) and the cur-
rent value of the Depth Modulator envelope (-100%-100%

When using this type, you may want to set the LFO Depth
to 100%, as this gives you maximum control and flexibility
with the Depth Modulator envelope. 

Negative Depths: In some cases, an envelope with points a
levels less than zero (in the range of 0 to -100%) may hav
the same result as if the point was simply at zero. In case
where negative modulation values have an effect, be mind
ful of envelopes that have points both above and below th
zero line – the modulation’s destination will “invert” its 
behavior when the envelope crosses from negative to pos
tive, which can produce interesting and complex sound 
behaviors. Predicting the results before you hear them wi
take practice!

Offset Modulator Offset Modulator combines the LFO and Envelope in a dif-
ferent way. In this type, the LFO’s Depth is still controlled 
by the envelope, but the Envelope shape is also added 
together with the LFO’s shape. The result is an “offset,” 
which you can seen by comparing the diagram with the LFO 
with Depth Modulator immediately above.

The Offset Modulator adds an Amount to use as ADSR % 
slider to the Modulator page.
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or down can be very effective. 

• Tremolo: Use an LFO mapped to Volume, or to Filter Frequency with a low filter resonance 
setting. Using an LFO with a Depth Modulator envelope that slowly ramps up or down ca
very effective. 

• Filter Sweep: Use an LFO mapped to Filter Frequency with a high filter resonance setting. 
The LFO rate should be very low (long period). Achieving your desired effect will probab
require a lot of experimentation with adjusting the LFO and Filter parameters.

• Arpeggiator Effects: Modulate Pitch from two or three LFOs with different but arithmetical
related frequencies. This will create repeating arpeggiator-like effects. For example, exa
Special Bank #99, Analog Sequence. Alternatively, offsetting the LFO frequencies by sm
arbitrary amounts can create interesting and complex effects.
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Production Technique Tips
Although MIDI has a reputation for sometimes sounding flat or mechanical, there are many
to make your music more engaging to listeners. Here’s a few tips for enhancing the emotio
impact and richness of your Instrument sounds.

Topics:
Humanizing MIDI Music
Dynamic Level and Pan
Thickening Instrument Sounds

Humanizing MIDI Music
Creating expressive music with MIDI takes a certain amount of care and effort. Here are som
that can help your music convey a more human vibe:

• Avoid excessive quantizing. Most MIDI sequencers let you “Quantize” notes to line them u
exactly with the beat. While quantizing can tighten up a sloppy take, it can also leech the
tion from a good performance.

• Create expressive velocity data. A great deal of expression is contained in the note velocit
messages within a skilled musician’s performance. If your notes weren’t played using a 
keyboard or other controller, try adjusting some velocity values manually in your sequen
Even randomization of velocity values can help.

• Use volume & modulation controllers. Depending on the Instrument, Modulation or Mod 
Wheel (controller 1), may add a ‘vibrato’ effect to the sound. This can help vary the flat,
unchanging sound of looping samples. Use the MIDI volume controller (Continuous Co
ler 7) to create crescendos, decrescendos, and expressive phrasing in instruments suc
strings, winds, synth pads, etc.

Tip: Continuous Controllers such as Volume, Pan Modulation or Pitch Bend can generate
huge amounts of MIDI information, increasing your listener’s download times. Most 
sequencers offer a controller thinning function that reduces these messages while pres
much of the original gesture. Excessive thinning, however, may result in blocky, or ste
volume fades or pitch bends – so don’t go to extremes.

• Fine-tune note lengths. The length of notes conveys a great deal of expression and can m
performance sound more lifelike, especially with basses and sustaining instruments suc
strings or woodwinds. Pay attention to whether the notes sound better detached, or leg
(end-to-end).

Dynamic Level and Pan
Volume and Pan are fundamental mixing tools. You can set fixed Pan positions for Custom 
ments, but beyond that, all level and pan settings will be part of your MIDI sequence, or the
of interactive Music Object function calls arriving from the Web browser, Director Movie, or 
game. 

• Volume is set on a per-MIDI-channel (per-Instrument) basis, using MIDI Continuous Con
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• Pan is also set on a per-MIDI-channel (per-Instrument) basis, using MIDI Continuous C
troller 10.

It’s a good idea to include a Volume and Pan message for each MIDI channel at the start o
Song. These settings can be changed during the song by placing appropriate controller me
on specific channels throughout your sequence.

Thickening Instrument Sounds
There are many ways to add depth and texture to the mix. Here are some examples:

• Doubling: Playing the same part simultaneously with two different Instruments, on two M
channels, is the simplest method for creating a rich, full sound. It is especially effective 
environment like Beatnik where Web bandwidth constraints discourage large samples. 

• Detuning: Try doubling the same Instrument on two MIDI channels, but send a small pitc
bend message to one of them at the start of the Song. The result is similar to a “chorus”
Experiment with similar vs. different Pan settings for the two channels. Varying the amou
pitch bend during the Song can also be effective. Setting your Pitch Bend to a small value 
gives you greater resolution when setting subtle detuning offsets.

• Stereoizing: Double an instrument on two MIDI channels and pan them to opposite sides,
delay the MIDI events on one channel slightly. Echo effects can be created by longer M
event delays. For a better echo effect, reduce the velocities of the notes in the later ‘ech
track.
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Linking to Your Sequencer

The primary purpose of the Beatnik Editor’s Live MIDI Input feature is to let you drive the p
gram’s software MIDI synthesizer with the MIDI output stream from your sequencer program
that you can hear how your pieces will actually sound when played back in a Web page, Sh
wave movie, or other Beatnik playback environment. It also lets you work on your arrangem
Instruments and notes at the same – much better than having to save a MIDI file and impo
every time you want to hear the results of a change.

Note: Before you can link the Beatnik Editor to your MIDI sequencer, you’ll have to set
your system MIDI software and/or hardware to suit your particular situation and comp
Full details are provided for each sequencer below, or if your sequencer is not listed h
see the Live MIDI Input section

Note: The caveats for using Live MIDI Input section also apply when linking to a sequence
including latency (delays between MIDI notes going in and sound coming out) and Pro
Change conventions (see the Live MIDI Input section).

Once your computer is correctly set up to route MIDI, most MIDI sequencers will automatic
handle most of the details of driving the Beatnik Editor. However, you may need to do a littl
manual set-up work in the sequencer. The remainder of this section covers how to set up s
popular sequencers to drive the Beatnik Editor’s Live MIDI Input.

Windows:
Linking with Cakewalk Pro
Linking with Cubase VST/24 3.7 (Windows)
Linking with Cubase VST/24 5.0 (Windows)
Linking with emagic Logic Audio (Windows)

Mac OS:
Linking with MOTU Digital Performer
Linking with emagic Logic Audio (Mac OS)
Linking with Steinberg Cubase VST/24 (Mac OS)
Linking with Opcode Vision DSP

See also: Live MIDI Input.
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Linking with Cakewalk Pro

(Windows)
Beatnik has verified compatibility with Cakewalk Pro version 8.03 through 9.03, as well as S
1.0.1.

Note for Windows 2000 and NT Users: You should be prepared for a certain amount 
irregularity in live MIDI event timing, as these operating systems are optimized fo
server processes, not real-time media presentation.

Setting Up
1. Install some form of MIDI linking software on your PC, following the supplied installatio

instructions.

We support two different freeware linking utilities: MIDI Yoke and HUBI.

• MIDI Yoke can be downloaded off the net. As of May, 2001, the most reliable 
place to get it is:

http://www.midiox.com/myoke.htm
If this site is inaccessible, do a search for MIDI Yoke and something will turn up.

• The HUBI Loopback Device is also available for download off the net at:

http://www.geocities.com/SiliconValley/Vista/2872/hmidilb/hmdlpbk.html
2. Install Cakewalk Professional on your PC, following the supplied installation instruction

3. Restart your computer.

This will enable the MIDI linking software, so that Cakewalk and the Beatnik Editor ca
detect it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Cakewalk. Otherwise Cakewalk won’t detect the
Beatnik Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the File menu and select the Preferences... command, then in the Preferences dialog 
box select your linking utility as your MIDI input source: 

• If you’re using MIDI Yoke, choose one of the three junctions. 

• If you’re using HUBI, choose LB1.

6. In the Beatnik Editor, make sure you have one or more Session windows open.

7. If you want visual linking, click on the Instruments tab in a Session window.

8. Launch Cakewalk.

The first time you open Cakewalk, it will prompt you to set your MIDI ports. If Cakewa
was already installed on your computer, go to the Tools menu and select the MIDI Devices 
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command. The Port Selection dialog box will appear.

9. In the Port Selection dialog box, choose whatever inputs you have in your MIDI setup, a
select a MIDI Yoke junction for output.

When you’ve finished your selections, the dialog box should look something like this:

10. Click the OK button and exit Cakewalk.

Working with Cakewalk and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Cakewalk will be able to find it when C
walk starts up.

2. Launch Cakewalk.

At this point playing any attached hardware MIDI input devices (MIDI keyboards, MID
drum pads, etc.) should produce sound.

If not, try closing both applications and reopening. If you still do not have sound, it’s po
ble that Cakewalk detected MIDI feedback and disabled the port you selected. Reche
MIDI device settings, then restart your computer.

3. In Cakewalk, open your sequence.

4. Set up your Tracks to play back on the Beatnik Editor MIDI synthesizer.

You can set all playback selections in Cakewalk’s Track Properties window: MIDI channels, 
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banks, and patches.

Double-click in the Track area, under any of these labels: Source, Port, Chn, Bank, or Patch 
The Track Properties window will appear.

To drive the Beatnik Editor, your Track Properties must be set as follows:

• Source – None

• Port – Depends on the MIDI routing utility you’re using. Select 1-MIDI Yoke 
Junction: if you’re using MIDI Yoke, or LB1 if you’re using HUBI.

• Channel – Any channel 1 through 16.

Notes: 

– Visual linking between Cakewalk and the Beatnik Editor only exists on channel

– Channel 10 is always going to be the Percussion (General MIDI ‘Drum Channe
So, if you choose Bank 1 and Channel 10, you will be playing Bank 1, Beatnik Sp
Percussion Instruments in the Beatnik Editor. Any other channel on the same Ba
will play Beatnik Special Melodic Instruments.

• Bank Select Method – Controller 0
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• Bank – The Beatnik Editor includes banks 0, 1, and 2, each having both a 
Melodic set and a Percussion set.

Note: You have to manually type the bank number.

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

• Patch – Whatever Instrument you want. Unfortunately, Cakewalk doesn’t list 
patch numbers in the playback patch choices. Instead, it lists General MIDI 
Instrument names. So, if you’re in either Bank 1 or 2, you have to count to get the 
right Instrument. Or, if you’re on channel 1, you can surf through the Beatnik 
Editor’s patches and find the one you want.

Tip: See the Goodies folder for an Instrument Profile for the Beatnik Editor. With this pro
file, you won’t have to count Instrument numbers to find patches.

    When completed, the Track Properties settings should look like this:

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Cakewalk, import it into the Beatnik Edi
and convert it to an RMF file that plays the same MIDI instruments every time, it is necessa
place the Bank Select and Program (patch) Change events in the MIDI event list. Some se
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1. Open a Track in the Event List window.

Select a Track that contains notes that you want to drive the Beatnik Editor, then go to
View menu and select the Event List command. An Event List window will appear:

2. Indicate the time for the Bank Select and/or Program Change, and open the Bank/Patch 
change dialog box.

In the Event List, select the spot where you want the Program Change and/or Bank Sel
event to go, then go to the Insert menu and select the Bank/Patch change… command.

To set a single Instrument for the whole Track, select the very first event and insert the
change there.

The Bank/Patch change dialog box will appear:

3. In the Bank/Patch change dialog box, indicate what Bank and/or Program you want to us

• Set the Bank Select Method to Controller 0, then manually enter the Bank num-
ber. Use 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
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Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

• Next, click on Patch and select your desired Instrument from the pop-up menu.

Note: Cakewalk lists Instruments by General MIDI instrument names, not MIDI progra
numbers. This works fine for Bank 0, but in Bank 1 (Beatnik Special Instruments) and
(Beatnik Custom Instruments), you’ll have to count items to get the right Instrument nu
ber.

Tip: If you’re on channel 1, you can surf through the Beatnik Editor patches to find the 
you want. Just look in the Beatnik Editor’s JavaScript window to find the instrument num-
ber, then type that number into the Event List, replacing the Instrument name. Or, if yo
already recorded notes in the Track, just choose the instrument name you set in the Track 
Properties dialog box.

Tip: See the Goodies folder for an Instrument Profile for the Beatnik Editor. With this pro
file, you won’t have to count instrument numbers to find patches.

When you’re finished, the dialog box should look something like this:

Tips: 
• Save your work often

• Remember that to ensure consistency of sound, your playback settings should 
match the Event List.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with Cubase VST/24 3.7 (Windows)
Beatnik has verified compatibility with Cubase VST, VST Score, and VST/24 for Windows, v
sion 3.7. For version 5.0, see the next section.

Note for Windows 2000 and NT Users: You should be prepared for a certain amount 
irregularity in live MIDI event timing, as these operating systems are optimized fo
server processes, not real-time media presentation.

Setting Up
1. Install some form of MIDI linking software on your PC, following the supplied installatio

instructions.

We support two different freeware linking utilities: MIDI Yoke and HUBI.

• MIDI Yoke can be downloaded off the net. As of May, 2001, the most reliable 
place to get it is:

http://www.midiox.com/myoke.htm
If this site is inaccessible, do a search for MIDI Yoke and something will turn up.

• The HUBI Loopback Device is also available for download off the net at:

http://www.geocities.com/SiliconValley/Vista/2872/hmidilb/hmdlpbk.html
2. Install Cubase VST, VST Score, or VST/24 on your computer, following the supplied in

lation instructions.

3. Restart your computer.

This will enable the MIDI linking software, so that Cubase and the Beatnik Editor can d
it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Cubase. Otherwise Cubase won’t detect the Be
nik Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the File menu and select the Preferences... command, then in the Preferences dialog 
box select your linking utility as your MIDI input source:

• If you’re using MIDI Yoke, choose one of the three junctions. 

• If you’re using HUBI, choose LB1.

6. In the Beatnik Editor, make sure you have one or more Session windows open.

7. If you want visual linking, click on the Instruments tab in a Session window.

8. Launch Cubase.

9. In Cubase, change your MIDI Setup settings to prevent a MIDI feedback loop.

Note: By default, Cubase finds and enables all possible MIDI inputs. As a result, if the M
output is set to MIDI Yoke: junction 1 and that is in turned being looped through the Beatn
Editor, Cubase will be receiving its own output – a MIDI feedback loop. If this happens
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MIDI Yoke will disable the MIDI port and you’ll have to restart the computer to turn it ba
on.

To avoid this problem, you need to disable the Beatnik Editor’s MIDI In port:

• Go to the Options menu and select the MIDI Setup command. The MIDI Setup 
window will appear:

• In the MIDI Setup window, click on the Enable box, then un-check the MIDI 
Input that you selected for the Beatnik Editor (in MIDI Yoke or HUBI).

10. Click on the Exit button to save your changed MIDI Setup.

Working with Cubase and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Cubase will be able to find it when Cub
starts up.

2. Launch Cubase.

3. In Cubase, open your sequence.

4. Set up your Tracks to play back on the Beatnik Editor MIDI synthesizer.

Highlight any MIDI track, then:

• Click in the Output box (in the Track Info section) and select the same port that 
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 81

m 

r, 
o 
ally 

 the 
you selected (in MIDI Yoke or HUBI) as the Beatnik Editor’s MIDI Input.

• For all tracks that you want to play through the Beatnik Editor, select the same 
MIDI Output.

• Double-click in the Prg box, then type the patch number that you want to use for 
this track.

Note: Although Cubase uses Program numbers 1-128, the Beatnik Editor uses Progra
numbers 0-127. As a result, you need to enter a program number one higher than the one 
you want the Beatnik Editor to receive.

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Cubase, import it into the Beatnik Edito
and convert it to an RMF file that plays the same MIDI Instruments every time, you’ll have t
insert Bank Selects and Program Changes into your tracks’ MIDI event lists. This is especi
important if you’re using Instruments that you’ve created in the Beatnik Editor.

1. Open a Track in the Event List window.

Select a Track that contains notes that you want to drive the Beatnik Editor, then go to
Edit menu and select the List command. An Event List window will appear, looking some-
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thing like the following:

2. In the Event List window, insert a Bank Select event at the very start of the Track. This wi
a Continuous Controller message for controller number 0.

• Click in the Insert choices box, then select Control Change from the pop-up win-
dow:

• Change your cursor to the Pencil tool by right-clicking anywhere in the graphic 
part of the Event List window (right hand side).

• Since you want this to be the first event in the Track, click your pencil in the top 
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left corner of the Event List’s graphic part:

A new Control Change event will appear at the start of the Track.

• Beatnik uses the MSB form of the Bank Select message, so double-click on the 
new Control Change event in the Val.1 column, and type in 0.

Then, double-click in the Val.2 column and type in your desired Bank number.

The Bank number should be 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instru-
ments)

3. Still in the Event List window, insert your Program Change events:

• Click in the Insert choices box, then select Program Change from the pop-up 
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 and 
window:

• Change your cursor to the Pencil tool by right-clicking anywhere in the graphic 
part of the Event List window (right hand side).

• Since you want this to be the second event in the Track – directly after the Bank 
Select event – click your pencil just below the Bank Select event:

A new Program Change event will appear.

Or, to insert additional Program Changes at other times, you can insert one here
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then drag to the desired time.

• To set the Program (Instrument) number, double-click on the new Program 
Change event in the Val.1 column, and enter your desired Program number. The 
Program number should be in the range 1-128.

Note: Although Cubase uses Program numbers 1-128, the Beatnik Editor uses Progra
numbers 0-127. As a result, you need to enter a program number one higher than the one 
you want the Beatnik Editor to receive.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with Cubase VST/24 5.0 (Windows)
Beatnik has verified compatibility with Cubase VST, VST Score, and VST/24 for Windows v
sion 5.0. For version 3.7, see the previous section.

Note for Windows 2000 and NT Users: You should be prepared for a certain amount 
irregularity in live MIDI event timing, as these operating systems are optimized fo
server processes, not real-time media presentation.

Setting Up
1. Install some form of MIDI linking software on your PC, following the supplied installatio

instructions.

We support two different freeware linking utilities: MIDI Yoke and HUBI.

• MIDI Yoke can be downloaded off the net. As of May, 2001, the most reliable 
place to get it is:

http://www.midiox.com/myoke.htm
If this site is inaccessible, do a search for MIDI Yoke and something will turn up.

• The HUBI Loopback Device is also available for download off the net at:

http://www.geocities.com/SiliconValley/Vista/2872/hmidilb/hmdlpbk.html
2. Install Cubase VST, VST Score, or VST/24 on your computer, following the supplied in

lation instructions.

3. Restart your computer.

This will enable the MIDI linking software, so that Cubase and the Beatnik Editor can d
it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Cubase. Otherwise Cubase won’t detect the Be
nik Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the File menu and select the Preferences... command, then in the Preferences dialog 
box select your linking utility as your MIDI input source:

• If you’re using MIDI Yoke, choose one of the three junctions. 

• If you’re using HUBI, choose LB1.

6. In the Beatnik Editor, make sure you have one or more Session windows open.

7. If you want visual linking, click on the Instruments tab in a Session window.

8. Launch Cubase.

9. In Cubase, change your MIDI Setup settings to prevent a MIDI feedback loop.

Note: By default, Cubase finds and enables all possible MIDI inputs. As a result, if the M
output is set to MIDI Yoke: junction 1 and that is in turned being looped through the Beatn
Editor, Cubase will be receiving its own output – a MIDI feedback loop. If this happens
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MIDI Yoke will disable the MIDI port and you’ll have to restart the computer to turn it ba
on.

To avoid this problem, you need to disable the Beatnik Editor’s MIDI In port:

• Go to the Options menu and select the MIDI Setup item, and then the System sub-
command. The MIDI System Setup window will appear:

• In the MIDI System Setup window, click on the Enable box, then un-check the 
MIDI Input that you selected for the Beatnik Editor (in MIDI Yoke or HUBI):

• Click on the Exit button to save your changed MIDI Setup.

Working with Cubase and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Cubase will be able to find it when Cub
starts up.

2. Launch Cubase.

3. In Cubase, open your sequence.

4. Set up your Tracks to play back on the Beatnik Editor MIDI synthesizer.

Highlight any MIDI track, then:

• Click in the Output box (in the Track Info section) and select the same port that 
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you selected (in MIDI Yoke or HUBI) as the Beatnik Editor’s MIDI Input:

• For all tracks that you want to play through the Beatnik Editor, select the same 
MIDI Output.

• Click on the arrow next to the Prg box, then select 0-127 from the pop-up menu:

This is the patch numbering system that the Beatnik Editor uses.

• Click on the arrow next to the Bank box, then select Swap Value Bytes (Roland) 
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• Double-click in the Bank box, then type the Bank number that you want to use 
for this track:

Use Bank number 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

• Double-click in the Prg box, then type the patch number that you want to use for 
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this track:

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Cubase, import it into the Beatnik Edito
and convert it to an RMF file that plays the same MIDI Instruments every time, you’ll have t
insert Bank Selects and Program Changes into your Tracks’ MIDI event lists. This is espec
important if you’re using Instruments that you’ve created in the Beatnik Editor.

1. Open a Track in the Event List window.

Select a Track that contains notes that you want to drive the Beatnik Editor, then go to
Edit menu and select the List command. An Event List window will appear, looking some-
thing like the following:

2. In the Event List window, insert a Bank Select event at the very start of the Track. This wi
a Continuous Controller message for controller number 0.

• Click in the Insert choices box, then select Control Change from the pop-up 
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menu:

• Change your cursor to the Pencil tool by right-clicking anywhere in the graphic 
part of the Event List window (right hand side).

• Since you want this to be the first event in the Track, click your pencil in the top 
left corner of the Event List’s graphic part:

A new Control Change event will appear at the start of the Track.

• Beatnik uses the MSB form of the Bank Select message, so double-click on the 
new Control Change event in the Val.1 column, and type in 0:
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 92

sion 

rcus-

ents
• Then, double-click in the Val.2 column enter your desired Bank number:

The Bank number should be 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

3. Still in the Event List window, insert your Patch Change events.

• Click in the Insert choices box, then choose Program Change from the pop-up 
menu:

• Change your cursor to the Pencil tool by right-clicking anywhere in the graphic 
part of the Event List window (right hand side):

• Since you want this to be the second event in the Track – directly after the Bank 
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Select event –click your pencil just below the Bank Select event:

A new Program Change event will appear. Or, to insert additional Program Chang
other times, you can insert one here and then drag to the desired time.

• To set the Program (Instrument) number, double-click on the new Program 
Change event in the Val.1 column, and enter your desired Program number. The 
Program number should be in the range 1-128:

Note: Although Cubase uses Program numbers 1-128, the Beatnik Editor uses Progra
numbers 0-127. As a result, you need to enter a program number one higher than the one 
you want the Beatnik Editor to receive.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with emagic Logic Audio (Windows)
Beatnik has verified compatibility with Logic Audio for Windows, from version 4.0 through 4.
(we tested the Platinum version).

Note for Windows 2000 and NT Users: You should be prepared for a certain amount 
irregularity in live MIDI event timing, as these operating systems are optimized fo
server processes, not real-time media presentation.

Setting Up
1. Install some form of MIDI linking software on your PC, following the supplied installatio

instructions.

We support two different freeware linking utilities: MIDI Yoke and HUBI.

• MIDI Yoke can be downloaded off the net. As of May, 2001, the most reliable 
place to get it is:

http://www.midiox.com/myoke.htm
If this site is inaccessible, do a search for MIDI Yoke and something will turn up.

• The HUBI Loopback Device is also available for download off the net at:

http://www.geocities.com/SiliconValley/Vista/2872/hmidilb/hmdlpbk.html
2. Install Logic Audio on your computer, following the supplied installation instructions.

3. Restart your computer.

This will enable the MIDI linking software, so that Logic and the Beatnik Editor can de
it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Logic. Otherwise Logic won’t detect the Beatnik
Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the File menu and select the Preferences... command, then in the Preferences dialog 
box select your linking utility as your MIDI input source:

• If you’re using MIDI Yoke, choose one of the three junctions. 

• If you’re using HUBI, choose LB1.

6. In the Beatnik Editor, make sure you have one or more Session windows open.

7. If you want visual linking, click on the Instruments tab in a Session window.

8. Launch Logic Audio.

For the Beatnik Editor to function cleanly with Logic Audio, you’ll have to change two s
tings.

9. In Logic, change your Environment settings to prevent a MIDI feedback loop.

Logic automatically finds and enables all possible MIDI inputs. As a result, if you’re usi
loopback application such as MIDI Yoke, Logic will be receiving its own output – a MID
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feedback loop. To avoid this problem, you need to turn off this feature and manually a
all of your MIDI inputs:

• Go to the Windows menu and select the Open Environment command.

• In the Environment window, click and hold on the Object List, then select the item 
Click & Ports:

•  Click on the line that connects to the Physical Input object, and hit the Delete 
key on your computer keyboard:

The line will disappear, disconnecting the feedback loop.

10. Still in Logic, turn off or redirect MIDI Clock output to avoid tempo problems.

By default, Logic transmits its MIDI clock on a MIDI Output port. This can cause temp
problems when Logic is linked with the Beatnik Editor, as it would be transmitting the c
to the Beatnik Editor back to itself. It would try to synch with itself, which is impossible
and would cause erratic tempo changes and settings. To either turn off the transmissi
the MIDI clock or to manually assign the ports it is sent to:

•  Go to the Options menu, select the Settings item, and then the Midi Options sub-
command.

• Then, in the Midi Options dialog box, either turn off MIDI Clock transmission, or 
re-direct it to an alternate MIDI port:
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• To turn off MIDI Clock completely, un-check the Transmit MIDI Clock checkbox:

• Or, to assign MIDI Clock to a different MIDI port, click on the box to the right of 
the Transmit MIDI Clock checkbox, then select the desired MIDI Output port 
from the pop-up menu that appears, and finally, make sure the Transmit MIDI 
Clock checkbox is checked:

Working with Logic Audio and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Logic will be able to find it when Logic 
starts up.

2. Launch Logic Audio.

3. In Logic, open your sequence.

4. Set up your MIDI Tracks to play back on the Beatnik Editor MIDI synthesizer.

For each MIDI Track (in a new song, this will usually be track 10 and it will be assigne
GM Device 1):

• Set the MIDI Output port.

Click and hold on the MIDI out selection, then select the same port you picked for 
MIDI Input in the Beatnik Editor. If you’re using MIDI Yoke, select the same juncti
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 a 
you picked in the Beatnik Editor, or if you’re using HUBI, select LB1.

• Set the Track’s Bank and Program numbers:

– Click on the GM Device:

– In the GM Device window that appears, click and hold on the *Custom Bank Mes-
sages* pop-up menu and select Bank Message: Control 0. Then click and hold on the 
(No Bank specified. Names of Bank 0 used) pop-up menu and select Bank 1:

– In the LOGIC Audio dialog box that appears, asking whether you want to initialize
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new bank, click the Initialize button:

– Still in the GM Device window, click and hold in the same pop-up menu again, a
select Bank 2:

– When the Initialize new Bank? window appears again, click the Initialize button 
again.

– Click on the dash to the right of Prg to select the Bank you want to use. Use Bank
1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

Note: If you’re on channel 1, the Beatnik Editor will highlight your selection to refle
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– Click on the number to the right of the Bank number, then select your desired P
gram (patch) number.

Note: These settings only affect playback, not exported Standard MIDI Files. If you wa
export a MIDI file, import it into the Beatnik Editor, and export it as an RMF file with th
exact same instruments assigned to it, then you’ll have to insert Bank Select and prog
Change events into the track event lists.

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Logic, import it into the Beatnik Editor, a
convert it to an RMF file that plays the correct MIDI Instruments every time, you’ll have to in
Bank Selects and Program Changes into your tracks’ MIDI event lists. This is especially im
tant if you’re using Instruments that you’ve created in the Beatnik Editor.

1. Open a Track in the Event List window.

Select a Track that contains notes that you want to drive the Beatnik Editor, then go to
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Windows menu and select the Open Event List command. An Event List window will appear:

2. In the Event List window, insert a Bank Select event at the very start of the Track. This wi
a Continuous Controller message for controller number 0.

• Change your cursor to the pencil too, then right-click on the Control Change 
Events button:

A new Control Change event will appear in the list:

• Change your cursor back to the arrow.

• Set the event time by double-clicking on the new event in the Position column, 
then typing the time at which you want the bank change to occur. The event will 
move to the new time in the event list.

For example, 1 1 1 1 is the first event, and 1 1 1 2 happens immediately after – in the 
first measure, first beat, first division, and second tick.

• Set the first part of the Bank number by double-clicking on the event in the NUM 
column, then typing the number 0. When you hit the Return or Enter key, the 
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Length/Info column will change to Bank MSB.

• Set the second part of the Bank number by double-clicking on the event in the 
VAL column, then typing the actual Bank number you want to use:

Use Bank number 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

3. Still in the Event List window, insert your Program (patch) Change events:

• Change your cursor to the pencil tool, then right-click on the Program Change 
Events button:

A new Program Change event will appear in the list.

• Change your cursor back to the arrow.

• Set the event time by double-clicking on the new event in the Position column, 
then typing the time at which you want the bank change to occur:

The event will move to the new time in the event list.

Note: Make sure the time of the Program Change is after the time of the Bank Change

• Set the Program number by double-clicking on the event in the VAL column, then 
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typing your desired program number:

Tips: 
• Save your work often

• Remember that to ensure consistency of sound, your playback settings should 
match the Event List.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with MOTU Digital Performer

(Mac OS)
Beatnik has verified compatibility with Digital Performer versions 2.6, 2.7, 2.7.1, and 2.7.2.

Setting Up
1.  Install MIDI linking software on your computer, following the supplied installation instru

tions. You’ll need to use both the Open Music System (OMS) and MOTU’s FreeMIDI. O
is needed because the Beatnik Editor will listen to OMS, but not to FreeMIDI, so FreeM
has to talk to OMS in order to communicate to the Beatnik Editor. They can both be d
loaded from the Web.

• OMS is available at:

http://www.opcode.com/downloads/
For best results, make sure to get version 2.1 or greater.

• FreeMIDI is available on your Performer CD, or at:

http://www.motu.com/english/download/
Make sure to get version 1.43 or greater – earlier versions will not work with the 
Beatnik Editor.

If either of these sites are inaccessible, do a Web search using your favorite search en

2. Install Digital Performer and FreeMIDI on your computer, following the supplied installa
instructions.

Important: When you run the FreeMIDI Setup program, go to the File menu and select Free-
MIDI Preferences. In the FreeMIDI Preferences dialog box that appears, be sure to turn o
the following options:

• Allow other applications
• Use OMS when available

3. Restart your computer.

This will activate OMS and FreeMIDI, so that Digital Performer and the Beatnik Editor 
detect them.

4. Turn off AppleTalk manually, to avoid possible crashes when using OMS.

When using OMS with AppleTalk active, the computer may crash when you exit either
ital Performer or the Beatnik Editor. Although OMS will try to turn AppleTalk off automa
cally, that will not prevent the crash. To avoid this problem, manually turn AppleTalk off 
before starting either Digital Performer or the Beatnik Editor:

• Go to the Apple menu, then open the AppleTalk Control Panel.

• In the AppleTalk Control Panel, click the Options… button. The AppleTalk 
Options dialog box will appear.

• In the AppleTalk Options dialog box, select the Inactive option, then click the OK 
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button. The dialog box will close.

• Close the AppleTalk Control Panel.

5. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Digital Performer. Otherwise Digital Performer 
won’t detect the Beatnik Editor at the other end of the linking utility.

6. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the Edit menu and select the Preferences... command, then in the Preferences dialog 
box select OMS as your MIDI input source.

7. In the Beatnik Editor, make sure you have one or more Session windows open.

8. If you want visual linking, click on the Instruments tab in a Session window.

9. Launch Digital Performer.

Note: If FreeMIDI displays a dialog box asking whether you’d like it to slave to OMS, 
answer Yes.

Working with Digital Performer and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. In Digital Performer, open your sequence.

If you open a demo or other pre-existing file, Digital Performer may prompt you to rem
the sequence’s MIDI destinations. If so, click in the New Assignment Column (under MIDI 
Destinations) and select Beatnik.

Note: Digital Performer doesn’t recognize the Beatnik Editor as a multi-Bank synthesiz
As a result, you’ll need to enter all your Bank Selects in your Track Event Lists. If you 
enter a Program number in the Arrangement window, Digital Performer will always access
Beatnik’s Bank 0 – never Bank 1 or Bank 2.

2. Verify that the link is working.

MIDI events on MIDI channel 1 are visually linked to the Beatnik Editor. This gives you
easy way to verify that the link is working: Just send a Program (patch) Change from D
Performer on channel 1, and look at the Beatnik Editor to see whether that same patc
ber is highlighted in the Instruments tab of the current Session window.

Note: Although Digital Performer uses Program numbers 1-128, the Beatnik Editor use
Program numbers 0-127. As a result, you need to enter a program number one higher than 
the one you want the Beatnik Editor to receive.

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Digital Performer, import it into the Beat
Editor, and convert it to an RMF file that plays the correct MIDI Instruments every time, you
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have to insert Bank Selects and Program Changes into your tracks’ MIDI event lists. This is
cially important if you’re using Instruments that you’ve created in the Beatnik Editor.

1. Open a Track in the Event List window.

Pick a Track that contains notes that you want to drive the Beatnik Editor, then go to t
Transport window and click the Event List button:

The Event List window will appear.

2. In the Event List window, insert a Bank Select event at the very start of the Track. This wi
a Continuous Controller message for controller number 0.

• In the Event List toolbar, click on the Insert button, and then select the Controller 
option.

A time position box will appear:

• You want the event to occur at the very start of the Track, so type in 1/1/001. The 
new event will appear at the top of the list.

• In the new event, double-click on the column beneath the Zoom button, then type 
in the number 0 to set the Most Significant Byte (MSB) part of the Bank Select 
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• Again in the new event, double-click on the column beneath the Audible Mode 
button, then type in a number to set the Bank Number part of the Bank Select 
message to the Bank you want to use:

Use Bank 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

3. Still in the Event List window, insert your Program (patch) Change events:

• In the Event List toolbar, click on the Insert button, and then select the Patch 
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A time position box will appear:

• You want the event to occur right after the Bank Select message, so type in 1/1/
002. The new event will appear at the top of the list.

• In the new event, double-click on the column beneath the Zoom button, then type 
in the number of the program you want to use:

Note: Although Digital Performer uses Program numbers 1-128, the Beatnik Editor use
Program numbers 0-127. As a result, you need to enter a program number one higher than 
the one you want the Beatnik Editor to receive.

Tips: 
• Save your work often

• Remember that to ensure consistency of sound, your playback settings should 
match the Event List.

Moving Your Sequence Into the Beatnik Editor and the RMF 
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Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with emagic Logic Audio (Mac OS)
Beatnik has verified compatibility with Logic Audio Silver, Gold, and Platinum, versions 4.1.
through 4.7.0.

Setting Up
1.  Install MIDI linking software on your computer, following the supplied installation instru

tions. We support the Open Music System (OMS), which can be downloaded from the
OMS is available at:

http://www.opcode.com/downloads/
For best results, make sure to get version 2.1 or greater. If this site is inaccessible, do
search using your favorite search engine.

2. Install Logic Audio Silver, Gold, or Platinum on your computer, following the supplied 
installation instructions.

3. Restart your computer.

This will enable the MIDI linking software, so that Logic Audio and the Beatnik Editor c
detect it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Logic Audio. Otherwise Logic Audio won’t detect
the Beatnik Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the Edit menu and select the Preferences... command, then in the Preferences dialog 
box select OMS as your MIDI input source.

6. If OMS prompts you to turn off AppleTalk, answer OK.

AppleTalk is known to interfere with MIDI, and can cause both Logic and the Beatnik E
tor to hang.

7. In the Beatnik Editor, make sure you have one or more Session windows open.

8. If you want visual linking, click on the Instruments tab in a Session window.

9. Launch Logic Audio.

Working with Logic Audio and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Logic will be able to find it when Logic 
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starts up.

2. Launch Logic Audio.

3. In Logic, open your sequence.

4. Set up your MIDI Tracks to play back on the Beatnik Editor MIDI synthesizer.

For each MIDI Track (in a new song, this will usually be track 10 and it will be assigne
GM Device 1):

• Set the MIDI Output port.

Click and hold on the MIDI out pop-up menu, then select Beatnik:

• Set the Track’s Bank and Program numbers:

– Click on the GM Device (above the MIDI out selector). The GM Device window will 
appear:

– In the GM Device window, click and hold on *Custom Bank Messages*, then select 
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Bank Message: Control 0 from the pop-up menu:

– Click and hold on the (No Bank specified. Names of Bank 0 used) pop-up menu, then 
select Bank 1:

– In the dialog box that appears, asking whether you want to initialize a new ban
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click the Initialize button:

– Click and hold in the same pop-up menu again, and then select Bank 2:

– When the Initialize new Bank? dialog box appears again, click the Initialize button 
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– Click on the dash to the right of the Prg box to select the Bank you want to use:

Use Bank 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

Note: If you’re on channel 1, the Beatnik Editor will highlight your selection to refle
any Bank Select or Program Change.

– Click on the number to the right of the Bank number, then select your desired P
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Note: These settings only affect playback, not exported Standard MIDI Files. If you wa
export a MIDI file, import it into the Beatnik Editor, and export it as an RMF file with th
exact same instruments assigned to it, then you’ll have to insert Bank Select and Prog
Change events into the Track Event Lists.

Inserting MIDI Bank Select and Program Change (Patch 
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Events Into Your Sequence
In order for you to be able to export a MIDI file from Logic, import it into the Beatnik Editor, a
convert it to an RMF file that plays the correct MIDI Instruments every time, you’ll have to in
Bank Selects and Program Changes into your tracks’ MIDI event lists. This is especially im
tant if you’re using Instruments that you’ve created in the Beatnik Editor.

1. Open a Track in the Event List window.

Select a Track that contains notes that you want to drive the Beatnik Editor, then go to
Windows menu and select the Open Event List command.

2. In the Event List window, insert a Bank Select event at the very start of the Track. This wi
a Continuous Controller message for controller number 0.

• Change your cursor to the pencil tool, then control-click on the green Control 
Change Events button:

A new Control Change event will appear in the list:

• Change your cursor back to the arrow.

• Set the event time by double-clicking on the new event in the Position column, 
then typing the time at which you want the bank change to occur:

The event will move to the new time in the event list.

For example, 1 1 1 1 is the first event, and 1 1 1 2 happens immediately after – in the 
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first measure, first beat, first division, and second tick.

• Set the first part of the Bank number by double-clicking on the event in the NUM 
column, then typing the number 0:

When you hit the Return or Enter key on your computer keyboard, the Length/Info col-
umn will change to Bank MSB.

• Set the second part of the Bank number by double-clicking on the event in the 
VAL column, then typing the actual Bank number you want to use.

Use Bank 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

3. Still in the Event List window, insert your Program (patch) Change events:

• Change your cursor to the pencil tool, then control-click on the green Program 
Change Events button:

A new Program Change event will appear in the list.

• Change your cursor back to the arrow.

• Set the event time by double-clicking on the new event in the Position column, 
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then typing the time at which you want the bank change to occur:

The event will move to the new time in the event list.

Note: Make sure the time of the Program Change is after the time of the Bank Change

• Set the Program number by double-clicking on the event in the VAL column, then 
typing your desired program number:

Tips: 
• Save your work often

• Remember that to ensure consistency of sound, your playback settings should 
match the Event List.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with Steinberg Cubase VST/24 (Mac OS)
Beatnik has verified compatibility with Cubase VST/24 for Mac OS, versions 4.1 through 5.

Setting Up
1.  Install MIDI linking software on your computer, following the supplied installation instru

tions. We support the Open Music System (OMS), which can be downloaded from the
OMS is available at:

http://www.opcode.com/downloads/
For best results, make sure to get version 2.1 or greater. If this site is inaccessible, do
search using your favorite search engine.

2. Install Cubase VST, VST Score, or VST/24 on your computer, following the supplied in
lation instructions.

3. Restart your computer.

This will enable the MIDI linking software, so that Cubase and the Beatnik Editor can d
it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Cubase. Otherwise Cubase won’t detect the Be
nik Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the Edit menu and select the Preferences... command, then in the Preferences dialog 
box select OMS as your MIDI input source.

6. If OMS prompts you to turn off AppleTalk, answer OK.

AppleTalk is known to interfere with MIDI, and can cause both Cubase and the Beatnik
tor to hang.

7. In the Beatnik Editor, make sure you have one or more Session windows open.

8. If you want visual linking, click on the Instruments tab in a Session window.

9. Launch Cubase.

10. If this is the first time you’ve opened Cubase, it will prompt you to select a MIDI routin
utility. Select OMS In and Out.

Working with Cubase and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Cubase will be able to find it when Cub
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2. Launch Cubase.

3. In Cubase, open your sequence.

4. Set up your Tracks to play back on the Beatnik Editor MIDI synthesizer.

Highlight any MIDI track, then:

Click in the Output box (in the Track Info section) and select Beatnik from the pop-up 
menu:

• For all tracks that you want to play through the Beatnik Editor, select Beatnik as 
the MIDI Output.
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• Click and hold on the Prg box, then select 0-127 from the pop-up menu:

This is the patch numbering system that the Beatnik Editor uses.

• Click and hold on the Bank box, then select Swap Value Bytes (Roland) from the 
pop-up menu: (Leave Send MSB First checked.)

• Double-click in the Bank box, then type the Bank number that you want to use 
for this track:

Use Bank 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

Note: You can also adjust the Bank number by clicking the top or bottom of the bo
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• Double-click in the Prg box, then type the patch number that you want to use for 
this track:

5. Verify that the link is working.

MIDI events on MIDI channel 1 are visually linked to the Beatnik Editor. This gives you
easy way to verify that the link is working: Just send a Program (patch) Change from 
Cubase on channel 1, and look at the Beatnik Editor to see whether that same patch n
is highlighted in the Instruments tab of the current Session window.

Note: If you want to access the Beatnik Editor’s Percussion Banks, then select channe
set the Prg to OFF, and select the Bank of your choice (again, 0, 1, or 2):

As with most MIDI Percussion Banks, each MIDI note number (pitch) plays a different
cussion Instrument, all at natural pitch instead of transposing to different pitches. (To 
pitch control over a Percussion instrument, use the Beatnik Editor to copy it into your 
tom Melodic Bank.)

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Cubase, import it into the Beatnik Edito
and convert it to an RMF file that plays the same MIDI Instruments every time, you’ll have t
insert Bank Selects and Program Changes into your tracks’ MIDI event lists. This is especi
important if you’re using Instruments that you’ve created in the Beatnik Editor.

1. Open a Track in the Event List window.

Select a Track that contains notes that you want to drive the Beatnik Editor, then go to
Edit menu and select the List command. An Event List window will appear, looking some-
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2. In the Event List window, insert a Bank Select event at the very start of the Track. This wi
a Continuous Controller message for controller number 0.

• Click in the Insert choices pop-up menu, then select Control Change:

• Change your cursor to the Pencil tool by control-clicking and selecting the Pencil 
tool from the pop-up box:

• Since you want this to be the first event in the Track, click your pencil in the top 
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left corner of the Event List’s graphic part:

 A new Control Change event will appear at the start of the Track.

• Beatnik uses the MSB form of the Bank Select message, so double-click on the 
new Control Change event in the Val.1 column, and type in 0. Then, double-click 
in the Val.2 column enter your desired Bank number.

The Bank number should be 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

3. Still in the Event List window, insert your Patch Change events.

• Click in the Insert choices box, then choose Program Change from the pop-up 
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 124

m 

nding 
Editor, 
window:

• Change your cursor to the Pencil tool by control-clicking and selecting the Pencil 
tool from the pop-up box.

• Since you want this to be the second event in the Track – directly after the Bank 
Select event – click your pencil just below the Bank Select event. A new Program 
Change event will appear. Or, to insert additional Program Changes at other 
times, you can insert them here and then drag to the desired time.

• To set the Program (Instrument) number, double-click on the new Program 
Change event in the Val.1 column, and enter your desired Program number. The 
Program number should be in the range 1-128:

Note: Although Cubase uses Program numbers 1-128, the Beatnik Editor uses Progra
numbers 0-127. As a result, you need to enter a program number one higher than the one 
you want the Beatnik Editor to receive.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Linking with Opcode Vision DSP

(Mac OS)
Beatnik has verified compatibility with Vision DSP version 4.5.

Setting Up
1.  Install MIDI linking software on your computer, following the supplied installation instru

tions. We support the Open Music System (OMS), which can be downloaded from the
OMS is available at:

http://www.opcode.com/downloads/
For best results, make sure to get version 2.1 or greater. If this site is inaccessible, do
search using your favorite search engine.

2. Install Vision DSP on your computer, following the supplied installation instructions.

3. Restart your computer.

This will enable the MIDI linking software, so that Vision and the Beatnik Editor can de
it.

4. Launch the Beatnik Editor.

Always launch the Beatnik Editor before Vision. Otherwise Vision won’t detect the Beatnik
Editor at the other end of the linking utility.

5. In the Beatnik Editor, select the linking utility as your MIDI input source.

Go to the Edit menu and select the Preferences... command, then in the Preferences dialog 
box select OMS as your MIDI input source.

6. If OMS prompts you to turn off AppleTalk, answer OK.

AppleTalk is known to interfere with MIDI, and can cause both Vision and the Beatnik 
tor to hang.

7. In the Beatnik Editor, make sure you have one or more Session windows open.

8. If you want visual linking, click on the Instruments tab in a Session window.

9. Launch Vision

Working with Vision and the Beatnik Editor
Remember: Always launch the Beatnik Editor first.

1. Launch the Beatnik Editor.

Launching the Beatnik Editor first ensures that Vision will be able to find it when Vision
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2. Launch Vision.

3. In Vision, open your sequence.

4. Set up your Tracks to play back on the Beatnik Editor MIDI synthesizer.

Highlight any track in the Song window, then click in the Instrument column and select 
Beatnik-X (where X is the MIDI channel number to which you want to assign the track).

Note: To access instruments in Beatnik Editor Banks 1 or 2, you’ll have to enter MIDI B
Select events in the Event List (see next section). If you enter Program (patch) Chang
events in the Song window without any Bank Select to move to Bank 1 or 2, Vision will on
access the Beatnik Editor’s Bank 0.

5. Verify that the link is working.

MIDI events on MIDI channel 1 are visually linked to the Beatnik Editor. This gives you
easy way to verify that the link is working: Just send a Program (patch) Change from V
on channel 1, and look at the Beatnik Editor to see whether that same patch number 
lighted in the Instruments tab of the current Session window.

Inserting MIDI Bank Select and Program Change (Patch 
Change)
Events Into Your Sequence
In order for you to be able to export a MIDI file from Vision, import it into the Beatnik Editor, a
convert it to an RMF file that plays the same MIDI Instruments every time, you’ll have to ins
Bank Selects and Program Changes into your tracks’ MIDI event lists. This is especially im
tant if you’re using Instruments that you’ve created in the Beatnik Editor.

Note: To access instruments in Beatnik Editor Banks 1 or 2, you’ll have to enter MIDI B
Select events in the Event List. If you enter Program (patch) Change events in the Song win-
dow without any Bank Select to move to Bank 1 or 2, Vision will only access the Beatn
Editor’s Bank 0.

1. Open the Event List window.

Go to the Windows menu and select the List command.

2. In the Event List window, insert a Bank Select / Program Change event.
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• Click and hold on the Insert button, then select Patch from the pop-up menu:

A new Bank Select / Program Change event will appear in the list.

• Click on the first column and type in the time at which you want the Bank Select 
/ Program Change event to occur – usually the very start:

• Click on the far right column, and then select B0 PC from the pop-up menu:

• Click on the number after B0, and then type in the number of the Bank you want 
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Use Bank 0, 1, or 2:

Bank 0: General MIDI Melodic Instruments (on channel 10: General MIDI Percus
Instruments)

Bank 1: Beatnik Special Melodic Instruments (on channel 10: Beatnik Special Pe
sion)

Bank 2: Custom Melodic Instruments (on channel 10: Custom Percussion Instrum

• Click on the number after PC and enter the program number of the Beatnik 
Instrument you want to use:

Tips: 
• Save your work often

• Remember that to ensure consistency of sound, your playback settings should 
match the Event List.

Moving Your Sequence Into the Beatnik Editor and the RMF 
Format
When you’re finished inserting all your Bank and Patch changes, and your notes are all sou
the way you want them, save your sequence as a Standard MIDI File. Then, in the Beatnik 
Import that MIDI file into a Session window (or just drag it into the Songs tab of a Session win-
dow), Play the song as a check, and finally export it as an RMF file.
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Advanced Techniques

How to use the Beatnik Editor for advanced interactive audio techniques.

Heading… Covers…
Creating Banks of Trigger-
able Samples (RMFX)

How to make an RMF file without any Song data – a collec-
tion of Instruments that can be triggered from JavaScript, 
Lingo, C, C++, or Java code. This technique is most often 
used to trigger sampled sound effects, dialog, or music pre-
mixes.

Automatic Looping and Track 
Muting

How to use markers and controllers in your MIDI file data, to
make the Beatnik playback sequencer loop a section of RM
music while automatically muting a different set of tracks at 
each pass through the loop.

MIDI Channel Modes How to access and use MIDI channel Melodic and Percussio
modes beyond the default General MIDI behavior.
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Creating Banks of Triggerable Samples (RMFX)
Ordinarily, the custom Beatnik Instruments included in an RMF file are played by notes sto
the MIDI files included in the same RMF file. However, all Beatnik playback platforms also 
include a programming interface with commands that allow the software developer to play 
vidual notes whenever desired, using any available Instrument, without involving any MIDI 
When this technique is combined with an RMF file that contains sampled audio clips, you g
ability to trigger any sample – a music premix, a dialog line, or a sound effect – interactively
any time. This section describes how to make and use RMF files containing just banks of sa
– and no Song data – for use in this way. Beatnik’s term for such an RMF file is RMFX.

Samples Are Stored as Custom Instruments in the RMFX File
All sound resources in RMF files are accessed through the scheme of MIDI musical instrum
programs. That may seem a little strange for sounds intended for playback at natural pitch 
exactly the kinds of samples you’ll most often want to use in RMFX files – but recall that Be
Instruments are always based on digital audio Samples. That means they can contain recor
any kind of sound at all, and not just the single musical tone usually used in conventional In
ments. It also means that the Custom Instruments in RMF files can be used like little audio
tridges, each one loaded with its own sound recording, ready to be triggered at any time. F
example, an audio logo to play when the mouse rolls over the company’s logo image, or a 
effect to play when the user clicks on a link.

Events Come from the Programming, Not the RMFX File
For these kinds of effects, you’ll rely on the developer of the Web page (or the Director Mov
the application, depending on your context) to do all the Instrument selection and note eve
gering – so there’s no longer any need to include any Custom Songs (imported MIDI data) i
exported RMF file. All the RMF file needs to include is the Custom Samples, and the Instrum
that are needed to access the samples.

Planning an RMFX File
There are basically two ways to arrange an RMFX file:

• Option A: Collect all the Samples into a single Instrument, with a separate Keymap Zone
each Sample.

In this approach, different note numbers trigger different Samples, and they all play at
correct pitch. This approach means more work if you want to play the samples at diffe
musical pitches, but in many applications – like spoken dialog or music remixers – you
not need to re-pitch the sounds anyway.

• Option B: Create a separate Instrument for each Sample.

In this approach, you can easily play the sample at different musical pitches by changi
note number in your noteOn()  or playNote()  commands.

It’s best to decide which of these two setup options you want to use before you start building your 
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RMFX file. With a little experience you’ll learn to mix the two options together within a singl
RMFX file, but for your first experiments you may want to pick just one or the other.

Building an RMFX File
Constructing simple RMFX files can be very easy, as the Beatnik Editor commands Make Instru-
ment Using... and Export RMF... automate most of the detail work. Basically, you just drag your
Samples in, create the Instrument(s) in one operation, and then generate the RMFX file in 
ond operation.

With the Beatnik Editor open:

1. Create a new Session file for your RMFX project.

• From the File menu, select the New command. A new Session document window 
called Untitled Session will appear.

• Go to the File menu again, select the Save As... command, and save your new 
Session file in an appropriate folder, with an appropriate filename.

2. Import your Samples.

In your Session document window, click the Samples tab. Then collect the sample files tha
you want to use anywhere on your desktop, and drag them all into the empty Samples list 
area. This will produce a new Sample item for each dragged sample file, each with the
name as the file. Any loops will be preserved.

3. Compress your Samples.

Still in the Samples tab of your Session document window, select all of your Samples,
then go to the Sample menu and select the Compression... command. The Compression dia-
log box will appear.

Use the Compression dialog box to apply the right compression for your material. In mos
cases, this will be one of the MP3 options. You can apply the same compression type
of your Samples in a single operation.

4. Create your Instrument or Instruments.

Still in the Samples tab of your Session document window, select all of your Samples, a
then go to the Sample menu and select the Make Instrument Using... command. The Make 
Instrument dialog box will appear. 

Set your Instrument options, and then click the OK button:

• If you decided to Combine Samples Into One Instrument, pick that option and 
also pick the sub-option One per key, starting at. You can change the starting key 
if you want to.

• If you decided to Separate Into Multiple Instruments, pick that option. If you 
want the samples to sound at their original pitches, you’ll have play them at the 
indicated Root Key note. You can change the Root Key note if you want to.

Your new Instrument or Instruments will appear in the Instruments tab of the Session docu-
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ment window, numbered starting at 0.

If you ever want to start adding variations to your Sample playback, like a volume enve
filtering, or modulation, you can modify the Instrument or Instruments in the Instrument 
Editor window.

5. Check your Instrument or Instruments.

In your Session document window, go to the Instruments tab and double-click the newly 
created Instrument or Instruments. The Keymap Zones page of the Instrument Editor win-
dow will show the MIDI note numbers you’ll need to use (in playNote()  and noteOn()  
commands) to trigger each Sample in each Instrument, so you may want to take note

You can also audition a selected Instrument with the keyboard in the Player window, if 
you’d like to verify that all your Samples are playing correctly.

6. Export your RMFX file.

In the Instruments tab of your Session document window, make sure the Show: menu says 
Bank 2: Custom Melodic, and then select all the Instruments shown.

Now go to the File menu and select the Export RMF... command.

One of the Export RMF dialog boxes will appear, asking whether you want to create an RM
file or an RMFX file. Pick the RMFX option, and then click the OK button.

The Save RMF File dialog box will appear. Use it to save your new RMFX file in an appr
priate folder, with an appropriate name. The RMFX file is ready for use in your produc

Note: If you want the RMFX file to include a copyright notice, credits, and other ‘meta-data’ 
information, you’ll have to change this procedure slightly. Before step 6, use the Instrument
command Make Song Using to create a Custom Song, then use the Song menu command Song 
Info to enter your info. Then, rather than using the Export RMF... command on your custom Instru
ments, apply it to the Custom Song instead. True, this will add a very small ‘dummy’ MIDI fi
your RMFX file – but because meta-data is attached to Songs rather than the RMF file itse
the only way to attach the copyright notice, etc.

Triggering RMFX Samples from the Production
To trigger the samples in your RMFX samples from a Web page or Director movie, the prog
mer will need to use the appropriate combination of the Music Object commands playNote() , 
noteOn() , and/or noteOff()  commands (using the optional Bank and Program parameters –
sure to indicate Bank 2, as RMFX samples are always in the Beatnik Custom Instruments 
For programming details, please refer to the Music Object Web Authoring Documentation, or the 
Beatnik Xtra User’s Guide. (Application programmers using the Beatnik Audio Engine should 
consult the BAE Client API Developer Reference for the equivalent information for that con

If you chose Option A (Single Instrument):
• To trigger a full sample, use the command noteOn() , supplying the note number for the 

desired sample. No noteOff()  is needed, as reaching the end of the sample produces the
same effect. However, if the Sample loops, it will continue to play until a corresponding 
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Alternatively, you could use playNote()  instead of noteOn() , as long as the duration is 
longer than the Sample’s own length.

• To stop a sample before it reaches the end, or to exit a loop, send a corresponding noteOff()  
command when you want the sample to stop.

Alternatively, you could use playNote()  instead of noteOn()  and noteOff() , with a dura-
tion shorter than the Sample’s own length. Be sure to indicate Bank 2, as RMFX sampl
always in the Beatnik Custom Instruments Bank.

If you chose Option B (Multiple Instruments):
• To trigger the selected sample at its natural pitch, use the command noteOn() , supplying the 

Root Key note for the selected sample. No noteOff()  is needed, as reaching the end of the
sample produces the same effect. However, if the Sample loops, it will continue to play u
corresponding noteOff()  is received.

Alternatively, you could use playNote()  instead of noteOn() , as long as the duration is 
longer than the Sample’s own length.

• To trigger the selected sample at a transposed pitch, use the command noteOn() , supplying a 
pitch other than the selected instrument’s Root Key note. The sample’s pitch will be tran
posed by the same amount as the difference between the Root Key and the played not
ber. For example, if you play an Instrument at a note that’s 12 semitones above its Roo
the Sample will play back one octave higher than its natural pitch.

Note: If the Sample contains rhythmic music material, changing the pitch will also dire
affect its tempo.

• To stop the sample before it reaches the end, or to exit a loop, send a corresponding 
noteOff()  command when you want the sample to stop.

Alternatively, you could use playNote()  instead of noteOn()  and noteOff() , with a dura-
tion shorter than the Sample’s own length. Be sure to indicate Bank 2, as RMFX sampl
always in the Beatnik Custom Instruments bank.
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Automatic Looping and Track Muting
This feature allows you to automate muting and unmuting of tracks in a looping file to creat
musical “playlists,” which can be of great benefit for reducing the size of a long file. This is 
accomplished with controllers in the MIDI data which tell the synth to play or not play speci
tracks in a predetermined order. It is not a real-time interactive feature.

Here's how it works:

1. Start with a MIDI sequence designed to loop end-to-end, which does not contain “loopstart” 
and “loopend” markers.

2. Insert, in any track, a continuous controller #85 whose value will indicate the total numb
loops of the file that will comprise the “playlist” (counting from zero).

3. Determine which loop repeats in which you want each track to play, and insert controlle
follows: to play track during loop (x): controller 87: (x); to mute track during loop (x): co
troller 86: (x).

As an example, let’s say that you have a file that I want to loop 3 times, and you want to he
piano solo during the second loop.

On any track, you would insert controller 85: 2, for 3 loops.

Then, on the track with the piano solo, I would insert:

• On any track, you would insert controller 85: 2, for 3 loops.

• Then, on the track with the piano solo, you would insert: controller 86=0, control-
ler 87=1, and controller 86=2

A few important points:

• All of the controller data must be at 1,0,0if a track does not have controller 86/87 
data, it will play normally.

• If there is no controller 86/87 corresponding to a particular loop value, the track 
in question will remain in its current state, either muted or unmuted.

• The file will play indefinitely; when the maximum loop value set with controller 
85 is reached, it resets to 0.

• The total number of tracks is limited to 64.

What results from this process is a file of a rather short duration (8 or 16 bars, perhaps) with
the different sections of the song lined up vertically. The process can be quite laborious an
requires great care; because it is based on tracks, not channels, the muting / unmuting fea
not be auditioned while linked to sequencer. One has to plot out the structure, collapse all th
into a short sequence (which means this won’t work with music that has uneven phrase len
meter changes), insert all the controller data, then hear the results after importing the MIDI
into the Editor.

Why would anyone want to go through all this trouble when they could just as easily create 
MIDI sequence with whatever arrangement they pleased? The main benefit of using this fea
decreased file size, typically cutting the MIDI data at least in half, or much more if there is a
repetitive pitch bend or continuous controller data. Plus, an RMF file could go on for 5, 10, 
minutes without repeating itself and still not be appreciably larger than a much shorter vers
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MIDI Channel Modes
The Beatnik MIDI Synthesizer supports an unusual MIDI Channel Mode, called Pitched Pe
sion, that gives you additional creative options by letting you play Percussion Bank Instrum
like regular Instruments, so that their pitch is transposed according to the MIDI note numbe
example, “talking drum” effects become easy, and you may discover other unusual and use
sound textures by playing Percussion Instruments at unexpected pitches. For example, you
a cool Gong-like effect if you play a cymbal crashes at a very low pitch. And Percussion so
played at high pitches make good user interface clicks.

You can also use MIDI Channel Mode control to make MIDI channels other than channel 1
behave like additional Drum channels. In fact, you can put any MIDI channel into any MIDI
Channel Mode.

About MIDI Channel Mode
MIDI Channel Mode determines how a channel will interpret MIDI note events. Each chann
tracks its own MIDI Channel Mode independently, and all notes played on a channel will so
using the channel’s current MIDI Channel Mode. Any channel can be put into any MIDI Cha
Mode with a Non-Registered Parameter Number, but by default, all channels start up in the
mal General MIDI Mode.

In addition to the two MIDI channel modes used in the General MIDI scheme (Normal Percu
and Normal Melodic modes), the Beatnik MIDI Synthesizer offers a third mode, Pitched Pe
sion. An option is also provided to return each channel to its ordinary General MIDI mode (
cussion Mode for channel 10, Melodic Mode for all other channels).

Setting the MIDI Channel Mode
To change a channel’s MIDI channel mode, send a MIDI Non-Registered Parameter Numb
(NRPN) event, with MSB (Continuous Controller 99) of 5 and LSB (Continuous Controller 98
0 (also known as ‘NRPN 640’), followed by a Data Entry controller message (Continuous C
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Note: Mode 1, Pitched Percussion is the unusual one that you’ll have the most fun exp

In your MIDI sequencer’s Event List, the events needed to set a channel’s MIDI Channel M
are as follows, where M is 0, 1, 2, or 3 according to the above table:

Controller #99, 5 – NRPN MSB of 5 – Select MIDI Channel Mode as Data Entry destina
Controller #98, 0 – NRPN LSB of 0
Controller #6, M – Set MIDI Channel Mode to M, via Data Entry controller

Uses for Normal Percussion Mode
One possible use for the MIDI Channel Mode would be to put more than one channel into N
Percussion Mode at the same time. Here are a few of the creative applications of doing so:

• Multiple Percussion channels would let you spread a rhythm arrangement out over man
MIDI channels, giving you the ability to dynamically change the pattern by muting and 
unmuting the channels. 

• With multiple Percussion channels, you could play Percussion Instruments from multipl
Banks at once – the GM Bank Percussion Instruments, the Beatnik Special Bank Percu
Instruments, and your own Custom Bank Percussion Instruments, all at the same time. J
each channel into Normal Percussion Mode, and then use a Bank Select message to p
Bank you want.

• Drum echo effects can be easier to achieve if you use additional MIDI channels for the 
tracks – there won't be any unpredictable retriggering problems if any of the initial notes
lap the start of their echoes.

Data Entry 
Controller Mode Effect

0 General MIDI Mode
(for that channel)

On Channel 10, puts the channel into 
Normal Percussion Mode; on all other 
channels, puts the channel into Normal 
Melodic Mode

1 Pitched Percussion Mode Program Changes select Percussion 
bank sounds, note numbers transpose 
them as though they were Melodic Bank 
Instruments

2 Normal Percussion Mode Note number selects Percussion bank 
sounds (a la General MIDI Channel 10)

3 Normal Melodic Mode Program Changes select Musical bank 
sounds, note numbers transpose them.
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For Reference

Detailed reference information on the Beatnik Editor.

 

Heading... Covers...

FAQ Answers to Frequently Asked Questions

Menu Reference Guide to Menu Commands

Window Reference Guide to Windows and Dialog Boxes

Troubleshooting How to fix any problems you may encounter

Removing the Beatnik Editor How to ‘un-install’ the program from your computer

Compatibility Info MIDI and file format support details

Versions and Updates Program Version History and how to get Updates

License Agreement The agreement that governs your use of the software

Online Resources Links to further information on the Beatnik Web site

Built-In Instruments List of General MIDI and Beatnik Special Instruments

Live MIDI Input How to work with MIDI controllers and sequencers

Trademarks Legal notices regarding Trademarks
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FAQ 

Answers to Frequently Asked Questions about the Beatnik Editor.

See Also: How Do I...

How do I get help when I run into a problem?

If you run into difficulty installing, registering, or using the Beatnik Editor, and can’t find an 
answer in the Online Help or User’s Guide, then contact Beatnik Customer Support via the 
Beatnik Web site:

http://www.beatnik.com/?editor-support

How do I convert a .WAV file into an RMF file?

See Basic Operation: Converting a Sample File to RMF.

How do I convert a MIDI file into an RMF file?

See Basic Operation: Converting a MIDI File to RMF.

What file formats does the Beatnik Editor import?

MIDI, WAV, AIFF, Sound Designer II, AU, and MP3 files. You can also import RMF 
files into a Session, but you can't include them in RMF files you export.

What copyright protection does RMF offer?

You can encode 40-bit encrypted copyright and licensing information into a file, and 
it can be easily displayed anywhere an RMF file plays. It will help a publisher or 
composer keep track of who is using their music.

Will the Beatnik Editor support DLS (the MIDI Manufacturers Association standard for download-
able samples)?

Beatnik intends to provide support for the DLS standard in a future version of the 
Beatnik Editor. As new file types become popular, we’ll add support for them.
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Menu Reference

Guide to the Commands in the Beatnik Editor’s Menus.

Topics:
File menu

Edit menu

Song menu

Instrument menu

Sample menu

Window menu

Help menu
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File menu
Commands for working with Beatnik Editor Session documents, for importing and export-
ing your work in other formats, for setting Preferences, and exiting the program.

Command Description

New Creates a new Session document, called Untitled Session. See Session 
windows.

Open...

(Not available in 
Demo mode)

Opens a previously saved Session document on disk.

Note: You can also open files in other recognized music and 
sound formats, resulting in an Import operation. If no Session 
document is currently open, a new Session document is create
first.

Close Closes the current Session document.

If you haven’t saved your latest changes to disk, an alert will 
appear asking whether you want to save the Session before clo
ing it. Closing without saving means losing all changes made 
since the latest Save or Save As.

Save

(Not available in 
Demo mode)

Saves the current Session document to disk under the same file nam
replacing the previous file version.

Notes for Mac OS Users:
• The Beatnik Editor will automatically add .bsn to the 

filename.

• The Mac OS file creator code will be ‘MPL2’.

Save As...

(Not available in 
Demo mode)

Saves the current Session document to disk, with an option to chang
the file name.

After saving, the Session window will show the new name and 
will remain open for further editing.

Note for Mac OS Users: The Beatnik Editor will automatically 
add .bsn to the filename.
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Revert Operation depends on the current window:

• In a Session document, replaces the current Session document w
its latest saved version on disk, discarding any recent changes. 
Reverting means losing all changes made since the last Save or 
Save As.

• In an Instrument Editor window or Sample Editor window, exits 
that window and reverts the Instrument or Sample to its previous 
state.

In all cases, An alert will appear asking you to confirm that you want t
Revert. 

Import... Opens the Import dialog box, where you can import one or more music 
and digital audio files, in several formats, into the current Session do
ument.

Export RMF...

(Not available in 
Demo mode)

Opens one of the Export RMF dialog boxes, where you can export the 
currently selected Song or Songs in RMF format.

Because RMF is a secure file format, an RMF file cannot be fur
ther edited after you export it. Be sure to retain your Beatnik 
Editor Session files so that you can update your RMF files with 
any future changes.

Export as Audio...

(Not available in 
Demo mode)

Opens the Save Audio File dialog box, where you can export the cur-
rently selected Song in any supported digital audio format – AIFF, 
WAV, raw samples, or MP3; for Mac OS users, Sound Designer II is 
also available.

Note: Does not work on multiple Songs at once – only one Song
at a time.

Note: Although the exported audio file will sound the same as the
RMF version, it will be much larger – up to 10 MB per minute – 
and interactive control over individual notes and instruments wil
no longer be possible. RMF is almost always a better choice.

Preferences...

(Windows only)

Opens the Preferences dialog box, where you can set general Beatnik 
Editor operating preferences.

Note: For Mac OS, this item appears in the Edit menu.

(Recent Session 
Names)

Opens recently accessed Session documents on disk.

Exit Ends your Beatnik Editor working session, exiting the program.

If you haven’t saved your latest changes, an alert will appear as
ing whether you want to save the Session before exiting.

Note: Exiting without saving means losing all changes made 
since your most recent Save or Save As.
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Edit menu
Commands for working with selected items.

Command Description

Undo Undoes the most recent Edit operation.

Note: The Beatnik Editor uses ‘Multiple Undo’. Every additional 
Undo command you issue takes you another step back in time 
(but no farther back than the latest saved version).

Note: Every window has a separate Undo history.

Redo Reapplies the most recently Undone operation. Available only after a
Undo.

Cut Removes the selection from the document and places it in the clipboa
for later Pasting, replacing any previous clipboard contents.

Copy Copies the selection to the clipboard for later Pasting, replacing any 
previous clipboard contents.

Note: When you copy a Custom Instrument, a dialog box 
appears, offering the option of also copying the Samples used i
that Instrument.

Paste Pastes the clipboard contents into the document.

The Paste command is unavailable whenever the clipboard is 
empty, or contains items of the wrong type.

Note: When pasting an Instrument into a Session document 
would result in more than one Instrument with the same MIDI 
program number, the Beatnik Editor will renumber the colliding 
Instruments and alert you. If you see this message, you should 
carefully verify that any Songs being added still play correctly 
because the Beatnik Editor will not update the corresponding 
MIDI Program Change events in any Songs that use the Instru-
ment to use the altered Instrument numbers. If the Song is now
playing with wrong Instruments, you will need to use your MIDI 
sequencer program to set the program numbers manually in yo
original sequence, then save a revised MIDI file and Re-Import 
MIDI (see Song Settings dialog box).

Delete Deletes the selection from the document, without changing the clip-
board.
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About the Clipboard
The clipboard is a temporary storage area used to hold items for editing operations – Cut, Copy, 
and Paste. Whenever you Copy or Cut an item, a copy of the item is placed on the clipboard. T
next Paste produces a copy of the item.

Rename Allows you to edit the selected item’s name.

Note: Only Custom items can be renamed – Custom Songs, Cu
tom Instruments, and Custom Samples. Built-in Songs and Sam
ples can’t be renamed at all; to rename a built-in Instrument, 
you’ll have to first Copy it and Paste it, creating a Custom Instru
ment copy that can then be renamed.

Select All Selects all items in the current Session window tab – that is, all Song
all Instruments or all Samples.

Preferences...

(Mac OS only)

Opens the Preferences dialog box, where you can set general Beatnik 
Editor operating preferences.

Note: For Windows, this item appears in the File menu.
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Song menu
Commands for working with selected items in The Songs Tab of a Session window.

Note: Some commands will only be available when a Song is selected and a Session w
is in front.

Command Description

Song Settings... Opens the Song Settings dialog box, where you can set several basic 
Song parameters.

Song Info... Opens the Song Info dialog box, where you can enter text information 
fields for the exported RMF file, such as copyright notice and per-
former credits.

Re-Import MIDI... Replaces the selected Song’s MIDI data from a Standard MIDI File 
(SMF) on disk.

Note: The Beatnik Editor only imports MIDI Files, it does not 
edit them directly. To edit the individual MIDI notes and other 
events within a Song, you’ll need to use a separate MIDI 
sequencer program and save your work as a Standard MIDI Fil
When working in this way, you’ll use the Re-Import MIDI com-
mand every time you make a change in the sequencer and want
update the corresponding Song in your Beatnik Editor Session 
document. That’s the only way to make the change show up in 
your exported RMF file.

Play Starts playback of the selected Song.

There’s also a Play button in the Player window, and double-
clicking a Song in The Songs Tab of a Session window also 
works.

Stop Stops playback of the currently selected Song.

There’s also a Stop button in the Player window.
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Instrument menu
Commands for working with selected items in The Instruments Tab of a Session window.

Note: Some of these commands will only be available when an Instrument is selected 
Session window is in front.

Command Description

New Instrument... Creates a new, ‘blank’ instrument in the next available slot, titled 
New Instrument. To turn it into a useful Instrument, use the Instru-
ment Editor window.

Note: The new Instrument contains no Samples, so trying to 
play it (with the onscreen keyboard in the Player window or 
the Live MIDI Input) produces silence.

Edit Instrument... Opens the Instrument Editor window, where you can inspect and 
edit the selected Instrument.

Note: Only Custom Instruments can be edited. To edit a built-
in Instrument, you’ll have to first Copy it and Paste it, creating
a Custom Instrument copy that can be edited.

Move Instrument... Opens the Move Instrument dialog box, where you can set the 
selected Instrument’s MIDI Program number to any unused numb
in either the Custom Melodic Instruments bank or the Custom Per
cussion Instruments bank. MIDI Program numbers are in the rang
0 – 127.

Note: Only Custom Instruments can be moved. To edit a built
in Instrument, you’ll have to first Copy it and Paste it, creating
a Custom Instrument copy that can be edited.
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Make Song Using Creates a new, simple Song with the same name as the first selec
Instrument, playing every Sample in the selected Instruments, all 
simultaneously. This may or may not meet your needs as a way to
trigger the Instruments in your final production, however it may 
make it easy to audition the Instruments and their Samples as you
working in the Beatnik Editor.

Note: If you have more than 15 Instruments selected, only the
first 15 will be used in the created Song. This is because MID
channel 10 is reserved for percussion, leaving only 15 avail-
able MIDI channels for triggering the Instruments.

The Song will contain one MIDI file Track for each created Instru-
ment, and each Instrument’s Track will contain one MIDI note for 
each Keymap Zone used in the Instrument. These notes will be sa
as the Keymap Zones’ Root Keys, so the Samples will usually pla
at their natural pitches. All of the notes will begin at the same time
and will be the same length.

For example, if you select one Instrument using a single Keymap 
Zone, and a second Instrument that uses three Keymap Zones, th
Make Song Using command will produce a Song with two tracks: 
Track 1 will contain one note (the Root Key of the one keymap 
zone), and Track 2 will contain three notes (the Root Keys for the 
three keymap zones).
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Sample menu
Commands for working with selected items in The Samples Tab of a Session window, 
selected waveform ranges in the Sample Editor window, and for managing the disk 
cache of compressed Sample copies.

Note: Some of these commands will only be available when a Sample is selected and 
the Session windows is in front, or when a waveform range is selected and a Sample Editor 
window is in front.

Command Description

Edit Sample... Opens the Sample Editor window, where you can inspect and edit 
the selected Sample.

Note: Only Custom Samples can be edited, never the built-in
Samples.

Compression... Opens the Compression dialog box, where you can inspect and 
change the data compression setting for the selected Sample. To
apply the same Compression type to multiple Samples, select the
all and then select the Compression... command.

Note: You can’t change the Compression setting for built-in 
Samples – only Custom Samples.

Make Instrument 
Using

Creates one or more new, simple Instruments with the same nam
as the selected Samples, and using the selected Samples.

When applied to multiple Samples, opens the Make Instru-
ment dialog box dialog box, with additional options.

Make Song Using Creates a new, simple Song with the same name as the selected 
Sample, and one or more new, simple Instruments with the same 
names as the selected Samples, and using the selected Samples.
is the same effect produced by doing a Make Instrument Using fol-
lowed by a Make Song Using the new Instruments. For details on 
the created Song, see the Make Song dialog box.

When applied to multiple Samples, opens the Make Song dia-
log box, with additional options.

Clear compression 
cache...

Opens the Clear compression cache dialog box where you can clear 
the cache of compressed copies of your Samples.

This command won’t be available if the disk cache is empty.

Delete uncompressed 
originals...

Opens the Delete uncompressed originals dialog box where you 
can delete the original, uncompressed versions of all compressed
Samples stored in your Session document.

Only available for Sessions with uncompressed Samples.
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Crop In the Sample Editor window, with a range of the Sample selected, 
trims away all sound before and after the selection.

Normalize In the Sample Editor window, with a range of the Sample selected, 
increases the selection’s volume to the highest possible level befo
distorting.

Fade In In the Sample Editor window, with a range of the Sample selected, 
creates a fade-in across the entire selection.

Fade Out In the Sample Editor window, with a range of the Sample selected, 
creates a fade-out across the entire selection.

Zoom Normal In the Sample Editor window, resets the X and Y zoom levels.

Zoom Loop Start In the Sample Editor window, zooms in on the loop start.

Zoom Loop End In the Sample Editor window, zooms in on the loop end.

Jump to Loop Start In the Sample Editor window, if the loop start isn’t visible, horizon-
tally scrolls to it.

Jump to Loop End In the Sample Editor window, if the loop end isn’t visible, horizon-
tally scrolls to it.
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Window menu
Commands for working with the Beatnik Editor’s windows.

You can close Session document windows, bring any open window to the front, or open the 
or JavaScript window if they aren’t already open.

Command Description

Close All Documents Closes all open Session documents, leaving the Player and JavaS-
cript windows open.

If you haven’t saved your latest changes, an alert will appea
asking whether you want to save the Sessions before closin
them.

Close All Closes all windows, including all Sessions and the Player and 
JavaScript windows.

If you haven’t saved your latest changes, an alert will appea
asking whether you want to save the Session before closin

Player Brings the Player window to the front, opening it if necessary.

JavaScript Brings the JavaScript window to the front, opening it if neces-
sary.

(Session window 
names)

Brings any one of your Session windows to the front, opening it 
if necessary.
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Help menu
Commands for getting information about the Beatnik Editor.

Command Description

Contents Displays the Help Contents dialog box, where you can access the 
Beatnik Editor User’s Guide and online help system.

Note: You must have a Web browser for this command to wor

Beatnik on the Web Opens your Web browser and takes you to the Beatnik Web site:

http://www.beatnik.com
Note: Your computer must be connected to the Internet for th
Web link to work.

About Beatnik Editor

Windows only

Displays the About Beatnik Editor dialog box, with registration 
information, the software release version, and related information

Note: For Mac OS, this item appears in the Apple Menu.
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Window Reference
How to use all of the Beatnik Editor’s Windows and Dialog Boxes.

Note: This Window Reference is organized into sections, according to the application m
used to access the window.

Topics:
File Menu windows
Song Menu windows
Instrument Menu windows
Sample Menu windows
Window Menu windows
Help Menu windows
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File Menu windows
How to use the Dialog Boxes accessed from the File menu.

Topics:
Import dialog box
Export RMF dialog boxes
Save Audio File dialog box
Preferences dialog box (for Mac OS, this item appears in the Edit menu)
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Import dialog box

Imports MIDI files and/or digital audio files into your Session document, for use in 
exported RMF files.

Note: The Import dialog box always adds files into the current Session document. Be su
the right Session document window is in front before you give the Import command – just 
click in the window, or select it from the Window menu.

Note: For best results, use standard filename extensions for MIDI and digital audio files
may want to import into the Beatnik Editor (see table below). On Mac OS, files with ba
(missing or incorrect) type and creator codes whose filenames don’t end with a recog
extension will not appear in folder listings of importable files.

The Beatnik Editor uses a conventional file opening dialog for selecting files to import:

To import MIDI and/or digital audio files into the current Session document:

1.  Navigate to the folder containing the files you want to import.

2.  Use the Show: pop-up menu to display the file types you’re looking for.

Note for Mac OS Users: The Show: menu relies on Mac OS file types and creator codes, p
filename extensions, to determine which files will appear. In rare cases, valid files will 
omitted because they don’t have a recognized type or creator, and the filenames don’
with a recognized extension. For example, files transferred from Windows will frequen
have missing or incorrect Mac OS file type and creator codes – and if the name of suc
doesn’t end in one of the recognized extension (.mid, .wav, .aif, etc.) then the file won
listed. To correct the problem, rename the file with the correct extension for its format 
use a utility to reset the Mac OS file type and creator).

3.  Select the files you want to import.

You can import any of the music and sound file formats listed in the table below.

4.  Click the Open button.

Imported files appear as new items in the Session document, depending on the file ty
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• Digital audio files will appear in the Samples tab, as new Custom Samples

• MIDI files will appear in the Songs tab, as new Custom Songs

• RMF files will appear in the Songs tab, as Imported RMF Songs.

Note: You won’t be able to play imported RMFX files. Although importing an RMFX file 
does produce an Imported RMF Song in your Session document, recall that RMFX fil
contain no MIDI score data. As a result, there aren’t any notes for the Play command or but-
ton to use, and so no sound is produced. For more information on RMFX files, see the
Advanced Techniques section for Creating Banks of Triggerable Samples (RMFX).

File Format Filename 
Extension Type Description When Imported,

Creates a New…

WAVE .wav audio Microsoft WAVE Custom Sample

AIFF .aif
.aiff

audio Audio Interchange 
File Format

Custom Sample

Sound 
Designer II

.sd2 audio Digidesign Sound 
Designer II

Custom Sample

AU .au audio Sun/Next audio Custom Sample

MP3 .mp3 audio MPEG 1 Layer 3 
audio

Custom Sample

MIDI .mid
.smf
.midi
.rmi

MIDI Standard MIDI 
File

Custom Song

RMF .rmf audio + 
MIDI 
combo

Beatnik Rich 
Music Format

Imported RMF Song
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Export RMF dialog boxes

Creates an RMF or RMFX file from the selected Song, Instrument, or Sample resources.

The whole purpose of the Beatnik Editor is to create RMF files. There are several types of 
files and several ways to create them, and the Export RMF... command is used for all of them. 
When you issue the Export RMF... command, the Beatnik Editor displays one of the following d
log boxes, depending on the type and number of resources you’ve selected:

Export RMF File dialog box
Export Multiple RMF Files dialog box
Export RMF from Instrument dialog box
Export RMF from Multiple Instruments dialog box
Export RMF from Sample dialog box
Export RMF from Multiple Samples dialog box

Before describing these dialog boxes, a brief introduction for users of previous versions of 
Beatnik Editor is in order. For background information on RMF files, see About Beatnik and the 
RMF File Format.

Note: Because RMF is a secure file format, an RMF file cannot be edited after you cre
The only way to change an RMF file is to change the resources that go into it, and the
use the Beatnik Editor to re-generate the RMF file. If you want to be able to update an 
RMF files with any future change, you must be sure to retain the Beatnik Editor Session fi
you used to generate the RMF file.

Changes to ‘Export RMF...’ since Beatnik Editor version 1
If you’ve used earlier versions of the Beatnik Editor, you may recall that creating some kind
RMF files required a lot of manual work. In particular, creating an RMF file for use as a ban
triggerable Samples – known as an RMFX file – was pretty complicated because you’d hav
build all the Instruments and keymap zones, and then place all the Samples into the keyma
by hand.

In the Beatnik Editor version 2, we’ve changed the RMF Export procedure to automate mo
that sort of grunt work. Now, you can just select the Songs or Instruments or Samples that 
want in your RMF file, and issue the Export RMF command – the Beatnik Editor will take care o
all the details it can, and display a dialog box asking for your instructions on how to handle
optional parts. Although these descriptions may seem wordy, you’ll find it quicker and easie
generate RMF files now.
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Export RMF File dialog box

When exporting an RMF file containing just a single Song, the Song data is always included
RMF file – so the only question to answer is what Instruments, if any, you want to include.

The Export RMF File dialog box looks like this:

Topics:
Working with the Export RMF File dialog box
What Instruments Should You Include?

Working with the Export RMF File dialog box
When the Export RMF Song dialog box opens, the listbox shows all Instruments that the S
you’re Exporting uses, with all of the Custom Instruments (if any) selected. To add or remo
individual Instruments to the selection, use click and shift-click. You can also use the All, Custom, 
and None buttons to add or remove groups of Instruments to the selection.

For help deciding which Instruments to select, see What Instruments Should You Include?, below.

When you’re happy with your selection of Instruments, click on the OK button to close the dialog
box.

Finally, use the Save RMF File dialog box to pick a folder and provide a filename for your 
exported RMF file:

Notes for Mac OS Users: 
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• In some versions of Mac OS, an erroneous item may appear in the Format: menu. 
Be sure not to select the option ‘Beatnik Editor document’.

• The Beatnik Editor will automatically add .rmf to the filename.

• The Mac OS file creator code will be ‘MPL2’.

What Instruments Should You Include?
When the Export RMF Song dialog box opens, the listbox shows all Instruments that the S
you’re Exporting uses, with all of the Custom Instruments (if any) selected. In most cases 
(including RMF files intended for use in the Beatnik Player for Web browsers) these Custom 
Instruments are the only ones you need to include in the RMF file.

That’s because most Beatnik playback environments include their own permanent copy of 
Built-In Instruments. For example, the Beatnik Player for Web browsers always has the full 
Built-In Instruments, so there’s no need to supply another copy of each Instrument within th
RMF file. There are a few exceptions to this rule, however. If you expect your RMF file to be
in Beatnik playback environments that don’t (or aren’t guaranteed to) include the Built-In In
ments, then you should also include any Built-In Instruments that are used.

Note: Specifically, the Beatnik Audio Engine for C and C++ and the Beatnik Xtra for Di
tor and Shockwave may or may not include the Built-In Instruments, depending on wh
sample library file is being used at the time. Check your Beatnik documentation for de

Of course, none of the Beatnik playback environments can be expected to already have a 
any of your Custom Instruments – so in order to make them available at playback time, you
need to include any Custom Instruments that are used. If the selected Song uses any Cust
Instruments, and you fail to include them in the RMF file, then when the RMF file is played 
all notes intended for those Custom Instruments will be missing.
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Export Multiple RMF Files dialog box

When exporting multiple Songs, each one will be saved to a separate RMF file containing j
single Song. The only question to answer is what Instruments, if any, you want to include in
RMF file. (The Song data is always included.)

The Export Multiple RMF Files dialog box asks for your answer to that question:

Topics:
Working with the Export Multiple RMF Files dialog box
What Instruments Should You Include?

Working with the Export Multiple RMF Files dialog box
This dialog box is very simple to use: just choose one of the three options by clicking on th
option you prefer. For help deciding which Instruments to select, see What Instruments Should 
You Include?, below.

When you’re happy with your selection, click on the OK button to close the dialog box. 

Finally, use the Choose A Folder dialog box to pick a folder for your exported RMF files:

The filenames will be taken from the Song names, but will all end with the.rmf extension.

Note for Mac OS Users: The Mac OS file creator code will be ‘MPL2’.

What Instruments Should You Include?
You have three options here. In most cases (including RMF files intended for sonifying Web
pages), Include All Custom Instruments is the best choice.

• Include No Instruments means none of the generated RMF files will include any Instrume
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neither Custom nor Built-In, even if used by the Songs.

Don’t use this option if any of the selected Songs depend on Custom Instruments – th
tom Instruments won’t be included, and when the RMF file is played, all notes that use
Custom Instruments will be missing.

If the selected Songs use only Built-In Instruments, and you know the RMF files will b
played in Beatnik playback environments that provide the Built-In Instruments, then it’s
to use the Include No Instruments option.

The Beatnik Player for Web browsers always includes the Built-In Instruments; h
ever the Beatnik Audio Engine for C and C++ and the Beatnik Xtra for Director a
Shockwave may or may not include the Built-In Instruments, depending on which
sample library file is being used at the time. Check your Beatnik documentation f
details.

• Include All Custom Instruments means that each generated RMF file will include any of y
Custom Instruments that the respective Song uses, but none of the Built-In Instruments 

This is usually the best choice, because most Beatnik playback environments include
own copy of the Built-In Instruments. For example, the Beatnik Player for Web browse
always has the full set of Built-In Instruments. Of course those players don’t have a co
your Custom Instruments, so to make them available at playback time you’ll need to in
them in the RMF files.

• Include All Instruments means that each generated RMF file will include all Custom and 
Built-In Instruments it uses.

Use this option if you expect the RMF files to be used in Beatnik playback environmen
that don’t (or aren’t guaranteed to) include the Built-In Instruments. (The Beatnik Audi
Engine for C and C++ and the Beatnik Xtra for Director and Shockwave may or may n
include the Built-In Instruments, depending on which sample library file is being used a
time. However, the Beatnik Player for Web browsers always includes the Built-In Instru
ments.)
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Export RMF from Instrument dialog box

When exporting from one or more Instruments, all selected Instruments are combined into 
gle RMF file. The only question to answer is whether you want the Beatnik Editor to genera
Song and include it in the RMF file. 

The Export RMF from Instrument dialog box asks for your answer to this question:

Working with the Export RMF from Instrument dialog box
This dialog box gives you a two-way choice:

• The Include song data in file (creates playable song file) option automatically generates a 
Song that plays one note on the selected Instrument, and adds it to the exported RMF fi
you’re exporting a single Instrument, and you want to hear the Instrument’s default Sam
when the RMF file is played, then you should select this option.

An RMF file with a Song is considered a ‘normal’ playable file – in a Web page it can b
‘autostarted,’ and will respond to Music Object JavaScript commands like play()  and 
stop() . If you have multiple Instruments selected, you get a chord with one note for e
Instrument, with each note on a separate MIDI file track.

• The Do not include song data option creates an RMF file without any Song – what we call
RMFX file, because one of its main uses is for sound FX. If you’re exporting multiple Ins
ments, you should probably select this option. (The Song that the Beatnik Editor would 
ate for you would cause all the Instruments to play at once – which in most cases won’t
what you want.)

Note: You can’t ‘autostart’ an RMFX file in a Web page because there’s no Song data t
play, and it won’t respond to Music Object JavaScript commands like play()  and stop() . 
However, you can trigger specific sounds at any time by selecting Instruments with the
mand setProgramBank()  and then using noteOn()  and noteOff() , or playNote() .

Note: The filename of an RMFX file will end in .rmf, not .rmfx.
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When you’re happy with your selection, click on the OK button to close the dialog box. Finally, 
use the Save RMF File dialog box to pick a folder and provide a filename for your exported RM
file:

Notes for Mac OS Users: 

• In some versions of Mac OS, an erroneous item may appear in the Format: menu. 
Be sure not to select the option ‘Beatnik Editor document’.

• The Beatnik Editor will automatically add .rmf to the filename.

• The Mac OS file creator code will be ‘MPL2’.
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Export RMF from Multiple Instruments dialog box

Note: This command produces a single RMF file containing all the selected Instrument
one RMF file per selected Instrument.

Note: If you have more than 15 Instruments selected, only the first 15 will be used in th
exported RMF file. This is because MIDI channel 10 is reserved for percussion, leaving
15 available MIDI channels for triggering the Instruments.

When exporting from one or more Instruments, all selected Instruments are combined into 
gle RMF file. The only question to answer is whether you want the Beatnik Editor to genera
Song and include it in the RMF file. 

The Export RMF from Multiple Instruments dialog box asks for your answer to this question:

Working with the Export RMF from Instrument dialog box
This dialog box gives you a two-way choice:

• The Include song data in file (creates playable song file) option automatically generates a 
Song that plays one note on the selected Instrument, and adds it to the exported RMF fi
you’re exporting a single Instrument, and you want to hear the Instrument’s default Sam
when the RMF file is played, then you should select this option.

An RMF file with a Song is considered a ‘normal’ playable file – in a Web page it can b
‘autostarted,’ and will respond to Music Object JavaScript commands like play()  and 
stop() . If you have multiple Instruments selected, you get a chord with one note for e
Instrument, with each note on a separate MIDI file track.

• The Do not include song data option creates an RMF file without any Song – what we call
RMFX file, because one of its main uses is for sound FX. If you’re exporting multiple Ins
ments, you should probably select this option. (The Song that the Beatnik Editor would 
ate for you would cause all the Instruments to play at once – which in most cases won’t
what you want.)

Note: You can’t ‘autostart’ an RMFX file in a Web page because there’s no Song data t
play, and it won’t respond to Music Object JavaScript commands like play()  and stop() . 
However, you can trigger specific sounds at any time by selecting Instruments with the
mand setProgramBank()  and then using noteOn()  and noteOff() , or playNote() .

Note: The filename of an RMFX file will end in .rmf, not .rmfx.
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When you’re happy with your selection, click on the OK button to close the dialog box. Finally, 
use the Save RMF File dialog box to pick a folder and provide a filename for your exported RM
file:

Notes for Mac OS Users: 

• In some versions of Mac OS, an erroneous item may appear in the Format: menu. 
Be sure not to select the option ‘Beatnik Editor document’.

• The Beatnik Editor will automatically add .rmf to the filename.

• The Mac OS file creator code will be ‘MPL2’.
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Export RMF from Sample dialog box

When exporting an RMF file from just a single Sample, there are two question to answer:

• Do you want the Beatnik Editor to generate a Song and include it in the RMF file?

• To make the Sample available to be played, the Beatnik Editor will have to create an Ins
ment for it – so what Bank and what Instrument Number do you want it to use for that In
ment?

The Export RMF from Sample dialog box asks for your answers to these questions:

Topics:
Working with the Export RMF File dialog box
Should You Include a Song in Your RMF File? (RMF or RMFX?)
What Bank and Instrument Number Should You Use?

Working with the Export RMF from Sample dialog box
See the following two headings for guidance on how to answer the two questions.

When you’re happy with your choices, click on the OK button to close the dialog box. Finally, us
the Save RMF File dialog box to pick a folder and provide a filename for your exported RMF 

Notes for Mac OS Users: 

• In some versions of Mac OS, an erroneous item may appear in the Format: menu. 
Be sure not to select the option ‘Beatnik Editor document’.

• The Beatnik Editor will automatically add .rmf to the filename.
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• The Mac OS file creator code will be ‘MPL2’.

Should You Include a Song in Your RMF File? (RMF or RMFX?)
Here’s how to decide whether you should include a Song in your RMF file:

• The Include song data in file (creates playable song file) option automatically generates a 
Song that plays one note on the selected Instrument, and adds it to the exported RMF fi
you’re exporting a single Instrument, and you want to hear the Instrument’s default Sam
when the RMF file is played, then you should select this option.

An RMF file with a Song is considered a ‘normal’ playable file – in a Web page it can b
‘autostarted,’ and will respond to Music Object JavaScript commands like play()  and 
stop() . If you have multiple Instruments selected, you get a chord with one note for e
Instrument, with each note on a separate MIDI file track.

• The Do not include song data option creates an RMF file without any Song – what we call
RMFX file, because one of its main uses is for sound FX. If you’re exporting multiple Ins
ments, you should probably select this option. (The Song that the Beatnik Editor would 
ate for you would cause all the Instruments to play at once – which in most cases won’t
what you want.)

Note: You can’t ‘autostart’ an RMFX file in a Web page because there’s no Song data t
play, and it won’t respond to Music Object JavaScript commands like play()  and stop() . 
However, you can trigger specific sounds at any time by selecting Instruments with the
mand setProgramBank()  and then using noteOn()  and noteOff() , or playNote() .

Note: The filename of an RMFX file will end in .rmf, not .rmfx.

What Bank and Instrument Number Should You Use?
Custom Instruments always appear in Bank 2, but you can place the created Instrument(s)
either the Melodic side of Bank 2, or the Percussion side of Bank 2. Select Bank 2 Custom - 
Melodic unless you are certain that you need to create a Percussion Bank Instrument (whic
rare).

You can use any of the 128 available Instrument numbers (0–127) in either side.
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Export RMF from Multiple Samples dialog box

Note: This command produces a single RMF file containing all the selected Samples, 
one RMF file per selected Sample.

When exporting an RMF file from multiple Samples, you have three questions to answer:

• Do you want the Beatnik Editor to generate a Song and include it in the RMF file?

• To make the Samples available to be played, the Beatnik Editor will have to create at lea
Instrument for them, and there a lot of possible ways to do that. Do you want the Samp
appear as separate Instruments, or do you want them combined into one multi-zoned In
ment? Either way, there are additional questions to answer about how to set up the Key
Zones.

• What Bank and what Instrument number (or numbers) do you want to use for the create
Instrument(s)?

The Export RMF from Multiple Samples dialog box asks for your answers to these questions:

Topics:
Working with the Export RMF from Multiple Samples dialog box
Should You Include a Song in Your RMF File? (RMF or RMFX?)
What Kind of Instrument(s) Should You Create?
What Bank and Instrument Number Should You Use?
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Working with the Export RMF from Multiple Samples dialog box
See the following three headings for guidance on how to answer the three questions.

When you’re happy with your choices, click on the OK button to close the dialog box. Finally, us
the Save RMF File dialog box to pick a folder and provide a filename for your exported RMF 

Notes for Mac OS Users: 

• In some versions of Mac OS, an erroneous item may appear in the Format: menu. 
Be sure not to select the option ‘Beatnik Editor document’.

• The Beatnik Editor will automatically add .rmf to the filename.

• The Mac OS file creator code will be ‘MPL2’.

Should You Include a Song in Your RMF File? (RMF or RMFX?)
Here’s how to decide whether you should include a Song in your RMF file:

• The Include song data in file (creates playable song file) option automatically generates a 
Song that plays one note on the selected Instrument, and adds it to the exported RMF fi
you’re exporting a single Instrument, and you want to hear the Instrument’s default Sam
when the RMF file is played, then you should select this option.

An RMF file with a Song is considered a ‘normal’ playable file – in a Web page it can b
‘autostarted,’ and will respond to Music Object JavaScript commands like play()  and 
stop() . If you have multiple Instruments selected, you get a chord with one note for e
Instrument, with each note on a separate MIDI file track.

• The Do not include song data option creates an RMF file without any Song – what we call
RMFX file, because one of its main uses is for sound FX. If you’re exporting multiple Ins
ments, you should probably select this option. (The Song that the Beatnik Editor would 
ate for you would cause all the Instruments to play at once – which in most cases won’t
what you want.)

Note: You can’t ‘autostart’ an RMFX file in a Web page because there’s no Song data t
play, and it won’t respond to Music Object JavaScript commands like play()  and stop() . 
However, you can trigger specific sounds at any time by selecting Instruments with the
mand setProgramBank()  and then using noteOn()  and noteOff() , or playNote() .

Note: The filename of an RMFX file will end in .rmf, not .rmfx.
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What Kind of Instrument(s) Should You Create?
If you want to create a single new Instrument from your selected Samples, the Combine Samples 
Into One Instrument option spreads the Samples across one Instrument’s keyboard layout. T
sounds can be distributed in two ways. The first is Split into equal zones, which results in multiple 
pitches being available for each Sample. The second option, One per key... is typically used for 
Percussion Instruments where different untransposable sounds reside on adjacent keys. Tstart-
ing at field lets you choose the keyboard note your individual Samples will start on, and eac
sequent Sample will be placed on the next available higher key.

If you prefer to split each Sample out into a separate Instrument, choose the Separate into Multi-
ple Instruments option. All of the Instruments will use the same Root Key, which you can set

Note: If you have more than 15 Samples selected, only the first 15 will produce new In
ments. This is because MIDI channel 10 is reserved for percussion, leaving only 15 a
able MIDI channels for triggering the Instruments.

What Bank and Instrument Number Should You Use?
Custom Instruments always appear in Bank 2, but you can place the created Instrument(s)
either the Melodic side of Bank 2, or the Percussion side of Bank 2. Select Bank 2 Custom - 
Melodic unless you are certain that you need to create a Percussion Bank Instrument (whic
rare).

You can use any of the 128 available Instrument numbers (0–127) in either side.
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Save Audio File   dialog box

Creates a digital audio file ‘print’ of the selected Song.

Note: Does not work on multiple Songs at once – only one Song at a time.

The Save Audio File dialog box is accessed from the Export as Audio... command in the File 
menu, and provides a way to export the currently selected Song in any supported digital au
mat – AIFF, WAV, raw samples, or MP3; for Mac OS users, Sound Designer II is also availa
The selected Song is not changed in any way, and remains in the Session document.

The generated audio file will sound exactly the same as the Song, and will have the same d
Any MIDI note events will be ‘rendered’ into the equivalent digital audio output, so in most c
the saved audio file will be much larger than the original MIDI file. 

Note: Converting MIDI to digital audio forecloses all interactive event control when the
is played back – for example: muting, soloing, live program changes or volume chang
individual Instruments, and so forth.

Notes for Mac OS Users: 

• The Beatnik Editor will automatically add an appropriate extension to the file-
name, based on the selected format: .wav, .sd2, .mp3, .aif, or .raw.

• The Mac OS file type will reflect your selected format.

• The Mac OS file creator will be Apple QuickTime, whose creator code is ‘TVOD’.

Working with the Save Audio File dialog box
To create your audio file, use the dialog box controls to:

1. Choose an appropriate folder, or create a new one.

2. Provide an appropriate filename.

3. Select your desired digital audio file format from the Save as type: (Windows) or Format: 
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 the 
(Mac OS) pop-up menu.

Note for Mac OS Users: In some versions of Mac OS, an erroneous item may appear in
Format: menu. Be sure not to select the option ‘Beatnik Editor document’.

4. When you’re happy with your choices, click on the Save button to close the dialog box.
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Preferences dialog box

General Beatnik Editor operating settings.

Note: Your Beatnik Editor preferences are stored in the file BeatnkEditorPrefs.bpf.

The Beatnik Editor uses a conventional Preferences dialog, containing just a few items:

Item Use

1 Choose MIDI Input Device 
list

Determines which MIDI interface hardware, or MIDI router 
software, the Player window and Beatnik MIDI Synthesizer 
will respond to.

MIDI events arriving from this source will drive the 
synthesizer in real time. Notes, Program Changes and
Bank Select events will play notes, set the Beatnik 
Instrument for each of the 16 MIDI channels, and con-
trol other aspects of the synth and mixer.

See also: Live MIDI Input.

2 Choose Audio Output 
Device list

(Windows only)

Determines which of the available audio output methods the
Beatnik MIDI Synthesizer will use for its output.

1

2

3

4
5
6
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About Audio Output Buffering
The purpose of the audio output buffer is to keep sound flowing to the speakers even when
computer’s CPU is experiencing heavy usage. The longer the buffer, the more audio outpu
tap’ to play out while the CPU is busy processing tasks other than audio. Larger audio outpu
ers, however, make the sound take longer to reach the speakers. If this delay, known as ‘late
long enough, you’ll notice it when playing a MIDI instrument, or when playing the keyboard
the Player window, or when working with a MIDI sequencer.

See also: Coping with Latency.

3 Audio Output Buffering 
slider

(Windows Only)

Adjusts the size of the Beatnik Editor’s audio output buffer, in
milliseconds. If the audio output buffer is too short, you’ll 
hear crackling, ‘glitches’ or ‘break-up’ in the Beatnik synthe-
sizer’s sound, and you should increase the buffer size until th
problem goes away.

Suggested buffer sizes:
Windows 95/98: Can be as short as 11 milliseconds

Windows NT: 50 milliseconds or more

See Also: About Audio Output Buffering, below.

3 Reopen previous session(s) 
on start-up checkbox

When checked, launching the Beatnik Editor will always 
restore the same set of Session documents that were open
when you last exited the program.

4 Show splash screen on 
start-up checkbox

When checked, launching the Beatnik Editor will always dis
play the program’s name and version number.

5 Show ToolTips checkbox

(Windows Only)

When checked, the Beatnik Editor will pop up a brief expla-
nation of any onscreen item your cursor lingers over.
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 177
Song Menu windows
How to use the Dialog Boxes accessed from the Song menu.

Topics:
Song Settings dialog box
Song Info dialog box
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Song Settings dialog box

Lets you inspect or change a Song’s title and playback properties, or update its MIDI File 
data.

Item Use

1 Title The name shown in The Songs Tab of your Session windows. 
Changing the name here produces the same result as chang
it there.

When the Song is created, its name is taken from the 
imported Standard MIDI file.

2 Reverb Type Determines which digital reverberation type the Beatnik 
Audio Engine will use for the Song when loaded and played
Reverb types simulate the spacious sound of various sizes a
kinds of acoustical rooms.

For descriptions of the listed reverb types, see the 
Effects: Reverb and Chorus heading in the For Musi-
cians section.

Note: Setting a reverb type here doesn’t necessarily 
guarantee the Song will be heard with that reverb. The
Beatnik mixer only has one reverb processor, which ca
be set to a different reverb type at any time by MIDI 
Song data, or with interactive program controls. Also, 
each Instrument may bypass the reverb processor.

Note: Using reverb increases the CPU load at playback
time, sometimes dramatically.

1
2

3

4 5
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3 Tempo Adjust Sets the Song’s playback tempo, as a percentage of the tem
stored in the imported MIDI file (25% – 300%). This is a con
venience feature that lets you adjust the tempo without havin
to re-edit the MIDI file in a sequencer, as you’d otherwise 
have to do.

A Tempo Adjust setting of 100% will play at the same 
tempo as the imported MIDI file, values over 100% play
faster, and values below 100% play slower. For exam-
ple, with a Tempo Adjust setting of 50% the Song would 
play at half the tempo of the original MIDI file.

4 Volume Adjust Sets the Song’s playback volume, as a percentage of norma
volume (5% – 300%). This is a convenience feature that lets
you adjust the volume without having to re-edit the MIDI file
in a sequencer or adjust all the Instrument volumes individu
ally, as you’d otherwise have to do.

A Volume Adjust setting of 100% will play at normal 
volume, values over 100% play louder, and values 
below 100% play quieter. For example, with a Volume 
Adjust setting of 50% the Song would play at half nor-
mal volume.

Note: Excessive volume settings may produce digital 
distortion.

5 Re-Import MIDI button Updates the Song’s MIDI File (notes) data from a Standard
MIDI file on disk, using the Import dialog box. To keep your 
RMF files in sync with the composer/arranger, be sure to re
Import every Song’s MIDI data every time it changes.

Note: The Beatnik Editor doesn’t edit the notes and 
other events inside MIDI Files – you need a separate 
MIDI sequencer program for that. Every time you make
changes in the sequencer, you’ll have to re-import the 
updated MIDI file into the Song.
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Song Info dialog box

Lets you inspect or change the RMF ‘meta-data’ information for one or more selected 
Songs, including copyright notice and credits.

Topics:
About Song Info Fields
How to Fill In the Info Fields
Editing Song Info for Multiple Songs
About Default Settings
URL Links in Song Info Fields

About Song Info Fields
The Song Info dialog box contains 15 text fields that are included in RMF Files exported from
Song. Listeners can view most of this information in Web browsers while the RMF file is pla
using the Beatnik Player control panel. This is how you attach your copyright and license in
mation to the RMF files you release onto the Web. Web page and Shockwave developers c
read the text fields with the Music Object getInfo()  method.

Note: The following fields are primarily intended to help organize music libraries, and sdo 
not appear in the Beatnik Player’s control panel display: Genre, Sub-Genre, Tempo Descrip-
tion, and Original Source.

A few things to keep in mind about the Song Info fields:

• RMF is a secure file format. Once your Song is exported to RMF, any attempt to tampe
these Info fields – such as your copyright notice or license term – will render the file unu
This is a good thing.
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• RMF’s security also means that if you lose your Session file, you won’t be able to change
Song Info fields any more! If you care about being able to make future adjustments to yo
RMF files – either in the Song Info or in the audible content – be sure to retain the Beatnik 
Editor Session files you made them from.

• Song Info entry fields can contain large amounts of text – up to 32,768 characters in each
However, in the Beatnik Player for Web browsers, only about the first 50 characters will
visible (subject to the user’s system font and point size settings). If you intend to use lar
amounts of Song Info text, you’ll probably want to prepare the text in a separate text edito
program, and then use the clipboard to copy and paste into the text entry fields in the Song Info 
dialog box. The fields are limited in size to discourage very large text blocks.

• Another reason to avoid very long text is that every character of Song Info you use adds one 
byte to the size of your RMF file – so if you want to minimize the size of your RMF files, k
your Song Info entries brief.
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How to Fill In the Info Fields
The following table lists the available fields and explains how to fill them in.

Editing Song Info for Multiple Songs
If you entered the Song Info dialog box with more than one Song selected, the number of sele
Songs will appear near the top of the dialog box, and the changes you make here will be ap
all of those Songs when you click the OK button. Any fields you don’t change will retain their cu
rent contents.

Some fields will have different existing contents for different Songs – for example, the Title is 
likely to be different for each Song. These fields will be indicated with the message Multiple 

Field Description Example

Title Title of the Song Go Doe Go

Performed by Name of performer/group The Doe Boys

Composer(s) Name of composer Joe Doe

Copyright Copyright notice © 2000 Joe Doe

Publisher Contact How to reach the Song’s publisher to 
learn more about licensing it

www.DoeMusicCom-
pany.com 1-800-555-1234

Use of License Uses for which the Song has been 
licensed

For Doe Boys Website Pro-
motion Only

License URL Web URL from which the RMF file is 
authorized to be served

www.doeboys.com

License Term Duration of license 1 year

Expiration Date End of license term Dec 31, 2000

Genre The Song’s musical style (general)
(not displayed in Beatnik Player)

House

Sub Genre The Song’s musical style (specific)
(not displayed in Beatnik Player)

Dubno

Tempo Description Descriptive only; tempo BPM is set in 
the Song Settings dialog box.
(not displayed in Beatnik Player)

A lively waltz!

Original Source Where did the Song data come from?
(not displayed in Beatnik Player)

The Doe Boys

Index Number For music library management DoeLib volume 23, index 47

Composer Notes Miscellaneous notes about the Song. This file loops seamlessly.
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selection with unmatched values, and a ... button will appear to the right of the item:

To enter new information into such a field, replacing all selected Song’s existing information for 
that field:

1. Click the ... button.

A Select Value: dialog box will appear listing all the different values that the selected So
contain for that field, and a text entry box in case you want to enter a completely differ
value.

2. Select one of the entries from the list, or type your new field contents into the text entry

3. Click the OK button.

The Select Value: dialog box will close, returning you to the Song Info dialog box with your 
field filled in.
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About Default Settings
Two buttons allow you to set up a default ‘template’ of Song Info field settings that you use fre-
quently. Just type in the information for fields that change infrequently, leave any Song-spe
fields blank (like the Title, for instance), and click the Save as Defaults button. This saves that col
lection of field contents as your ‘Default Setting’. Then later, any time you want to re-use yo
template information for a Song, just open the Song Info dialog box and click the Use Defaults 
button:

URL Links in Song Info Fields
Several of the Song Info fields support URLs. This gives you a way to provide hyperlinks that W
listeners viewing your Song Info with the Beatnik Player control panel can click, taking them t
Web pages of your choice.

For example, the URL in following text will be clickable in the Beatnik Player:

Click for licensing info: http://www.doeboys.com/licensing.htm

Note: Don’t try to use HTML tags like <A HREF=”...”></A>  in a Song Info field – any text
starting with the familiar http://  is automatically treated as a URL.

Item Use

Save as Defaults button Copies the current field contents to the Default Setting.

Use Defaults button Fills fields in from the Default Setting, replacing the current
field contents.

Fields that are blank in the Default Setting will not be 
replaced.
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Instrument Menu windows
How to use the dialog boxes accessed from the Instrument menu.

Topics:
Instrument Editor window
Move Instrument dialog box
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Instrument Editor window

A workspace for creating custom Instruments for use in RMF files.

Note: All Instruments are based on Samples.

Tip: If you decide to cancel all your Instrument Editor window edits and revert to the previ-
ous version, there are two ways to do it:

• If you’re working in the Instrument Editor window when you decide to revert, go 
to the File menu and select the Revert command.

• If you’ve just closed your Instrument Editor window and then decide to revert, 
then immediately click in the Session document window that contains the Instru-
ment you just edited, then go to the File menu and select the Undo command.

Overview
The Instrument Editor window is a patch editor for the MIDI synthesizer that’s used in all Beat
playback software – the Beatnik Player for Web browsers, the Beatnik Xtra for Director and
Shockwave, JavaSound, and the Beatnik Audio Engine for C and C++.

The Instrument Editor has five Pages. To access a page, click on its large button:

Page Contains

Keymap Page Sample Keymap, with transpose and volume controls

Filter Page Filter settings

Volume Page Volume Envelope

Modulation Page Dynamic Modulators: LFO’s, envelopes, and combinations

Output Page Pan and Reverb settings
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Keymap Page

Every Instrument includes one Keymap. The Keymap determines what Sample will be play
each received MIDI note number (pitch), so you can think of the Keymap page as a ‘digital v
that plays a Sample and produces an audio output. The Keymap is displayed in two ways: a
of Keymap Zones, and as a keyboard diagram.

The Keymap consists of one or more Keymap Zones, each linking one MIDI note range to 
Sample, with instructions on how to play the Sample when a note in that range is received.
Beatnik MIDI Synthesizer doesn’t support crossfades or velocity switching, so Keymap Zon
can’t overlap.

Since there are 128 MIDI note numbers, and a Keymap Zone can be as little as one note w
Keymap can contain up to 128 Keymap Zones. A very simple Instrument would have just o
Keymap Zone covering the entire keyboard, whereas a more complicated Instrument (for e
ple, Beatnik’s General MIDI piano at Bank 0, Program 0) uses many Keymap Zones to pro
many different Samples for different ranges of the keyboard.

On the keyboard diagram, adjacent Keymap Zones have different colors, and the selected K
Zone’s name and Root Key dot appear on the keyboard. In the list, each Keymap Zones ap
on a separate line.

The two buttons below the keyboard diagram apply to all Keymap Zones in the Instrument:

• Always Play at Root Pitch controls whether the Instrument will act as an ordinary playable
musical instrument, or as a bank of non-transposable sounds. When this button is turne
the Samples will never be transposed by the pitch of the received MIDI notes, and will a
play back at the same pitches at which they were recorded.

• Ignore Loops in Sample controls whether any loops stored with the Samples will be used.
When this button is on, the loops will be ignored and the Samples will always play straig
through from beginning to end – ending before the played MIDI note does, if the note is
long enough.
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Each Keymap Zone contains the following fields:

Column Sets

Low note
High note

Lowest and highest MIDI notes in this Keymap Zone.

See Adjusting a Keymap Zone’s Range below.

Sample name Name of the Sample to use for this note range.

To open the Sample in a Sample Editor window:

• Windows: Hold the Alt key and double-click on the Sam-
ple name.

• Mac OS: Hold the Option key and double click on the 
Sample name.

To replace the current Sample with a different one, either:

• Drag a Sample in from the Samples tab of a Session win
dow, and drop it on the Sample name, or.

• Double-click on the Sample name, then make a selectio
from the list of available Samples that appears.

Root Key MIDI note that will cause the Sample to play at its original 
pitch. This Root Key isn’t required to fall inside the Keymap 
Zone’s note range, although for most conventional Instru-
ments it will.

See Adjusting a Keymap Zone’s Range below.

Volume Volume to use for this Keymap Zone, so that you can balanc
zones whose Samples have different volumes.

Volume is expressed as a percentage of the Sample’s norm
volume. For example, a volume of 100 is considered normal, 
and 800 would overdrive the Sample volume eight times over

Note: Excessive volumes may cause digital overload 
distortion.

To change a Volume, click on the current value in the list, then 
type a number from 0 through 800, and then press the Return 
or Enter key.
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Working with Keymap Zones

Adding and Removing Keymap Zones
• To add a new Keymap Zone, click the Add button above the list.

The new Keymap Zone will fill the lowest available empty note range – or, if the whole
board is already covered with Keymap Zones, the largest existing Keymap Zone will be
in two, and the new Keymap Zone will take over one of them.

• To remove a Keymap Zone, select it and click the Delete button above the list.

Selecting Keymap Zones
There are three ways to select a Keymap Zone:

• On the keyboard diagram, click on the Keymap Zone you want.

• In the list, click on the Keymap Zone you want.

• In the list, use the cursor control keys on your computer keyboard to move to the Keym
Zone you want: up arrow, down arrow, left arrow, right arrow, Home, and End all work.

Adjusting a Keymap Zone’s Range
There are two ways to change a Keymap Zone’s range – either visually, or by typing:

• To type, click on the Keymap Zone’s Low or High note in the list, and then type your new no
name and octave – for example, D1.

Note: For a flat, type a lowercase b (for example, Gb3) and for a sharp use pound sign (#) – 
but remember that the Beatnik Editor always displays the sharp version (F#3).

• To set the range visually, first select the Keymap Zone, then go to the keyboard diagram
click and horizontally drag the zone’s low (left) or high (right) boundary.

Note: Dragging a boundary will ordinarily also move the boundary of the adjacent Key
Zone. If you want to open up an empty space instead:

• Windows: Alt-click the boundary, then drag left or right.

• Mac OS: Option-click the boundary, then drag left or right.

Tip: Single-zone Keymaps always cover the entire keyboard. If you only need one Sam
your Instrument, but want to limit the note range in which it can be played, then add a
ond zone. This will let you adjust their zone ranges separately, and will let you leave k
ranges uncovered. If you wind up with an unnecessary zone that you want to be silent
it just one note wide and set its volume to 0.

Adjusting a Keymap Zone’s Root Key
There are three ways to change a Keymap Zone’s Root Key:

• On the keyboard diagram, first select the Keymap Zone, and then drag the orange dot t
desired note.

• On the keyboard diagram, first select the Keymap Zone, and then shift-click the desired

• In the list, click on the Root Key note and then type your desired note name.
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Filter Page

The audio signal from the Keymap Page feeds the Filter Page. If the filters are switched on, the 
signal is processed by the filters, otherwise the filters are bypassed.

Note: You don’t need to use the filters if your Instrument design doesn’t call for them. I
fact, the filters contribute significantly to the synthesizer’s CPU processing load – so if
don’t need the filters, you should switch them off.

To switch the filters off, click the small light next to the large Filter Page button to turn i

Notes: 
• If you want to use any stereo Samples in an Instrument, you’ll probably want to 

avoid using the Filter.
• If you’re going to mix mono and stereo Samples in the same Instrument, you’ll 

probably want to avoid using the Filter.
• If you want to use the Filter on an Instrument, you’ll have to use mono Samples.

This is all because whenever an Instrument is playing a stereo Sample, the Filter is 
bypassed. As a result, bad-sounding artifacts can occur when a filtered Instrument sw
from a mono Sample to a stereo Sample, or vice versa. 
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About the Filters
The Filter Page contains two different filters, acting in series:

• The Comb Filter has controls for the peak frequency spacing and resonance, and can be
to track the pitch of the notes that the Instrument is playing (see Track Pitch).

Note: When the Tone Control setting is negative, the Comb Filter is bypassed.

• The Tone Control is a gentle high or low frequency rolloff filter with a Depth setting:

• When the Tone setting is positive, the Tone Control rolls off high frequencies.

• When the Tone setting is negative, the Tone Control rolls off low frequencies, and 
the Comb Filter is bypassed.

Both the Comb Filter and the Tone Control can be modulated (see Modulation Page).

Note that this filter set is a little different from most synthesizers and samplers, which usual
a resonant lowpass filter.

Tip: To approximate a conventional lowpass filter, set the Comb Filter for very wide pe
frequency spacing, so that one cycle of the comb spreads out over the whole frequenc
trum.

Working with the Filter Page

Comb Filter
You can set both of the comb filter’s parameters (peak frequency spacing and resonance) a
by clicking on the handle (small square) in the large display and dragging:

• To change the peak frequency spacing, drag the handle left or right.

Alternatively, you can click on the Comb Frequency field, type in a frequency in Hertz (from
175 to 11200 Hz), and hit Enter. 

• To change the resonance amount, drag the handle up or down.

Alternatively, you can click on the Resonance field, type in a resonance depth amount (fro
0 for no resonance to 255 for maximum resonance), and hit Enter.

Note: To change just one parameter and not the other, hold the Shift key to constrain y
drag to just one dimension at a time.

Tone Control
• When the Tone setting is positive, the Tone Control rolls off high frequencies. The large

number, the greater the rolloff.

Filter Page

Comb
Filter

Tone
Control

From
Keymap
Page

To
Volume
Page
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• When the Tone setting is negative, the Tone Control rolls off low frequencies, and the C
Filter is bypassed. The larger the negative number, the greater the rolloff.

Track Pitch
The Filter Page includes a Track Pitch button, whose effect is a little unusual:

When this button is turned on, the Comb Filter’s peak frequency spacing will be based on t
note’s MIDI note number (pitch), with an optional offset in semitones. This can produce ma
interesting and unusual harmonic effects. The result is best heard when the Comb Filter res
setting is fairly high.

For example:

• If you set the semitone offset to 0, then the Comb Filter’s peak frequencies will exactly mat
the pitch of the played note, and will adjust on a note-by-note basis.

• If you set the semitone offset to 7, then the Comb Filter’s peak frequencies will always be 7
semitones (a perfect fifth) above the played note.
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Volume Page

The audio signal from the Filter Page feeds the Volume Page. If the Volume Envelope is switched
on, the signal is processed by the Volume Envelope, otherwise the Volume Envelope is byp

Note: You don’t need to use the Volume Envelope if your Instrument design doesn’t ca
it. In fact, the Volume Envelope contributes to the synthesizer’s CPU processing load –
you don’t need the Volume Envelope, you should switch it off.

To switch the Volume Envelope off, turn off the small light next to the large Volume Pag
button.

About the Volume Envelope
The Volume Envelope is displayed as a graph, where the horizontal axis represents Time and the 
vertical axis represents the volume Level. The graph shows all the segments that make up the 
ume Envelope. You can edit the envelope’s shape directly in the graph – just click on a poin
drag it up and down, and right and left, to a new Time and Level.

The Volume Envelope points are also listed below the graph as pairs of numbers (Time and Level).
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How Envelope Phases Relate to Note Timing
A Volume Envelope has up to three phases – the Attack phase, an optional Sustain phase,
Release phase. These phases link envelope timing to the MIDI note events that trigger the

Phase Description

Attack
(before grey section)

Can have multiple segments

The Attack phase begins when the MIDI Note On message is 
received. The Volume Envelope starts working through its seg-
ments, and continues until one of two things happen:

• The MIDI Note Off event is received. If this happens first, the
Volume Envelope jumps to the first segment in the Release
phase, skipping any phases not yet reached.

• The last segment in the Attack phase ends. If this happens 
before the Note Off event, the Volume Envelope continues 
into the Sustain phase.

Sustain
(grey background)

Can only have one segment

If the Attack phase has completed, but the MIDI note is still being
held, then the Volume Envelope stays in the Sustain segment unt
the MIDI note is released. Remember, the MIDI note can be held
for an unlimited amount of time. That’s why the Time axis isn’t 
labeled during Sustain segment, and why Time begins again from 0 
when the Release phase starts. For the same reason, the Sample
typically be looping while the Volume Envelope is in the Sustain 
phase.

Decay during the Sustain segment: Ordinarily the Volume Enve-
lope will hold steady at the same Level during the Sustain segmen
so that the note can be held infinitely long if necessary. However,
for many kinds of Instruments – including plucked strings and 
pitched percussion – maintaining a steady volume during the sus
tain period sounds unnatural, so you also have the option to allow
the Volume Envelope to decay during the Sustain segment.

Note: If you use Decay during the Sustain segment, the seg
ment is drawn in red.

Note: If you use Decay during the Sustain segment, and you
Envelope decays to zero before the MIDI notes are finished
the notes will end prematurely.

Release
(after grey section)

Can have multiple segments

The Release phase begins when the MIDI Note Off messag
is received. The Volume Envelope jumps to the first Release
segment, and works through the Release segments until 
reaching the end of the last Release segment – at which tim
the note is finished.

Attack Phase Sustain Phase Release Phase
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Working with the Volume Page

Zooming the Display
To manually zoom in and out, use the magnifying glass buttons in the upper right corner. If
drag a point off the right edge of the window, the display will automatically zoom out to fit.

Using the Preset Envelope Shapes
The three Create New Shape buttons below and to the right of the graph call up simple, pre-
defined envelope shapes. For example, the second button is a basic 3-point envelope with
tain segment.

Note: Clicking a Create New Shape button will wipe out your current, edited envelope an
replace it with one of the preset shapes.

Tip: Changing the Envelope type with the Create New Shape buttons can drastically change
the Instrument’s sound. If you don’t like the sound of resulting change, use the Undo com-
mand immediately.

Editing the Envelope Shape
• To Add a new point: Click on any graph segment and a new segment will be added to the 

phase of the Envelope.

Note: If the Volume Envelope you’re editing does not already include a Sustain segme
you cannot add a new Sustain segment directly. Instead, you’ll have to use the Create New 
Shape buttons to select a preset shape that does include a Sustain segment, then edit
shape to meet your Instrument’s requirements.

• To Move a point’s Time and/or Level: Click on the point and drag its handle.

Notes:
• To enter exact Time and Level values, click on the number fields and type.

• To change just one and not the other, hold the Shift key to constrain your drag to 
just one dimension at a time.

• To Delete a point:
• Windows: Alt-click the point.

• Mac OS: Option-click the point.

• To use Decay during the Sustain segment: Drag down on the Sustain segment’s end handle
and then move it left or right. The Sustain segment will be redrawn in red.

Hold Sample In Release
The Hold Sample in Release button controls how Samples that include loops will behave in th
Instrument:

• If the Hold Sample in Release button is on, the Sample Loop will never exit once entered. Th
part of the Sample after the Looping region won’t be heard in this Instrument.

• If the Hold Sample in Release button is off, the Sample Loop will only repeat as long as the
MIDI note is held. As soon as the MIDI note is released – in other words, as soon as the
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ume Envelope enters the Release phase – the Sample will stop Looping, and the part o
Sample after the Looping region will play.

Note: Samples without Loops aren’t affected by the Hold Sample in Release button.
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Modulation Page

Tip: The Modulation Page is the Instrument Editor’s most complicated page. It can be con
fusing at first if you’re not familiar with the Beatnik Editor, or with music synthesizers i
general. For some introductory material to help you figure out what’s going on here, se
section For Musicians.

The Modulation Page is different from the other Instrument Editor pages in that it doesn’t directly
generate or process any audio signals. Instead, it generates control signals that modify par
all the other Pages. Modulators are LFO’s (Low Frequency Oscillators), Envelopes, and co
tions of the two – control signal sources that you can edit to make an Instrument sound mo
dynamic and interesting by varying those parameters over the life of the note, in musically 
ways.

Note: You don’t need to use Modulation if your Instrument design doesn’t call for it. In f
Modulation contributes to the synthesizer’s CPU processing load – so if you don’t nee
use Modulation, you should switch it off.

To switch Modulation off, set all five Modulators’ destinations to Not Used (see below).

Topics:
Modulators in a Nutshell
Working with the Modulation Page
A Modulation Tutorial

Modulators in a Nutshell
• An Instrument can use up to five Modulators.

• The Modulators that your Instrument actually uses are indicated in the lower rectangula
dow, just above the Page selector buttons. If the window shows Not Used five times, then you 
aren’t using any Modulators.

• To select a Modulator for editing or inspection, click on it in the lower rectangular windo
The Modulator will appear in the upper editing display.

• Each Modulator has a Modulator Type and a Modulator Destination. The Modulator Typ
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determines what kinds of signal the Modulator is able to generate. The Modulator Destin
is the Instrument parameter that the Modulator affects:

Note: Modulator Types and Destinations are explained in much greater detail in the For 
Musicians section, starting at the heading Modulation. You may also find the Modulation 
Tips section helpful.

Working with the Modulation Page

To Add a New Modulator:
Assigning a Modulator to an actual destination turns the Modulator on. In the lower rectang
window, find a Modulator slot that’s Not Used, then click and hold on the words Not Used and 
select one of the available Modulator Destinations from the pop-up menu that appears.

A thumbnail will appear beneath, and the Modulator Type pop-up menu will appear to the r

To Delete a Modulator:

Removing a Modulator’s destination turns the Modulator off. In the lower rectangular windo
click and hold on the Modulator’s Destination pop-up menu, then select Not Used.
The Modulator’s thumbnails will disappear beneath, as will the Modulator Type pop-up men
the right.

To Change a Modulator’s Destination:

In the lower rectangular window, click and hold on the Modulator’s Destination pop-up men
then select the destination you want.

To Change a Modulator’s Type:

In the lower rectangular window, click and hold on the Modulator’s Type pop-up menu, then
select the Modulator Type you want.

To Select a Modulator’s LFO or Envelope for Editing:
Depending on the Modulator Type, each Modulator will show either one or two ‘thumbnail’ 
graphs in the lower rectangular window – an LFO thumbnail on the left if it includes an LFO
an Envelope thumbnail on the right if it includes an Envelope. To select an LFO or Envelop

Modulator Source Types Modulation Destinations

Low Frequency Oscillator (LFO)
Envelope
LFO with Depth Modulator (Envelope)
Offset Modulator

Volume
Pitch
Stereo Pan Position
Filter Tone Control
Comb Filter Frequency Spacing
Comb Filter Resonance

(Choose One per Modulator) (Choose One per Modulator)
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editing in the large editing window at the top of the page, just click on its thumbnail.

Editing a Modulator’s Envelope Part
All Modulator Types except the basic LFO include an Envelope part. Editing an Envelope in
Modulation Page works just the same as editing the Volume Envelope in the Volume Page:

• The horizontal axis is Time, and the vertical axis is Modulation Depth.

• To add a point, click on a segment.

• To delete a point, Alt-click (Windows) or Option-click (Mac OS) on it.

• To move a point in Time or Level, drag it. Or, type into the number fields.

• To constrain a drag, use the Shift key.

• To replace your Envelope with a simple preset template, click on one of the Create New Enve-
lope buttons.

Note: For the Offset Modulator type, an additional ADSR(%) slider appears just above the 
Create New Envelope buttons. For details, see the section Modulator Types.

For further operating details, see Working with the Volume Page.

Editing a Modulator’s LFO Part
All Modulator Types except the basic Envelope include an LFO part. Editing an LFO in the Mod-
ulation Page works just the same as editing the Comb Filter in the Filter Page:

• The horizontal axis is Time, and the vertical axis is Modulation Depth.

• To change the LFO period and depth, drag the handle in the graph, or type into the num
fields.

• To change the LFO waveform, click one of the waveshape buttons below the large wind
sine, triangle, square, inverted square, sawtooth, or inverted sawtooth.

For further operating details, see Working with the Filter Page.

To Zoom the Editing Window:
To manually zoom in and out, use the magnifying glass buttons in the upper right corner. If
drag a point off the right edge of the window, the display will automatically zoom out to fit.

A Modulation Tutorial
To add vibrato to an Instrument:

1. Find an unused Modulator slot in the lower rectangular window.

2. Click and hold on the pop-up menu that says Not Used, and then select Pitch.

This will be your Modulator’s destination. A thumbnail will appear beneath, and the Mo
lator Type pop-up menu will appear to the right.

3. Click and hold on the Modulator Type pop-up menu, and then select LFO.

This will be your Modulator Type. The Modulator’s LFO thumbnail will appear beneath
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Pitch label.

4. Click on the LFO thumbnail to select the LFO for editing.

The large editing window at the top of the page will now show the LFO’s current settin

5. In the large editing window, drag the LFO graph’s control handle (the black square whe
two red lines cross) to set a period of about 300 ms, and a depth of about 50%.

 Now when you play the Instrument in the Player window, you should hear a warbling 
vibrato. That’s the effect of your LFO Modulator on the Pitch.

Many Instruments sound more natural if the amount of vibrato starts at zero, then fades in 
ally over a period of a few seconds. That’s one of the things the LFO with Depth Modulator modu-
lator type is good for. Here’s how to use it:

1. Click and hold on the Modulator Type pop-up window again, and this time select LFO with 
Depth Modulator.

A second thumbnail will appear next to the LFO thumbnail – an Envelope thumbnail.

2. Click on the Envelope thumbnail.

The large editing window will now show the Envelope instead of the LFO. This is the E
lope that controls how the Pitch LFO’s depth will change over time. The default Envelope
isn’t very useful, however, so you’ll need to create a better one.

3. Create a simple Envelope that takes 2 seconds to reach a maximum, and then anothe
second to return to zero:

• Click the middle Create New Envelope button. Three Envelope Handles will 
appear in the graph, all at a level of 0%.

• Drag the rightmost Envelope Handle out to the right, out to around 2000 ms.

• Drag the middle Envelope handle up to 100%, and then out to the right to about 
2000 ms.

Now when you play the Instrument in Player window window, you should hear the warbling
vibrato increase over two seconds, and then decrease to nothing in another two seco
That’s the effect of the Depth Modulator envelope on your LFO Modulator.
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 201

 
o 

Songs 

d 
Output Page

The audio signal from the Volume Page feeds the Output Page, which is the Instrument’s final 
stage. It only contains two controls:

• The Disable Reverb button controls whether the Instrument will send a signal to Beatnik’s
global reverb processor. If this button is on, then the Instrument will always sound ‘dry’ n
matter how the global reverb is set, and no matter which reverb type is selected for the 
that use the Instrument.

• Stereo Pan position. This is set as a number, with 0 indicating center, -64 indicating full Left, 
and 64 indicating full Right.

There are three ways to set the Pan position:

• Drag the slider control.

• Drag in the large Left – Right display.

• Type a number into the numeric Stereo Pan field.

Notes: 
• If you want to use any stereo Samples in an Instrument, you’ll probably want to 

avoid using the Stereo Pan control.

• If you’re going to mix mono and stereo Samples in the same Instrument, you’ll 
probably want to avoid using the Stereo Pan control.

• If you want to use the Stereo Pan control on an Instrument, you’ll have to use 
mono Samples.

This is all because whenever an Instrument is playing a stereo Sample, the Stereo Pan 
control is bypassed. As a result, bad-sounding artifacts can occur when a panne
Instrument switches from a mono Sample to a stereo Sample, or vice versa.

(End of Instrument Editor window)
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Move Instrument dialog box

Lets you change an Instrument’s number, which is the same as its MIDI Program number.

When the Move Instrument dialog box first opens, the Bank and Instrument Number will refle
the current location of the selected Instrument. To assign the Instrument to different Bank a
Instrument number – effectively moving it to a new Instrument slot and MIDI Program numb
just enter the Bank and Instrument number you want, and then click the OK button.
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Sample Menu windows
How to use the dialog boxes accessed from the Sample menu.

Topics:
Sample Editor window
Compression dialog box
Make Instrument dialog box
Make Song dialog box
Clear compression cache dialog box
Delete uncompressed originals dialog box
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Sample Editor window

A workspace where you can audition, inspect, clean up, and loop imported Samples.

Tip: If you decide to cancel all your Sample Editor window edits and revert to the previous
version, there are two ways to do it:

• If you’re working in the Sample Editor window when you decide to revert, go to 
the File menu and select the Revert command.

• If you’ve just closed your Sample Editor window and then decide to revert, then 
immediately click in the Session document window that contains the Sample you 
just edited, then go to the File menu and select the Undo command.

Notes:
• Most of the Sample editing functions are only available when a range of the Sam-

ple’s waveform is selected – see Making a Selection.

• In the Sample Editor window, you’re editing the Sample’s uncompressed original 
version, not the compressed copy you made in the Compression dialog box. As 
soon as you exit the Sample Editor window, the Beatnik Editor will re-compress 
the revised Sample, using the same compression type you selected for that Sam-
ple.

Topics:
Making a Selection
Sample Editing Commands
Using the Onscreen Controls

See also: Looping Tips in For Musicians.
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Making a Selection
Most of the Sample editing functions are only available when a range of the Sample’s wavef
selected. To select a range of the waveform, click the mouse at one end of the part you wa
edit, then drag left or right to the other end, and release the mouse button. This selects the
and causes the Volume Handles to appear:

Tip: To extend or contract either end of the selection, you can Shift-click and then drag
or right.

Once you have a selection, you can apply the Sample editing command in the context, Edit, and 
Sample menus.

Volume
Handles

Selection
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Sample Editing Commands
In the Sample Editor, the context menu contains the following commands. Some of these com
mands are only available when a range of the waveform is selected. Most of these comma
also available in the Sample menu.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

Note: Undo and Redo are also available in the Edit menu, and via keyboard shortcut
(Windows: control-Z; Mac OS: cmd-Z).

Command Use

Delete Removes the selection from the Sample (cut).

Crop Trims away all sound before and after the selection.

Normalize Increases the selection’s volume to the highest possible lev
before distorting.

Fade In Creates a fade-in across the entire selection.

Note: By contrast, the Fade-In Volume Handle lets you 
apply a fade-in that starts at the beginning of the selec
tion, but is shorter than the selection. See Using the 
Onscreen Controls.

Fade Out Creates a fade-out across the entire selection.

Note: By contrast, the Fade-Out Volume Handle lets you
apply a fade-in that finishes at the end of the selection
but is shorter than the selection. See Using the Onscreen 
Controls.

Zoom Normal Resets the X and Y zoom levels.

Zoom Loop Start Zooms in on the loop start.

Zoom Loop End Zooms in on the loop end.

Jump Loop Start If the loop start isn’t visible, horizontally scrolls to it.

Jump Loop End If the loop end isn’t visible, horizontally scrolls to it.

Select All Selects the entire Sample.
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Using the Onscreen Controls
The Sample Editor window includes several graphic displays and controls:

Item Use

1 Time Scale Shows running time in sample numbers (not milliSeconds)

2 Loop Handles The Loop Handles set the position of the orange Looping 
region. To move a Loop Handle, click on it and drag left or 
right. The middle Loop Handle moves the loop region withou
changing its length.

Note: The Loop Handles only appear when the Loop 
button is on – see 10.

Note: The Loop Start and Loop End points are also dis-
played as numbers that you can edit directly – see 9.

1

2

4

6
9, 10

13

5

12 11 7

3
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3 Volume Handles The Volume Handles are controls for applying a fade-in, fa
out, or volume change to the selection:

Note: The Volume Handles are only available when a 
range of the Sample’s waveform is selected – see Mak-
ing a Selection.

• To apply a Fade-In to the start of the selection: Click on 
the left Volume Handle, then drag to the right. Release th
mouse button at the point where you want the fade-in to
finish. If you want to fade in from the beginning of the 
whole Sample, be sure your selection begins at the very
first sample.

Note: By contrast, the Fade-In command applies a fade-
in to the full length of the selection – see Sample Editing 
Commands.

• To apply a Fade-Out to the end of the selection: Click on 
the right Volume Handle, then drag to the left. Release th
mouse button at the point where you want the fade-out t
start. If you want to fade out at the end of the whole Sam
ple, be sure your selection ends at the very last sample.

Note: By contrast, the Fade-Out command applies a 
fade-in to the full length of the selection – see Sample 
Editing Commands.

• To change the selection’s volume: Click on the center Vol-
ume Handle and drag up or down.

• To change the whole Sample’s volume: Use the Select All 
command, then click on the center Volume Handle and 
drag up or down.

Note: By contrast, the Normalize command turns the 
selection’s volume up to the maximum possible level 
before clipping – see Sample Editing Commands.

4 Selection Indicators Displays the start, end, and length of the currently selecte
range of the Sample waveform – or, if there’s no selection, th
current cursor position. All numbers are in Sample numbers
not milliSeconds.

5 Zoom Controls Displays the current waveform zoom levels:

• To zoom the time axis (horizontal) in and out, use the X 
controls. At 1:1, each horizontal screen pixel shows one 
audio sample.

• To zoom the volume axis (vertical) in and out, use the Y 
controls.
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6 Sample Rate field Sets the playback sampling rate for this Sample, in samples
per second.

Note: Changing this number will not  convert the data to 
a new sample rate and will  change the pitch. This field is 
treated as an instruction for how fast to play the Sampl
data, so the higher the number, the higher the pitch an
the shorter the sound.

Caution: Be careful when changing the Sample Rate. If 
any Instruments use this Sample, then changing the 
Sample Rate will change those Instruments’ pitch – 
which is usually a problem.

7 Root Key field
8 Root Key button

Records the pitch (MIDI note number) that the Sample pro-
duces when played at its current Sample Rate. To set the Root 
Key, either click on the field and then type in a note name (fo
lowed by the Enter key), or click the button and select a note 
from the keyboard that appears.

Caution: If the Root Key is not set correctly, then Instru-
ments automatically built from this Sample will play out 
of tune.

Note: The Root Key note is used whenever you make a 
new Instrument using this Sample, and allows the Bea
nik Editor to automatically preserve correct pitch in 
Keymaps that it creates for you (see the Make Instru-
ment dialog box and the Make Song Using command).

Note: Changing the Root Key does not affect Instru-
ments that already use this Sample. The Root Key note is 
only used when new Keymaps are created.

9 Loop Start and Loop End 
fields

Display the start and end of the Looping region, or 0 if no 
loop exists. Both numbers are in Sample numbers, not milli-
Seconds. To set either field, click on the field, and then type 
a sample number (followed by the Enter key).

Note: The Loop Start and Loop End points also appear in 
the waveform display as Loop Handles – see 2.

Note: The Loop Start and Loop End fields only apply 
when the Loop button is on – see 10.

10 Loop button Controls whether the Sample will loop when played. When 
the Loop button is lit, Looping is turned on.

Note: To set the Looping region position, see the Loop 
Handles (2) or the Loop Start and Loop End fields (9)
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11 Play button Plays the Sample. Use to check your work as you make ed

Note: The spacebar on your computer keyboard also ac
as a Play / Stop button.

Note: Playback always starts from the current sample 
cursor position (vertical white line), not necessarily 
from the start of the Sample. Every time you click in the
waveform display, the cursor moves to that position.

12 Stop button Stops playback of the Sample.

Note: The spacebar on your computer keyboard also ac
as a Play / Stop button.

13 Sample Info area Displays additional information about the Sample:

• Sample Length – In sample numbers, not milliSeconds.

• Channels – Mono (1 channel) or Stereo (2 channels).

• Bit Depth – Resolution of the Sample in bits, either 8 bit or 
16 bit. Note that 8-bit sounds have noticeably lower fidel-
ity than 16 bit sounds.

• Compression Type – The Sample’s current compression 
type, as set via the Compression dialog box.

• bytes used on disk– The amount of disk space used by the 
Sample. Note that you can reduce this number with com
pression, or by reducing the bit depth or sample rate in a
separate sample editing program.
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Compression dialog box

A workspace for choosing the best data compressor for one or more selected Samples.

Note: If you have audio production experience, you may find this use of the term compres-
sion confusing. Here, the word refers to audio data compression, which is the art of reduc-
ing the size of a sample file – and not dynamic range compression of audio signals, which 
may be more familiar to you.

Topics:
Working with the Compression Dialog Box
Setting a Compression Type
About Compression
About the Sample Cache
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Working with the Compression Dialog Box
The Compression dialog box gives you tools for testing or ‘previewing’ various compression
types on your selected Samples, comparing the original audio to the compressed versions
assigning your preferred compression type to the Samples.

If the selected Samples have been previously compressed or previewed with the selected c
sion type, then the compressed size will appear below the list. Notice the difference in comp
and uncompressed size.

Item Use

1 Compression Types listbox To select a compression type, click on it. To avoid all data
compression, select no compression.

Note: The compression types listed here may vary from
Sample to Sample because some of the compression 
types won’t work for certain kinds of Samples – i.e. par
ticular sampling rates, numbers of channels, and/or bit
depths.

1

2

3

4 6

5
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Setting a Compression Type
To set the compression type for the selected Samples:

1. If your RMF file will be played in Web pages by the Beatnik Player for Web browsers, a
it’s important to you that it play with the maximum number of existing users’ Beatnik Pla
installations, then check the Player 2.0.x and Beatnik Xtra Compatible Types Only checkbox.

2. Select a compression type from the list.

3. Click the Preview button and listen to the compressed Sample.

2 Player 2.0.x and Beatnik Xtra 
Compatible Types Only check-
box

To ensure that your RMF files’ MP3 compression will be 
backwards-compatible with more versions of the Beatnik 
Player for Web browsers and the Beatnik Xtra for Macrome-
dia Director, be sure to check this checkbox.

Note: Until such time as later versions of the Beatnik 
Player become well-distributed, Web developers who 
require compatibility with the installed base of Beatnik 
Players should use this option.

Several new MP3 sample compression settings becam
available in version 2.0, some of which were not sup-
ported in the earlier versions. When this item is 
checked, the Compression Types listbox (1) will only 
offer those compression types that the Beatnik Player,
versions 2.0.x, and the Beatnik Xtra are able to play.

3 Original button Plays the original, uncompressed version of the Sample.

4 Preview button Previews the effect of the selected compression type on the
indicated Sample, without selecting that type.

Note: If you entered this dialog with multiple Samples 
selected, a Preview for: menu will appear above the Pre-
view button. Use this menu to indicate which of the 
selected Samples you want to preview before you click 
the Preview button.

If the selected Samples haven’t yet been compressed 
with the selected compression type, a Compression 
Progress dialog box will appear briefly.

During preview playback, the Preview button will 
change to a Stop button. Use it to cancel playback 
before the Sample finishes playing.

5 OK button Applies the selected compression type to the selected Sam
ples, and closes the dialog box.

6 Cancel button Closes the dialog box without applying the selected compre
sion type.
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• If this Sample hasn’t been compressed with this compression type before, there 
may be a delay while the Sample is compressed and added to the sample cache 
(see About the Sample Cache below).

• Note the difference between the Sample’s uncompressed and compressed sizes.

• You can preview as many different compression types as you like before settling 
on the one you want to use. If your disk fills up with too many compressed alter-
natives, use the Clear compression cache dialog box (see About the Sample 
Cache below).

4. Once you’ve decided which compression type to use, select it in the list and click the OK but-
ton.

In the Samples tabs of Session windows, a Sample’s Compression type will appear after the Sa
ple’s name, in parentheses.

About Compression
Compression saves disk space and speeds your listener’s download times by reducing the
the Custom Samples in your exported RMF files.

In a Beatnik Editor Session, compression is treated as a property that’s applied to a Sample
RMF export – your original Sample remains uncompressed, and a compressed copy is gen
for use in the RMF file export. That means it’s safe to experiment with changing the compre
type for any Sample as many times as you like – your original uncompressed Sample is alw
kept safe in the Session document. 

Note: By contrast, earlier versions of the Beatnik Editor would apply compression to th
original Sample in the Session file, which could lead to a fidelity loss if you later chang
your mind about the compression type.

Such experimentation is usually worth the effort, as different compression types are better 
for different kinds of sounds – some compression types can produce bad-sounding artifact
some kinds of sound material. You’ll want to carefully evaluate how good each compression
sounds to find the best balance between fidelity and file size for each Sample.
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The Beatnik Editor supports several different data compression algorithms, including MP3.

About the Sample Cache
For faster comparison of different compression types, the Beatnik Editor preserves every c
pressed Sample version you’ve ever previewed in a disk file “cache,” instead of re-compres
every time you ask for a preview. If the compression type you want to preview has already 
made for that Sample, the cached version is instantly played.

The sample cache ordinarily grows until you close your Session file or quit the Beatnik Edit
which time it’s deleted. If you run out of disk space during a Beatnik Editor session, you ca
reclaim the cache disk space with the Clear compression cache... command. 

Note: Although not encouraged, you can also remove the original, uncompressed Sam
from your session with the Delete uncompressed originals dialog box.

Compression Type Description

No compression Use the original Sample directly, applying no data compression.

ADPCM compression (IMA 
4:1)

Adaptive Delta Pulse-Code Modulation, which reduces files to 25% of ori
inal size. Compatible with the International Multimedia Association (IMA)
specification.

uLaw 2 to 1 Used on many UNIX-based computers. (Pronounced “mew-law”)

aLaw 2 to 1 Used on many UNIX-based computers. (Pronounced “A-law”)

MPEG Layer 3

The same compression type used in MP3 files, where the data compress
ratio is user-controllable. Higher bit rates provide better sound quality, 
whereas lower bit rates provide quicker downloads – and you get to set t
tradeoff.
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Make Instrument dialog box

Power-user shortcut for creating new Instruments from selected Samples.

Instruments can be complicated, and creating them from scratch can be tedious. For simple
ments, the Make Instrument Using command automates the worst of this work: creating new 
Instruments and setting up their Keymaps.

Note: Complicated or advanced Instruments will require further work in the Instrument Edi-
tor window.

Topics:
About the Make Instrument Using command
Creating a Single Instrument from Multiple Samples
Creating Multiple Instruments, Each with a Single Sample

About the Make Instrument Using command
The Make Instrument Using command behaves differently depending on how many Samples
you’ve selected:

• With just a single Sample selected, the Beatnik Editor will go ahead and build you a new 
Instrument using that Sample for all 128 notes, without displaying any dialog box.

• With more than one Sample selected, the Beatnik Editor displays the Make Instrument dialog 
box because it needs to know what kind of Instrument you want to make – you might w
create just one Instrument using all the selected Samples, or you might want each Sam
go into a separate Instrument of its own – and how you want the Keymaps to be laid out
resulting Instruments. When you click the OK button, the Beatnik Editor takes your instruc-
tions and creates the Instruments, all in a single step.
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Creating a Single Instrument from Multiple Samples

Note: If you have more than 128 Samples selected, only the first 128 will be used in th
ated Instrument.

To create one new Instrument using all of your selected Samples:

1. Click the Combine Samples Into One Instrument radio button 1.

This option will create one Keymap Zone per Sample. You have two options for how th
Keymap Zone will be placed on the keyboard.

2. Pick one of the keymap layout options by selecting radio button 2 or 3:

3. If you selected One per key, starting at:, then click the ... button (4) to pick the starting note.

The Select Note dialog box will appear, with a keyboard you can click to pick your note

4. Click the OK button to accept your settings and close the dialog box.

The newly created Instrument will appear in the Instruments tab of your Session wind
with the name New Instrument.

Option... Produces Keymap Layout...

2 Split into equal 
zones

All 127 keys will be covered, with an equal number of MIDI 
key numbers in each zone.

This allows the Samples to be transposed by playing different 
notes, as in most multi-sampled musical instruments.

3 One per key, starting 
at:

Each selected Sample will be assigned to one MIDI key num-
ber, beginning with a key that you can specify and moving up 
the keyboard. No other MIDI keys will be covered.

This prevents the Samples from being transposed, for exam-
ple percussion, singing, spoken word, or music recordings.

1
2
3 4
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Creating Multiple Instruments, Each with a Single Sample

New in version 2.1: This dialog now includes a checkbox option for the Specify Root Key value. 
This allows you to preserve the Samples' original Root Keys in the newly created Instrume
desired.

The Separate into Multiple Instruments option creates one new Instrument for each selected S
ple. For example, with five Samples selected, you’d get five new Instruments. All created In
ments will use the same Root Key, which you can pick. If you want to assign a different Root Key 
to any of the created Instruments, you’ll need to open them in the Instrument Editor window.

To create one new Instrument for each of your selected Samples:

1. Click the Separate Into Multiple Instruments radio button (1).

This option will create one new Instrument per Sample.

2. Click the ... button to pick the Root Key (2).

The Select Note dialog box will appear, with a keyboard you can click to pick your note. 
of the new Instruments will share this same Root Key.

3. Click the OK button to accept your settings and close the dialog box.

The newly created Instruments will appear in the Instruments tab of your Session win

1
2
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Make Song   dialog box 

Power-user shortcut for creating a new Song and Instruments from selected Samples.

The Make Song Using command always produces one Song that triggers all the selected Sam
and always produces one or more Instruments to link the new Song to the Samples. Howev
more than one Sample selected, you have a few choices as to how the Instruments get cre

Instruments can be complicated, and creating them from scratch can be tedious. For simple
ments, the Make Song dialog box automates the worst of this work: creating new Instruments
setting up their Keymaps.

Note: Complicated or advanced Instruments will require further work in the Instrument Edi-
tor window.

Topics:
About the Make Song Using command
About the Created Song
Creating a Single Instrument from Multiple Samples
Creating Multiple Instruments, Each with a Single Sample

About the Make Song Using command
The Make Song Using command creates a new, simple Song and one or more new, simple In
ments that use the selected Samples. This is the same as the effect that would be produce
doing a Make Instrument Using followed by a Make Song Using with the new Instruments 
selected. However, the command behaves differently depending on how many Samples yo
selected:

• With just a single Sample selected, the Beatnik Editor will go ahead and build you a new 
Instrument using that Sample for all 128 MIDI notes, and a Song that triggers that Instru
without displaying any dialog box.

• With more than one Sample selected, the Beatnik Editor will still automatically create a So
to trigger the Samples, but it displays the Make Song dialog box with additional options for 
how to lay out the Samples into one or more new Instruments. You might want to create
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one Instrument using all the selected Samples, or you might want each Sample to go in
separate Instrument of its own.

About the Created Song
The new Song will trigger every selected Sample. This may or may not meet your needs as
to trigger the Samples in your final production, however it may at least make it easy to aud
the Instruments and Samples as you’re working in the Beatnik Editor.

The Song will contain one MIDI file Track for each created Instrument, and each Instrumen
Track will contain one MIDI note for each Keymap Zone used in the Instrument. These note
be same as the Keymap Zones’ Root Keys, so the Samples will usually play at their natura
pitches. All of the notes will begin at the same time, and will be the same length.

For example, if you select one Instrument using a single Keymap Zone, and a second Instr
that uses three Keymap Zones, the Make Song Using command will produce a Song with two 
tracks: Track 1 will contain one note (the Root Key of the one Keymap Zone), and Track 2 
contain three notes (the Root Keys for the three Keymap Zones).
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Creating a Single Instrument from Multiple Samples

Note: If you have more than 128 Samples selected, only the first 128 will be used.

To create one new Instrument using all of your selected Samples, and a one-track MIDI So
trigger all the Samples in that Instrument:

1. Click the Combine Samples Into One Instrument (One Track Song) radio button (1).

This option will create one Keymap Zone per Sample. You have two options for how th
Keymap Zones will be placed on the keyboard.

2. Pick one of the Keymap layout options by selecting radio button 2 or 3:

3. If you selected One per key, starting at:, then click the ... button (4) to pick the starting note.

The Select Note dialog box will appear, with a keyboard you can click to pick your note

4. Click the OK button to accept your settings and close the dialog box.

The newly created Instrument will appear in the Instruments tab of your Session wind
with the name New Instrument, and the newly created Song will appear in the Songs tab

Option... Produces Keymap Layout...

2 Split into equal 
zones

All 127 keys will be covered, with an equal number of MIDI 
key numbers in each zone.

This allows the Samples to be transposed by playing different 
notes, as in most multi-sampled musical instruments.

3 One per key, starting 
at:

Each selected Sample will be assigned to one MIDI key num-
ber, beginning with a key that you can specify and moving up 
the keyboard. No other MIDI keys will be covered.

This prevents the Samples from being transposed, for exam-
ple percussion, singing, spoken word, or music recordings.

1
2
3 4
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Creating Multiple Instruments, Each with a Single Sample

New in version 2.1: This dialog now includes a checkbox option for the Specify Root Key 
value. This allows you to preserve the Samples' original Root Keys in the newly create
Instruments, if desired.

The Separate into Multiple Instruments option creates one new Instrument for each selected S
ple. For example, with five Samples selected, you’d get five new Instruments. All created In
ments will use the same Root Key, which you can pick. If you want to assign a different Root Key 
to any of the created Instruments, you’ll need to open them in the Instrument Editor window.

Note: If you have more than 15 Samples selected, only the first 15 will produce new In
ments and be used in the created Song. This is because MIDI channel 10 is reserved
cussion, leaving only 15 available MIDI channels for triggering the Instruments.

To create one new Instrument for each of your selected Samples, and a multi-track MIDI S
trigger all the Samples in that Instrument:

1. Click the Separate Into Multiple Instruments (Multi-Track Song) radio button (1).

This option will create one new Instrument per Sample.

2. Click the ... button to pick the Root Key (2).

The Select Note dialog box will appear, with a keyboard you can click to pick your note. 
of the new Instruments will share this same Root Key.

3. Click the OK button to accept your settings and close the dialog box.

The newly created Instruments will appear in the Instruments tab of your Session window, 
and the newly created Song will appear in the Songs tab.

1
2
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Clear compression cache dialog box

Deletes unneeded temporary compressed audio files from the Beatnik Editor’s disk 
cache.

Every time you preview a new compression setting for any Sample, a new compressed copy
Sample is generated and saved in a temporary cache folder on your hard drive. If this proce
on long enough, it can eat up more of your free disk space than you might like. Clearing th
pression cache recovers this free space.

Two things to remember:

• Clearing the cache is safe
The original, uncompressed Samples stay in your Session document and aren’t affec
any way.

• Even if you never clear the cache, it won’t hurt your RMF files in any way
The cache doesn’t affect the size of your exported RMF files in any way.

Note: To remove your original, uncompressed Samples rather than the extra compress
copies, see the Delete uncompressed originals dialog box.
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Delete uncompressed originals dialog box

Deletes the original, uncompressed versions of all compressed Samples in your Session 
document. This means committing to your current Compression settings.

Uncompressed Samples can be very large. Once you’ve settled on a compression type for
your Samples, you can use this command to shrink the size of your Session file by deleting
original, uncompressed version of all Samples for which you’ve selected a Compression ty

Note: Beatnik recommends extreme care when using this command. If you delete your 
only copies of the uncompressed Samples, and then later decide to change the comp
technique, you’ll have to first decompress the compressed copies, and then re-compr
them. With most compression techniques, this will result in a significant loss of fidelity

Two things to remember:

• If you can afford the disk space, you should always keep your uncompressed original Sam-
ples in your Session document.

Retaining the uncompressed originals preserves flexibility in the future, and once the 
nals are gone there’s no way to recover the lost fidelity.

• The sizes of the uncompressed originals don’t affect the size of your exported RMF files
any way.

Shrinking the Session file by deleting the large original Samples won’t make your RMF
any smaller.
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Window Menu windows
How to use the windows accessed from the Window menu.

Topics:
Player window
JavaScript window
Session windows
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Player window

Playback controls, a Keyboard for auditioning Instrument, and Synthesizer status dis-
plays.

Note: If channel 1’s Mute button is pressed, it’ll prevent The Onscreen Keyboard from play-
ing.

Notes for Live MIDI input users: 

• If a MIDI channel’s Mute button is on, then live MIDI notes arriving on that 
channel won’t be heard. The channel Solo buttons also affect Live MIDI Input.

• When you select a new Instrument in a Session window, the Instrument name will 
appear immediately in the Keyboard Instrument display; however, the Instrument 
will not be activated until you click a note on the onscreen keyboard. As a result, 
any Live MIDI Input notes received on channel 1 during that interval will sound 
with the previous channel 1 Instrument.

Topics:
1 Volume Control
2 Transport Controls (Play, Stop, Loop)
3 Song and Instrument Info
4 Editor Play Settings
5 Output Meter
6 MIDI Channels Display and Mute & Solo Buttons
7 CPU & Voice Meters
8 The Onscreen Keyboard

4

2

81

3

5 66 7
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Volume Control
An overall output volume control for the Beatnik Audio Engine at the heart of the Beatnik E

Note: Don’t make any volume balancing decisions in the Beatnik Editor based on audi
playing from another application – even the digital audio tracks of a MIDI sequencer dr
the Beatnik Editor’s Live MIDI Input – because different applications may operate at diffe
ent loudness levels. For precise mixing, and to make sure your RMF files will repeat y
mix correctly when it’s played, place volume controller events (MIDI Continuous Contro
number 7 for each MIDI channel) in the event list for each Track in your MIDI file.

Transport Controls (Play, Stop, Loop)
Controls that act like a CD player’s Play, Stop, and Loop buttons – except that they apply to
selected Song, not a CD.

New in version 2.1: The Song Position Dial behavior has been changed. Clicking a pos
on the dial now makes the current Song start playing from that position.

Item Use

Volume Control Sets your listening level.

Note: This volume control is dependent on your com-
puter’s hardware and software volume controls. If thos
other volume controls are turned all the way off, you 
won’t hear any of the sound the Beatnik Editor is gene
ating. See Troubleshooting.

Item Use

Play Button Click to start the selected Song.

When a Song is playing, you can ‘scrub’ back and forth
with the round Playback Position indicator.

Stop Button Click to stop playback.

Loop Button Click to make the Song repeat continuously when played – 
every time it reaches its end, it’ll start over from the begin-
ning. To turn looping off, click again.
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Song and Instrument Info
Information about the selected Song and its playback state.

Item Use

Song Title Title of the selected Song.

Time Display The current playback position, in minutes and seconds. This
resets to zero whenever the Song restarts or loops.

When the Loop button is on, a loop icon also appears to 
the left of the time display. 

Tempo and Length Display The selected Song’s playback speed in Beats Per Minute 
(BPM), and overall length in minutes and seconds.

New in version 2.1: The Tempo Display is now updated con-
tinuously.

Playback Position Display Draws a circle as the Song plays from beginning to end – 
when the circle completes, the Song is over.

Note: You can ‘scrub’ the Song back and forth by drag-
ging the triangle.

Keyboard Instrument Display Name of the currently selected Instrument for MIDI channel
1. Notes played on The Onscreen Keyboard always use this 
Instrument, because it always plays channel 1.
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Editor Play Settings
These controls let you listen to your music and sound material under the same conditions t
your playback environment will use – the Beatnik MIDI Synthesizer’s sample rate, bit depth
number of channels (mono or stereo), and reverb type. These settings affect all audio gener
the Beatnik Editor – playback of the current Song, notes played on The Onscreen Keyboard, notes 
arriving over the Live MIDI Input, and digital audio files generated with the Export as Audio... 
command.

Note: The settings you make here are not saved in your RMF files. These are playback se
tings only, and used only while working in the Beatnik Editor.

Output Meter
A graph of the actual sound being generated by the Beatnik MIDI Synthesizer.

Item Use

Bits and Channels control Sets the playback bit depth, and whether the Beatnik MIDI 
Synthesizer runs in mono or stereo. Stereo sounds better th
mono, and 16-bit sounds better than 8-bit. Options are:

8-bit mono
16-bit mono
8-bit stereo
16-bit stereo – for Beatnik Player for Web browsers

Sample Rate control Determines the Beatnik MIDI Synthesizer’s playback sample
rate. Higher sample rates sound better. Available sample rat

11 kHz
22 kHz – for Beatnik Player for Web browsers
44 kHz

Reverb Type control Selects which of the available reverb types to use. Each reve
type has a different character; for descriptions, see Effects: 
Reverb and Chorus.

Note: Changing the reverb type here doesn’t affect the 
reverb type stored in each Song and RMF file – see th
Song Settings dialog box for details.

Note: Four of the Beatnik reverb types depend on the 
Beatnik Audio Engine’s stereo mode, and so will not be
available when the Beatnik Editor is running in mono: 
Early Reflections, Basement, Banquet Hall, Catacomb

Item Use

Output Meter The waveform displayed is similar to what would be shown 
on an oscilloscope connected to your computer’s audio out-
put, updated 24 times per second.
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MIDI Channels Display and Mute & Solo Buttons
Display of note activity for each of the 16 MIDI channels, and buttons to Mute (silence) and Solo 
(highlight) the channels independently, like you’d find on a sound mixing board. Recall that
Beatnik MIDI Synthesizer is organized as 16 MIDI Channels, each of which can independe
play several notes at once using a given Instrument.

New in version 2.1: The Mute and Solo button behavior has been changed:

• To change multiple buttons at once, click on one button and then drag across the 
rest of the desired buttons.

• To turn all 16 Mute buttons on or off at once, click the word Mute.

• To turn all 16 Solo buttons on or off at once, click the word Solo.

Note: The Mute and Solo buttons control the triggering of MIDI notes on the indicated 
MIDI channel – not the channel’s audio output. As a result, when you turn a Mute butto
the channel’s sound will not return immediately – only when the next MIDI note occurs
that channel. In some cases this lag can be fairly long, for example in pieces using slo
pos or long notes. The lag may be especially noticeable if you’re using music pre-mix
ples (such as beat loops) which won’t retrigger until the MIDI file loops.

Item Use

MIDI Channels Display Shows the number of notes currently playing on each of the
16 MIDI channels, updated 24 times per second. This 
includes all playing Songs, Live MIDI Input, and notes played 
on The Onscreen Keyboard.

Note: If a channel’s Mute button is pressed, you won’t 
see (or hear) any note activity on that channel. The Solo 
buttons may also prevent notes from sounding.

MIDI Channel Mute Buttons Each MIDI channel has a Mute button. Muting a channel pre-
vents it from playing notes. You can mute any number of 
channels at the same time.

Note: The Mute buttons affect all notes on the indicated
MIDI channel, irrespective of source: Song playback, 
Live MIDI Input, and The Onscreen Keyboard.

Note: If channel 1’s Mute button is pressed, it’ll prevent 
The Onscreen Keyboard from playing.

MIDI Channel Solo Buttons Each MIDI channel also has a Solo button. Soloing a channel 
prevents all other channels from playing notes, so that only 
the soloed channel is audible. You can solo any number of 
channels at the same time.

Note: The Solo buttons affect all notes on the indicated 
MIDI channel, irrespective of source: Song playback, 
Live MIDI Input, and The Onscreen Keyboard.

Note: Mute overrides solo – that is, even if you solo a 
muted channel, it won’t resume playing new notes
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 231

r) 
-

 

e-

e 
CPU & Voice Meters
This section shows overall activity of the Beatnik MIDI Synthesizer, in terms of CPU Load and 
total number of active Voices.

Item Use

CPU Load Meter Shows roughly what percentage of your computer’s CPU 
(Central Processing Unit, also known as the microprocesso
is being used, updated 24 times per second. If no other pro
grams are running on your computer at the same time, this 
will give you a pretty good idea how CPU-intensive it is to 
play a given Song on a computer with a similarly powerful 
processor.

The red line indicates the highest peak so far. To clear this 
peak indicator, click on the meter.

Note: For a more accurate measurement, point at the 
CPU Load meter and select Intensive Calc from the 
context menu. 

To access the context menu: for Windows, right-
click; for Mac OS, control-click.

Note: Playing the same Song on a less powerful 
machine will take a higher percentage of the CPU.

Note: In addition to the number of voices being played,
the Editor Play Settings directly affect the CPU Load 
figure – that is, the reverb setting, choice of mono or st
reo, the sample rate and the bit depth.

Voices Meter Shows how many of the Beatnik MIDI Synthesizer’s 64 
voices are being used, updated 24 times per second.

The red line indicates the highest peak so far. To clear this 
peak indicator, click on the meter.

Note: The Voices meter may disagree with the number 
of lit-up keys on the onscreen Keyboard. That’s becaus
the keys lights up only during the Note On portion of a 
note, but the note will occupy its voice until its volume 
envelope fades to complete silence. If the Instrument 
has a long release time, that can take a while.
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About Voice Availability
The Beatnik Audio Engine’s 64 voices are organized as three separate pools:

• 56 voices are available to play notes for Songs, incoming Live MIDI Input, and The Onscreen 
Keyboard. This 56-voice limit is also present in the Beatnik Player for Web Browsers.

• 1 voice is reserved for auditioning Samples.

• The remaining 7 voices are reserved for playing sound effects.

The Onscreen Keyboard
The onscreen Keyboard displays MIDI note events as lit-up keys, and you can click on the 
board to play notes on MIDI channel 1 (as you’ll need to do when selecting or editing Instru
ments).

Note: If channel 1’s Mute button is pressed, it’ll prevent The Onscreen Keyboard from play-
ing.

Note: If you have a MIDI keyboard and your computer has a hardware MIDI interface 
installed, you may prefer to play notes on your own keyboard rather than pecking out 
cal lines one note at a time on the onscreen Keyboard; see Live MIDI Input.

Note: The Beatnik Editor uses three different keyboard displays, for three different pur
poses:

Keyboard appearing in… Is for…

Player window Playing notes, and show-
ing what MIDI notes are 
playing

Keymap tab of the Instrument Editor Displaying and editing 
an Instrument’s Keymap 
Zones

Select Note dialog box Selecting a MIDI note 
number for use as a set-
ting parameter
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Playing Notes on the Onscreen Keyboard
To play a note using the onscreen Keyboard, just click on the key you want to play. To hold a
hold the mouse button down after you click the key. 

You also have control over the notes’ Instrument and velocity, and a simulated Sustain ped

• Instrument – The notes you play on the onscreen Keyboard always use the currently sele
Instrument. To play a particular Instrument, go to the Instruments tab of your Session window
and select the Instrument. The onscreen Keyboard will continue to use that same Instru
even when the Instruments tab isn’t visible.

• Velocity – You can also control the velocity of each note you play on the onscreen keybo
In many Instruments, velocity is linked to brightness, volume, or intensity, giving the Ins
ment a more dynamic character. Clicking at the top of a key produces a lower velocity; 
ing at the bottom of the key produces the maximum velocity (127); and clicking anywhe
between the extremes produces a proportionate velocity.

• Sustain – The Shift key on your computer keyboard acts as the onscreen Keyboard’s sus
pedal. For example, if you press and hold the Shift key, then click three different notes on th
onscreen Keyboard, you’ll notice that the notes sustain until you release the Shift key and then 
click on another note.

Click Here for Low Velocity

Click Here for HIgh Velocity
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JavaScript window

Echoes your actions in JavaScript source code – for cut-and-pasting into Web page code 
– as a convenience for Web page authors.

Note: Musicians and sound designers not involved in Web page coding details probab
won’t need to use the JavaScript window.

Every time you take any action in the Beatnik Editor that can also be done in a Web page J
cript program with Beatnik’s Music Object programming interface, the equivalent JavaScrip
source code is added to the JavaScript window. You can copy this source code from the JavaS-
cript window, and then paste it into your Web page source code using a text editor. The Java
window will accumulate all your actions up to a maximum of 32,768 characters of code, at w
point the oldest entries will begin to ‘scroll off the top’ and disappear.

Note: When a Percussion Bank instrument is selected in a Session document window
ing notes on the Player window keyboard produces playNote()  commands in the JavaS-
cript window with program numbers over 127. While program numbers over 127 would
be valid in a MIDI sequence, and could not be sent over a MIDI wire, in Beatnik’s Mus
Object programming interface for the Beatnk Player (for Web browsers) or for the Bea
Xtra (for Director and Shockwave) they select Percussion Bank instruments. For exam
program 128 selects Percussion Instrument 0, program 129 selects Percussion Instru
and so on, up to program 255 which selects Percussion Instrument 127.

Item Use

1 Source Code Area JavaScript source code appears here as text that you can c
or cut to the clipboard. To copy or cut, use the Edit menu com-
mands, the Copy button (2), or the context menu commands.

To access the context menu: for Windows, right-click; 
for Mac OS, control-click.

2 Copy button Click to copy the selected JavaScript source code text to the
clipboard. If nothing’s selected, copies all source code text i
the JavaScript window.

3 Clear button Click to clear all source code text in the JavaScript window.

1

2

3
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About JavaScript Source Code
Every entry in the JavaScript window consists of two lines: first a JavaScript comment identif
ing the meaning and value range of any function parameters, and then the actual source c
Music Object function call with its parameters filled in to reflect your most recent action tak

For example, if you go to a Session window and select Custom Instrument number 7, the JavaS-
cript window will emit the following JavaScript code:

// setProgram( MidiChannel0to16, BankNumber0to2, ProgramNumber0to127 )
player.setProgram( 1, 2, 7 )

Note: Getting Beatnik interactive audio working in a Web page involves a good deal m
than just pasting these lines into a JavaScript file. At a minimum, you’ll also need to ch
the word player  to match the name of your Music Object instance; typically a lot more
work than that will be required. You’ll certainly need a good general understanding of 
Beatnik Music Object interface – be sure to read the Web Authoring Documentation on the 
Beatnik Web site before you start writing JavaScript to control the Beatnik Player:

 http://www.beatnik.com/to/?music-object-doc
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Session windows 

Each Session window represents one Beatnik Editor Session file – a holder for the 
Songs, Instruments, and Samples you intend to use in the RMF files you’ll make.

Tip: When you first create a new Session file, it may look empty. To the contrary, every
sion file includes a large collection of built-in Beatnik Songs, Samples, and Instrumen
it’s just that they’re temporarily hidden. See Within Each Tab, ‘Show:’ Displays a Category of 
Items, below.

Topics:
Basic Operation
The Songs Tab
The Instruments Tab
The Samples Tab
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Basic Operation
A Session is a workspace where you build Custom Instruments, audition imported Songs, 
manipulate imported Samples. For easy importing, you can drag audio and MIDI files from
desktop directly into any Session window. To show more or fewer items, you can resize the
dow.

New in version 2.1: New Get Resource Usage command in the context menu displays the
selected Song, Instrument, or Sample's total size in bytes.

The displayed size includes all dependent objects. For an Instrument, this will be
Instrument resource plus all Samples used in the Instrument. For a Song, the siz
include all Instruments it uses, plus all the Samples used by those Instruments.

Subtopics:
Working with Multiple Sessions
Tabs for Songs, Instruments, and Samples
Within Each Tab, ‘Show:’ Displays a Category of Items
Working with Listed Items

Working with Multiple Sessions
You can keep multiple Session documents open if you want to. With more than one Sessio
dow open, you can freely drag, copy, and paste Songs, Instruments, and Samples between
dows.

Each Session will have its own separate Undo history, so the Undo and Redo commands always 
apply just to the Session you’re in at the time. Also, the onscreen keyboard in the Player window 
always only uses Instruments from the Session you’re in at the time (that’s why keyboard p
back may pause momentarily when you move between open Sessions). 
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Tabs for Songs, Instruments, and Samples
The Session document window organizes your music and sound resources under three tab
the tabs on file folders: a Songs tab, an Instruments tab, and a Samples tab. These tabs select 
which kind of resource will appear in the list beneath – to see what’s inside any tab, just cli
it:

Within Each Tab, ‘Show:’ Displays a Category of Items
To help you focus on the right things at the right times, all three tabs include a Show: pop-up 
menu that controls what categories of items appear in the list – for example, in the Samples tab 

Songs Instruments Samples
Document Version 2.1.0 © 1998–2001 Beatnik, Inc.



Beatnik Editor User’s Guide / 239

ss to the 
very 

. 
, Cus-
you can view just Custom Samples, just Built-In Samples, or All Samples:

Besides your own music and sound elements, every Session document also gives you acce
music and sound resources in the built-in Beatnik Bank – the same resources available in e
Beatnik Player for Web browsers.

By default, the Show: menu focuses on the categories containing the content you’ve created
That’s why a Session looks empty when you first create it – there aren’t any Custom Songs
tom Instruments, or Custom Samples yet.

Here’s the full list of Show: item categories for each tab:

* Built-In resources

Custom Samples Built-In Samples All Samples
(Custom + Built-In)

Songs tab Instruments tab Samples tab

All
Custom Songs
Groovoids*
Imported RMF

Bank 0 Melodic - General MIDI*
Bank 0 Percussion - General MIDI*
Bank 1 Melodic - Beatnik Special*
Bank 1 Percussion - Beatnik Special*
Bank 2 Melodic - Custom Melodic
Bank 2 Percussion - Custom Percussion
See also: Instrument Bank Organization.

All
Custom Samples
Built-in Samples*
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Working with Listed Items
You can rename, copy, paste, and delete items in any Session window, and apply comman
selected items.

Note: There are a few restrictions on working with Built-In items. None of the Built-In ite
can be modified, and Groovoids and Built-in Samples can’t be copied. However, you c
copy Built-In Instruments and use them as a basis for your own Instrument designs.

To Select items:
• To select a single item, just click on it.

• To select multiple items, shift-click on them.

• To add single items to the selection, or to remove them, use control-click (for 
Windows) or cmd-click (for Mac OS). 

To Rename an item:
• Mac OS: Click the item name, then when the name box appears, type a new 

name.

• Windows: Click the name to select it, then click again and let the mouse hover 
there for a moment. When the name box appears, type a new name.

• Or select the item, and then select the Rename command from the Edit menu or 
the context menu.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

To Copy one or more items:
• Select the items, and then select the Copy command from the Edit menu or the 

context menu.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

• Or select the items, and then type control-C (for Windows) or cmd-C (for Mac 
OS).

To Delete one or more item:
• Select the items, and then select the Delete command from the Edit menu or the 

context menu.
To access the context menu: for Windows, right-click; for Mac OS, control-
click.

• Or select the items, and then type the Delete key.

To apply any other command to one or more items: 
1. Select the items.

2.  Select a menu command.

Commands are available in the application menus and the context menu. The availab
mands depend on the items you’ve selected; for example, Sample menu commands a
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available when Sample items are selected.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

See also: Commands in Song menu, Instrument menu, and Sample menu.
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The Songs Tab
Displays the Songs in the current Session, in alphanumeric order.

The Show: pop-up menu controls what kinds of Songs will appear:

Working with Songs
• To play a Song, double-click it.

The Song name and tempo will appear in the Player window, and the Stop and Play button
will control playback of the Song.

• To edit Song Info for a Custom Song, select it and choose an editing command from the Songs 
menu.

Note: The Song Info for Groovoids and Imported RMF Songs can’t be edited.

Show: Displays

All All Songs. This means all three categories below.

Custom Songs (default) Songs that you (or other Beatnik users) create.

Note: In a newly created Session, this cate-
gory will be empty.

Groovoids Built-in Songs supplied by Beatnik – typically, short 
music or sound effects sequences intended for quick and 
easy Web site sonification.

Groovoids can’t be edited.

Imported RMF RMF files that you’ve imported into the Session for 
playback.

Imported RMF Songs can’t be edited.
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• To rename a Custom Song, use your operating system’s standard mouse technique.

Windows: Slow double-click.
Mac OS: Click and wait.

Note: Groovoids and Imported RMF Songs can’t be renamed.
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The Instruments Tab 
Displays the Instruments in the current Session, in numeric order. 

New in version 2.1: New Show Empty Instrument Slots command in the context menu turn
display of empty slots on and off.

The Show: pop-up menu controls what kinds of Instruments will appear:

Show: Displays

Bank 0 Melodic - General MIDI Melodic instruments and effects conforming to the Gen-
eral MIDI standard.

Bank 0 Percussion - General MIDI Percussion instruments and effects conforming to the 
General MIDI standard.

Bank 1 Melodic - Beatnik Special Beatnik extensions to the General MIDI melodic instru-
ments.

Bank 1 Percussion - Beatnik Special Beatnik extensions to the General MIDI percussion 
instruments.

Bank 2 Melodic - Custom Melodic
(default)

Melodic Instruments that you (or other Beatnik users) 
create.

Note: In a newly created Session, this cate-
gory will be empty.

Bank 2 Percussion - Custom Percus-
sion

Percussion Instruments that you (or other Beatnik users
create.

Note: In a newly created Session, this cate-
gory will be empty.
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Working with Instruments
• To apply a command from the Instrument menu or context menu to an Instrument, select th

Instrument and give the command.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

Note: Some Instrument commands are only available for Custom Instruments.

• To edit a Custom Instrument using the Instrument Editor window, double-click the Instru-
ment.

Note: General MIDI and Beatnik Special Instruments are Built-In, and so can’t be edite

• To rename a Custom Instrument, use your operating system’s standard mouse techniqu

Windows: Slow double-click.
Mac OS: Click and wait.

Note: General MIDI and Beatnik Special Instruments are Built-In, and so can’t be rena

Note: When you copy a Custom Instrument, a dialog box appears, offering the option of als
copying the Samples used in that Instrument.
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The Samples Tab 
Displays the Samples in the current Session, in alphanumeric order. 

The Show: pop-up menu controls what kinds of Samples will appear:

Working with Samples
• To apply a command from the Sample menu or context menu to a Sample, select the Samp

and give the command.

To access the context menu: for Windows, right-click; for Mac OS, control-click.

Note: Some Sample commands are only available for Custom Samples.

• To edit a Custom Sample using the Sample Editor window, double-click the Sample.

Note: The Built-In Samples can’t be edited.

• To rename a Custom Sample, use your operating system’s standard mouse technique.

Windows: Slow double-click.

Show: Displays

All All Samples. This means both categories below.

Custom Samples (default) Samples that you (or other Beatnik users) create, 
imported from sound files created in other applications.

Note: In a newly created Session, this cate-
gory will be empty.

Built-in Samples Beatnik’s built-in Samples.

Built-in Samples can’t be edited.
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Mac OS: Click and wait.

Note: The Built-In Samples can’t be renamed.
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Help Menu windows
How to use the Windows accessed from the Help menu.

Topics:
Help Contents dialog box
About Beatnik Editor dialog box
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Help Contents dialog box

Opens the Online Help’s Table of Contents.

Note: The Online Help system requires the use of your Web browser – either Microsof
Internet Explorer, or Netscape Navigator or Communicator. For minimum versions, seSys-
tem Requirements.

Note for Windows Users: To open the Help Contents dialog box at any time, press the F1 
key.

The Beatnik Editor’s Online documentation system uses your preferred Web browser to dis
both context-sensitive Help for every window and dialog box, and the HTML version of this
User’s Guide. Selecting the Help Contents menu item opens the User’s Guide to the Introductio
page.
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About Beatnik Editor dialog box

Contains the program version and legal notices, and handles Registration.

Note: When first installed, the freely distributable Beatnik Editor is fully functional – exc
that the File menu commands Open, Save, Save As..., Export RMF... and Export as Audio are 
disabled. These features – which are essential for using the Beatnik Editor in professi
Web and multimedia development – are reserved for users who purchase a Registrati

The About Beatnik Editor dialog box includes the software version number, legal notices, and
registration status of your copy of the software:

• If you’ve already registered your copy of the Beatnik Editor, the About Beatnik Editor dialog 
box includes your name, email address, and serial number.

• If your copy of the Beatnik Editor hasn’t been registered yet, the About Beatnik Editor dialog 
box notes that the program is Unregistered, and includes a Register button.

Registering the Beatnk Editor
To register your copy of the Beatnik Editor:

1. Using your Web browser, purchase a Registration Key from the Beatnik Web site:

http://www.beatnik.com/to?editor
Follow the instructions on the Web page, and you will receive a Registration Key – a 
sequence of numbers, letters, and dashes that looks something like this:

TX6F-H3RRTF8-Q32U-X9M2D
2. Launch your installed copy of the Beatnik Editor.

A new Untitled Session document window appears.

3. Open the About Beatnik Editor dialog box. This step depends on your operating system:

• On Windows, go to the Help menu and select About Beatnik Editor.
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• On Mac OS, go to the Apple menu and select About Beatnik Editor.
4. In the About Beatnik Editor dialog box, click the Register button.

The Registration dialog box appears.

5. In the Registration dialog box, enter your User Name, Email Address, and Registration Key.

Be sure to enter exactly the same User Name and Email Address that you used when pur-
chasing the Registration Key, and type the exact Registration Key you received. If even one 
letter is different, the program will not register successfully.

6. Click the OK button.

If the Beatnik Editor detects a problem with your information, it will ask you to re-chec
your entries. Otherwise, your copy will be registered and the Export RMF... and Export as 
Audio... commands will be enabled.

If you run into difficulty registering the Beatnik Editor, then contact Customer Support via th
Beatnik Web site:

http://www.beatnik.com/?editor-support
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Troubleshooting

How to diagnose and repair any problems you may encounter while using the Beatnik 
Editor.

Mac OS Users: Netscape is default browser, but the Beatnik Editor’s Online Help uses Microsoft 
Internet Explorer 

This can happen because most of the Mac OS ‘default browser’ settings apply only to
http: protocol, whereas the Online Help system uses the file: protocol.

To set Netscape as your default browser for the file: protocol:

1. From the Apple menu, launch the Internet Control Panel. The Control Panel will open a dia
log box.

2. If you don’t see an Advanced tab next to the News tab, turn Advanced Mode on.

Go to the Edit menu and select the User Mode... command. Then, in the dialog box that 
appears, select Advanced and click the OK button.

3. Click on the Advanced tab, and then click the Helper Apps icon.

4. Scroll the list of handlers down until you come to a line containing file in the Type column, 
then select that line. It should show Microsoft Internet Explorer as the current file hand

5. Set your preferred browser as the handler for the file type.

Click the Change... button, then click the Select... button. In the navigation dialog box that
appears, locate the browser that you want to use to read the Beatnik Editor Online Hel
click the OK button.

6. Close the Internet control panel.

Mac OS Users: Your MIDI or Digital Audio file doesn’t appear in the Import dialog box

On Mac OS, the Beatnik Editor won’t recognize files with bad – that is, missing or 
incorrect – type and creator codes if the filenames don’t end in a recognized exten-
sion. Change the filename to end in  .wav, .aif, .aiff, .au, .mp3, .mid, .smf, .midi, .rmi, 
or .rmf as appropriate.

Mac OS Users: Make sure you’re using Sound Manager 3.1 or later

Earlier versions of Sound Manager are not compatible with the Beatnik Editor.

Mac OS Users: Turn off RAM Doubler and Virtual Memory

The RAM Doubler utility and the Mac OS Virtual Memory feature can interfere with the
Beatnik Editor’s timing and operation, degrading the audio output and risking crashes
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If a sample won’t loop...

Is the loop start point set to 0? All Beatnik playback software treats a sample start 
point of 0 as an order to not loop the Sample. Open the Sample in the Sample Editor 
and change the loop start to 1.

Mac OS Users: If you’re using OMS...

Make sure you are using version 2.1 or greater.
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Removing the Beatnik Editor

How to remove or ‘uninstall’ the Beatnik Editor, in case you should ever need to.

The steps needed to remove the Beatnik Editor depend on your operating system:

Removing Under Windows
Removing Under Mac OS

Removing Under Windows
The Beatnik Editor follows the standard Windows program removal procedure. You have two 
choices.

Either:
• Go to the Start Menu and select Programs -> Beatnik Editor -> Remove Beatnik Editor

or:
• In Control Panel, use the Add/Remove Programs icon as detailed below:

1. On the Windows desktop, double-click the My Computer icon to open it.

The My Computer window will appear, with a folder icon labelled Control Panel.

2. Double-click the Control Panel icon to open it.

The Control Panel window will appear, with an icon labelled Add/Remove Programs.

3. Double-click the Add/Remove Programs icon to open its Properties dialog box.

4. In the Add/Remove Programs Properties dialog box, select Beatnik Editor from the scrolling 
list of installed programs.

5. Click the Add/Remove... button (Windows 95/98/NT) or Change/Remove... button (Windows 
2000) to remove the Beatnik Editor from your computer.

Removing Under Mac OS
1. Throw away the Beatnik Editor application folder, called Beatnik Editor.

If you aren’t sure where this folder is, go to the Apple menu and select a search utility such 
as Sherlock or Find File.

2. Throw away the Beatnik Editor preferences file.

This file is called Beatnik Editor Prefs, and it’s located in the Preferences folder (which is 
inside the System Folder of your startup drive).
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Compatibility Info

Covers the Beatnik Editor’s compatibility with various music and sound standards.

Topics:
Supported File Formats

MIDI Implementation Chart
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Supported File Formats
The Beatnik Editor can import music and sound data saved in the following file formats:

File Format Supported Subtypes Filename 
Extension

RMF
Beatnik's Rich Music Format
(musical notes and/or digital 
audio)

all .rmf

MIDI
Standard MIDI* File (SMF)
(musical notes)

all .mid, .midi

WAV
Windows WAV format
(digital audio)

u-law, stereo
A-law, mono
A-law, stereo
IMA ADPCM 8kHz, 4-bit, mono
IMA ADPCM 8kHz, 4-bit, stereo
IMA ADPCM 11kHz, 4-bit, mono
IMA ADPCM 11kHz, 4-bit, stereo
IMA ADPCM 22kHz, 4-bit, mono
IMA ADPCM 22kHz, 4-bit, stereo
IMA ADPCM 44kHz, 4-bit, mono
IMA ADPCM 44kHz, 4-bit, stereo

.wav

AIFF
Audio Interchange File Format
(digital audio)

8-bit, mono, signed
8-bit, stereo, signed
16-bit, mono, signed, byte-swapped
16-bit, stereo, signed, byte-swapped

.aif, .aiff

MP3
MPEG I Layer 3
(digital audio)

.mp3

SDII
Digidesign Sound Designer II
(digital audio)

.sd2

AU
Sun Audio
(digital audio)

8-bit, mono, signed
8-bit, stereo, signed
u-law, mono
u-law, stereo
A-law, mono
A-law, stereo
Java/Web, mono

.au
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MIDI Implementation Chart
Model: Beatnik PlatformDate: April 2, 2000
Software Wavetable SynthesizerVersion: BAE 1.5.2

Function Transmitted Recognized Remarks
Basic
Channel

Default x 1 - 16
Changed x 1 - 16

Mode Default x Mode 3 Can’t change
Messages x x
Altered ***********

Note
Number

x 0-127
True Voice *********** 0-127

Velocity Note on x O
Note off x x

After Touch Key x x
Channels x x

Pitch Bend Pitch Bend x *1, *2 Resolution 12 bit
Change
Control

0 x *1, *2 Bank Select (MSB Only)
1 x *1, *2 Modulation
6 x *1, *2 Data Entry
7 x *1, *2 Volume
10 x *1, *2 Panpot
11 x *1, *2 Expression
64 x *1, *2 Hold1 (Sustain)
85, 86, 87 x *1, *2 Beatnik Loop & Mute (files 

only)
90 x *1, *2 Master Reverb Type
91 x *1, *2 Reverb depth

(>15 = on for reverb types 1–7)
93 x *1, *2 Chorus Send
98, 99 x *1, *2 NRPN (LSB, MSB)
100, 101 x *1, *2 RPN (LSB, MSB) – Reserved
121 x *1, *2 Reset All Controllers
123 x O All Notes Off

Program
Change

x *1
True Number *********** 0-127

System
Exclusive

x x

System
Common

Song Position x x
Song Select x x
Tune Request x x

System
Real Time

Clock x x
Commands x x

Aux.
Messages

Local On/Off x x
All Notes Off x O (123)
Active Sensing x x
System Reset x x

Notes *1 O x can be selectable           O : Yes   x : No
*2 See For Musicians for details on Beatnik's response to Controllers. 

Mode 1: OMNI ON, POLY Mode 2: OMNI ON, MONO Mode 3: OMNI OFF, POLY Mode 4: OMNI OFF, MONO 
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Versions and Updates

The Beatnik Editor’s Version History, and how to get the latest update.

This User’s Guide describes version 2.1 of the Beatnik Editor, which was released in June 
2001. For full details of the changes introduced at each release, see the Version History section 
below.

Got the Latest?
If you’re reading this much later than June, 2001, and you think it might be time for an upda

1. First, check your Beatnik Editor version. You should be using version 2.1 or higher. 

2. Then, visit the Beatnik Editor Web site to check for any newer version:

http://www.beatnik.com/to/?editor

Determining Which Version You Have
To check your Beatnik Editor version number, launch the program and check the About Beatnik 
Editor dialog box. 

Here’s how:

If you’re on... Then do this...

Windows Go to the Help menu and select the About Beatnik Editor  
Windows only command.

Mac OS Go to the Apple menu and select the About Beatnik Editor... 
command
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Version History
This section of the User’s Guide records the changes that have been made at each major an
release of the Beatnik Editor, beginning with version 2.0. There’s a section for each major r
and its related minor releases.

The current release of the Beatnik Editor is version 2.1. If you're using an earlier version of
Beatnik Editor, you should update to the latest.

Version 2.1
Beatnik Editor version 2.1 is a minor maintenance release with a few new features, release
June of 2001. To date there have been no maintenance releases for version 2.1.

What’s New in Version 2.1

General Changes
• Player Window: New controls

• Mute and Solo button behavior changed:

To change multiple buttons at once, click on one button and then drag across the 
the desired buttons.

To turn all 16 Mute buttons on or off at once, click the word Mute to the left of the but-
tons.

To turn all 16 Solo buttons on or off at once, click the word Solo to the left of the but-
tons.

• Song Position Dial behavior changed:

Clicking a position on the dial makes the current Song start playing from that pos

• Tempo Display is now updated continuously.

• Session Window: New context menu commands
• Make Instrument Using and Make Song Using command dialogs now include a 

checkbox option for the Specify Root Key value. This allows you to preserve the 
Samples’ original Root Keys in the newly created Instruments, if desired.

• All Tabs: New Get Resource Usage command in the context menu displays the 
selected Song, Instrument, or Sample's total size in bytes.

The displayed size includes the uncompressed sizes of all dependent objects; fo
Instrument, this will be the Instrument resource plus all Samples used in the Inst
ment. For a Song, the size will include all Instruments it uses, plus all the Sample
used by those Instruments.

• Instruments Tab: New Show Empty Instrument Slots command in the context 
menu turns display of empty slots on and off.

• Sample Editor Window: New sample rate menu
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• Added a new Sample Rate menu to make it easier to pick a standard sample rate 
(48000, 44100, 36000, 22050, or 11025 Hz). To set a different sample rate, select 
Other and type in a number in Hz.

• Make Instrument and Make Song dialog boxes: New option
• Added a new checkbox to the Specify Root Key field. This gives you the option of 

preserving the Root Keys of your samples when creating a new Instrument or 
Song from them via the Make Instrument Using and Make Song Using com-
mands.

Mac OS Changes
• No Sequencer Needed for Live MIDI Input – You no longer need to use a MIDI sequencer t

route a connected MIDI controller (such as a keyboard) to the Beatnik Editor’s Live MID
Input. Just select the device in the Preferences dialog.

• Pop-Up Help – Now displays ‘ToolTip’ style pop-up help tags for onscreen items, similar t
the Windows version.

• Minimum System Requirements changed:
• Mac OS 8.5 no longer supported; 8.6 minimum

• PPC 604e processor no longer supported; 604 minimum

• Minimum processor speed increased to 180MHz

• Hard Disk use reduced from 15 MB to 8 MB

• Web Browser minimum version reduced from 4.5 to 4.0 (for online help)

• Added Microsoft Internet Explorer and AOL browser (for online help)

Windows Changes
• Minimum System Requirements changed:

• Minimum processor increased from Pentium 133 to Pentium Pro 200

• Hard Disk use reduced from 15 MB to 7.3 MB

• Web Browser minimum version reduced from 4.5 to 4.0 (for online help)

Bug Fixes
• When the Player Window is set to 8-bit audio output, the list of available audio file expor

mats should not have included the MPEG formats.

• The commands Make Instrument from Sample and Make Song from Sample were disregard-
ing the sample’s Root Key.

• Attempting to export a single Sample as an RMF file could cause a crash.
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Version 2.0
Beatnik Editor version 2.0 was released in September of 2000. Version 2.0 was the first rele
the Beatnik Editor that supported both Windows and Mac OS. There was one maintenance
release, version 2.0.1, to address a problem when Registering with an email address conta
the underscore character (_).

What’s New in Version 2.0
Topics:

Summary of Changes
Tips for Version 1 Users
Changed Key Commands

Summary of Changes
The Beatnik Editor software has been completely rewritten for version 2.0, with a new look
feel, and major improvements in technology and user interface:

• Cross-Platform – The Beatnik Editor is now available for both Mac OS and Windows.

• Revised Session window now includes tabs for all Songs, Instruments, and Samples in a
project. You can keep multiple Session documents open at once, and you can drag, cop
paste your Songs, Instruments, and Samples between Sessions. In fact, you can now c
paste multiple objects at once.

• Revised Export RMF command makes RMF creation a single-step process:

– With multiple Songs selected, Export RMF now creates one RMF file per Song.

– With Instruments selected, Export RMF automatically creates a Song to trigger them
includes it in the RMF file.

– With Samples selected, Export RMF automatically creates Instruments from the Sam
per your instructions, and a Song to trigger them, and includes everything in the RMF
No more MIDI file import step.

Now GrooveGram-style RMF files are practically automatic – just load the RMF file, lo
it, and add some JavaScript buttons to Mute and Unmute the Tracks.

• New support for RMFX files – just select the RMFX option in the Export RMF dialog box. N
need for complex template Session files or cumbersome hand operations any more. (A
RMFX file is an RMF file containing one or more Instruments, but no Songs – useful for
sounds that will be triggered interactively with the Music Object but not used in stored So

• New Sample Editor with visual editing of sample waveforms and loop points. Commands
include Cut, Paste, Clear, Crop, Gain Change, Normalize, Fade In, and Fade Out.

• New JavaScript window to help streamline the Sonification process. It shows the equival
JavaScript code for actions that you take in the Beatnik Editor. You can copy the code in
window, and paste it right into your HTML editor.
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• New Make Using… shortcut commands to streamline common operations:

– Make Instrument Using Samples automatically builds one or more Instruments from
or more selected Samples, including creating the Keymap and laying the Samples ou
your instructions.

– Make Song Using Samples goes a step further, and creates not just the Instruments
simple Song that triggers them when the RMF file is played.

– Make Song Using Instruments does the same thing in cases where you already hav
Instrument built.

• Improved Undo / Redo – Every edit operation is Undo-able and Redo-able. The undo histo
effectively infinite (limited by memory, disk, etc.). Each window has a separate Undo trail.

• Improved MIDI Sequencer Link – The Beatnik Editor is now always responsive to external 
MIDI input, so there is no longer a Link to Sequencer command. You can always play fro
external MIDI keyboard instead of the onscreen keyboard, if you prefer. You can always
tion your current Instrument Bank by playing a song from your sequencer (or from any S
dard MIDI File player, such as the Windows Media Player).

• Improved Song Info features (formerly ‘Copyright’) – You can now apply the same Song In
settings to multiple Songs at once, in a single operation. You can also set up a default s
values for all the Song Info fields, then in a single step apply them all – or only some of
– to a Song whenever you want.

• Improved Instrument Editor now combines Keymap, Filter, Volume Envelope, Modulation, 
and Output controls into one window with multiple pages and graphic editing. You can n
drag Samples into the Keymap from a Session window, and your Instruments can now 
to five Modulators (previous limit was three).

• Improved Compression features – A new caching system makes it easier to compare differ
compression types for a given Sample. Also, the original, uncompressed version of ever
ple is kept, so you can always switch to a different compression type later with no loss in
ity. You can also apply the same compression type to any number of Samples at once, 
single operation.

• Improved Export Audio File feature lets you save linear audio versions of your Songs in WA
AIFF, and MP3 formats (in addition to the original Sound Designer II on Mac OS).

• Improved MPEG compression – The new MPEG encoder and decoder run much faster an
sound much better.

• Improved Modulation Editor – Modulation options are now presented as four basic Modula
Types – LFO, Envelope, LFO with Depth Envelope, and Offset Modulator – and the con
that are irrelevant for each type are kept from view.

• Improved window behavior – The Sample Editor and Instrument Editor windows are mod
less – that is, you can leave them open while doing work in other windows, and you can
as many Sample Editors and Instrument Editors open as the available memory will allow
Also, when the Beatnik Editor starts up, it now automatically returns to the state it was i
before the latest shut down. This includes which Session documents were open, select
items, window positions, MIDI channel Mute and Solo buttons, and so forth.
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• Improved documentation – Revised and expanded Beatnik Editor User’s Guide, now supp
both in printable PDF and online HTML formats. Also new onscreen ToolTips (Windows
only).

Tips for Version 1 Users
If you’ve been working with earlier releases of the Beatnik Editor, you should be aware of a
significant workflow changes introduced in version 2:

• Full-Time Live MIDI Input
The Beatnik Editor’s MIDI Input feature now operates all the time – there’s no longer a
need for the Link to Sequencer command. Just select the right MIDI Input source in th
Preferences dialog box.

• Total Undo
Whereas the Beatnik Editor version 1 had limited Undo functionality, version 2 offers total 
Undo all the way back to your most recent Save or Save As…. Also, there are now multiple 
Undo histories. That is, every window you open maintains its own independent Undo history. 
This means that while you’re in a Sample Editor or Instrument Editor, you can Undo your 
changes all the way back to the original, unedited version without affecting any of the 
you’re doing at the same time in other windows.

Important Notes:
• When you close a Sample Editor or Instrument Editor window, all the edits you 

made are rolled into one single Undo-able step in the Session document’s Undo 
history. For example, if immediately after closing a Sample Editor you click in 
your Session document and then Undo, you’ll get the Sample as it was before you 
started editing it – not the Sample as it was before your most recent edit inside 
the Sample Editor. The same also holds true for changes to Instruments.

• You can now Revert a Sample Editor or Instrument Editor window, with same 
effect.

• Multiple Sessions
Whereas the Beatnik Editor version 1 operated on one Session document at a time, ve
is able to keep as many Sessions open as the available memory will allow. You can dr
copy, and paste Custom Songs, Custom Instruments, and Custom Samples between 
open Session documents. Dragging or pasting also offers the option of bringing any d
dent resources along – for a Song, its Custom Instruments and Custom Samples can
cloned; and for an Instrument, its Samples can also be cloned.

Important Note: When dragging or pasting into a Session document would result i
more than one Instrument with the same MIDI program number, the Beatnik Edit
will renumber the colliding Instruments and alert you. If you see this message, you 
should carefully verify that any Songs being added still play correctly because the 
Beatnik Editor will not update the Song’s MIDI Program Change events to use th
altered Instrument numbers. If the Song is now playing with wrong Instruments, 
will need to use your MIDI sequencer program to set the program numbers manu
in your original sequence, then save a revised MIDI file and Re-Import MIDI (see Song 
Settings dialog box).
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Changed Key Commands

Menu Beatnik Editor 
1.0 command

Beatnik Editor 
2.0 command Description

File J I Import

P (none) Link to Sequencer
(P is now Compression)

Edit 1, 2, 3 (none) Minimum, Medium, and Maximum 
volume commands have been 
removed

Song Y (none) Changed ‘Copyright’ to ‘Song 
Info’
(Y is now Redo)

Instrument K, M, G, F (none) Changed to page select buttons in 
Instrument Editor window

I (none) Instrument Settings moved into 
Instrument Editor window
(I is now Import)

Window 4, 5, 6 (none) Songs, Instruments, and Samples 
are now tabs in the Session window

7, 8 (none) Keyboard and Realtime windows 
are now combined in the Player 
window

9 (none) Help window moved to Help menu
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License Agreement

This is the End User License Agreement that governs your use of the Beatnik Editor soft-
ware.

END-USER LICENSE AGREEMENT
IMPORTANT: This is a legal agreement between you (the "User") and Beatnik, Inc., with its
cipal place of business at 2600 S. El  Camino Real, San Mateo, California 94403 ("Beatnik")
important that you read this document before clicking on the "I  Accept" button below or usin
software ("Software").  By clicking on the "I Accept" button below and/or installing or using 
of the Software, you acknowledge that you have read this Agreement and agree to be boun
terms.  If you do not agree to be bound by all of the terms of this Agreement, click on the "I
decline" button below and do not attempt to access, install or use any of the Software.

Section 1. LICENSE
         1.1 License Grant.  During the term of this Agreement, Beatnik grants to User and Us
accepts from Beatnik a limited, personal, non-exclusive, non-sublicensable and non-transfe
license (the "License") to install and use the Beatnik Editor, version 2.1, in object code form
only, together with any related technical specification documentation provided by Beatnik (
"Documentation" and, unless otherwise noted, together with the software, the "Software") o
a single computer connected to a single monitor (i.e. a single CPU).  User may not use the
ware on more than one (1) computer simultaneously, or on any networked system with mu
users.  Beatnik shall not be obligated to provide any maintenance or updates for the Softw
User.

         1.2 Ownership.  Subject only to the License, Beatnik or its licensors, as applicable, sh
retain all right, title and interest, including without limitation all copyrights, trademarks and o

proprietary rights, in and to the Software.  The Software is protected by the copyright and p
laws of the United States and other countries, and international copyright conventions and tr
Beatnik reserves all rights in the Software not expressly granted to User herein.

         1.3 Copies.  User may transfer the Software to a single computer hard disk, provided
User maintains the original solely for backup and archival purposes.  User may make one c
the Software for backup and archival purposes only, but no other copies. User must reprodu
include the copyright notice, trademark notice and other proprietary notices that appear on
original Software on any copy thereof made in accordance with the terms of this Agreemen

         1.4 Restrictions.  User shall not (and shall not allow any third party to: (i) decompile, d
semble, or otherwise reverse engineer (except to the extent that applicable law prohibits re
engineering restrictions) or attempt to reconstruct or discover any source code, underlying 
algorithms, file formats or programming or interoperability interfaces of the Software by any
means whatsoever, (ii) remove, modify, obscure or deface any product identification, copyr
trademark or other notices in the Software, (iii) provide, sell, distribute, transfer, rent, lease,
use for timesharing, service bureau or hosting purposes or otherwise use or allow others to
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Software to or for the benefit of third parties, (iv) display, translate, modify, incorporate into 
with other software or create a derivative work of any part of the Software, and (vi) other th
specifically allowed under this Agreement, use the output or other information generated by
Software (including, without limitation, output describing the structure of a software program
any purpose other than User's own internal use.

Section 2. WARRANTY DISCLAIMER.
THE SOFTWARE IS LICENSED "AS-IS." 

NO WARRANTY OF ANY KIND, WHETHER EXPRESS OR IMPLIED IS PROVIDED BY 
BEATNIK, INC. OR ITS LICENSORS.  NO DEALER, AGENT OR EMPLOYEE OF BEATNIK
IS AUTHORIZED TO MAKE ANY WARRANTY WITH RESPECT TO THE SOFTWARE.  
BEATNIK AND ITS LICENSORS EXPRESSLY DISCLAIM ANY AND ALL WARRANTIES 
OF ANY KIND WHETHER EXPRESS OR IMPLIED (EITHER IN FACT OR BY OPERATION
OF LAW) WITH RESPECT TO THE SOFTWARE, INCLUDING WITHOUT LIMITATION, 
ALL IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT OR FIT-
NESS FOR A PARTICULAR PURPOSE.  BEATNIK AND ITS LICENSORS DO NOT WAR-
RANT THAT THE SOFTWARE IS ERROR OR VIRUS FREE OR THAT OPERATION OF TH
SOFTWARE WILL BE SECURE OR UNINTERRUPTED.  USER MAY HAVE OTHER 
RIGHTS TO THE EXTENT REQUIRED BY LAW, HOWEVER, TO THE FULL EXTENT 
PERMITTED BY LAW, THE DURATION OF ANY STATUTORILY REQUIRED WARRAN-
TIES SHALL BE LIMITED TO THE PERIOD COMMENCING ON THE EFFECTIVE DATE 
AND ENDING NINETY (90) DAYS THEREAFTER.

Section 3. TERM AND TERMINATION.
         3.1 Term.  This Agreement shall commence on the date on which you click "I Accept" b
(the "Effective Date", and shall continue indefinitely, unless terminated pursuant to Section 
this Agreement.

         3.2 Termination.  Beatnik may terminate this Agreement upon written notice to User if
breaches any term of this Agreement. User may terminate this Agreement by written notice
Beatnik accompanied by all copies of the Software licensed to User.  Upon any expiration o
mination of this Agreement, User shall immediately cease all use of the Software and retur
destroy all copies of the Software and all portions thereof to Beatnik.  Termination is not an 
sive remedy and all other remedies will be available whether or not this Agreement is termin
Sections 1.2, 1.4, 2, 3.2, 4 and 5 shall survive termination of this Agreement for any reason

Section 4. LIMITATION OF LIABILITY.
NOTWITHSTANDING ANYTHING IN THIS AGREEMENT TO THE CONTRARY, NEI-
THER BEATNIK NOR ITS LICENSORS SHALL BE LIABLE OR OBLIGATED WITH 
RESPECT TO ANY SUBJECT MATTER OF THIS AGREEMENT UNDER CONTRACT, 
NEGLIGENCE, STRICT LIABILITY OR ANY OTHER LEGAL OR EQUITABLE THEORY 
(I) FOR ANY AMOUNTS IN EXCESS OF AN AMOUNT EQUAL TO THE AGGREGATE OF
THE AMOUNTS PAID BY USER WITH RESPECT TO THE SOFTWARE THAT IS THE SUB
JECT OF THE CLAIM, (II) FOR ANY DIRECT, SPECIAL, INCIDENTAL, PUNITIVE OR 
CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT LIMITATION, FOR ANY COST 
OF PROCUREMENT OF SUBSTITUTE GOODS, TECHNOLOGY, SERVICES OR RIGHTS
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(III) FOR INTERRUPTION OF USE OR LOSS OR CORRUPTION OF DATA; OR (IV) FOR
ANY MATTER BEYOND ITS REASONABLE CONTROL.  SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATIONS AND EXCLUSIONS MAY NOT APPLY TO USER.

Section 5. GENERAL PROVISIONS
         5.1 Cumulative Remedies.  The remedies under this Agreement shall be cumulative a
alternative and the election of one remedy for a breach shall not preclude pursuit of other r
dies unless as expressly provided in this Agreement.

         5.2 Governing Law.  This Agreement shall be governed in all respects by the substan
laws of the State of California, United States of America (excluding conflict of laws rules), w
out regard to the U.N. Convention on Contracts for the International Sale of Goods. Any dis
regarding this Agreement shall be subject to the exclusive jurisdiction of the California state
courts in and for San Mateo County, California or, if there is federal jurisdiction, the United S
District Court for the Northern District of California, and the parties agree to submit to the p
sonal and exclusive jurisdiction and venue of these courts.

         5.3 Notices.  All notices, statements and reports required or permitted by this Agreem
shall be in writing and deemed to have been effectively given and received; (i) five (5) busin
days after the date of mailing if sent by registered or certified U.S. mail, postage prepaid, w
return receipt requested; (ii) when transmitted if sent by facsimile, provided a confirmation 
transmission is produced by the sending machine and a copy of such facsimile is promptly s
another means specified in this Section 6.3; or (iii) when delivered if delivered personally o
by express courier service.  All notices to Beatnik must be sent to the attention of Beatnik's
eral Counsel at the address first set forth above.

         5.4 Export Restrictions.  User will comply in all respects with all laws, regulations, rules
treaties applicable to any materials or technology provided hereunder, including without lim
tion, all export restrictions.  User will comply with the Export Administration Regulations or o
United States laws and regulations with respect to export in effect from time to time.  By do
loading, using or installing the Software, you warrant that you are not, and are not located 
under the control or, or a national or resident of any country, subject to United States expor
restrictions that prohibit the license of the Software to you.

         5.5 Assignment.  User shall not assign or otherwise transfer any of its rights, obligatio
licenses hereunder without the prior written consent of Beatnik, including any assignment b
operation of law as a result of the merger or acquisition of User. Subject to the foregoing, th
visions of this Agreement shall apply to and bind the successors and permitted assigns of t
ties.

         5.6 Headings.  The descriptive headings of this Agreement are intended for reference
and shall not affect the construction or interpretation of this Agreement.

         5.7 Severability.  If any provision set forth in this Agreement is determined by any cou
be unenforceable, invalid or illegal, such provision shall be interpreted to have the broades
cation as shall be enforceable, valid and legal, provided, however that if such provision can
interpreted to be enforceable, valid or legal to any extent, such provision shall be severed. 
invalidity, illegality or unenforceability of any particular provision of this Agreement shall not
affect the other provisions hereof, which shall continue in full force and effect.
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         5.8 Waiver of Rights.  The failure of either party to require performance of any of the t
covenants, or conditions of this Agreement or to exercise any right hereunder in any instan
shall not be construed as a waiver or relinquishment of the future performance of any rights

         5.9 Entire Agreement; Conflict.  This Agreement, together with all exhibits and schedu
hereto, constitutes the complete, final and exclusive statement of the terms of the Agreeme
among the parties pertaining to the subject matter hereof and supersedes all prior agreeme
understandings, negotiations and discussions of the parties.  No modification or rescission
Agreement shall be binding unless executed in writing by the party to be bound thereby.

         5.10 Legal Expenses.  The prevailing party in any legal action brought by one party a
the other and arising out of this Agreement will be entitled, in addition to any other rights an
remedies it may have, to reimbursement for its expenses, including court costs and reason
attorneys' fees.

         5.11 Government End-Users.  The Software and accompanying documentation are d
to be "commercial computer software" and "commercial computer software documentation
respectively, pursuant to DFAR Section 227.7202 and FAR Section 2.212, as applicable.  An
modification, reproduction, release, performing, displaying or disclosing of the software and
accompanying documentation by the U.S. Government shall be governed solely by the term
this Agreement and shall be prohibited except to the extent expressly permitted by the term
this Agreement.

Copyright notice applicable to the Software:  Copyright (c) 1996 - 2001 Beatnik, Inc.  All rig
reserved.  MPEG Layer 3 audio coding technology licensed from Fraunhofer IIS and THOM
multimedia.  All rights reserved.

Beatnik(r), Beatnik EditorTM, and all Beatnik logos are either registered trademarks or trad
marks of Beatnik, Inc. in the United States and/or other countries.
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Online Resources

Links to useful information and content on the Beatnik Web site.

Customer Support If you run into difficulty installing, registering, or using the Beatnik Edi-
tor, and can’t find an answer in the Online Help or User’s Guide, then con-
tact Beatnik Customer Support via the Beatnik Web site:

http://www.beatnik.com/to/?editor-support

Documentation Updates Every once in a while you may want to check for updates to this User’s 
Guide or other Beatnik Editor documentation:

http://www.beatnik.com/to/?editor-doc-download

Software Updates Every once in a while you may want to check for updates to the Beatnik 
Editor software:

http://www.beatnik.com/to/?editor

Beatnik for Beginners Come learn what Beatnik interactive audio is all about:

http://www.beatnik.com/to/?beginners

Beatnik Discussion 
Forums

This is the best place to keep in touch with other beginning and intermedi-
ate Beatnik Editor users, and to ask questions as you start learning:

http://discussion.beatnik.com/

Beatnik Knowledge-
base

Online database of tips, techniques, and user experience for all Beatnik 
technologies:

http://www.beatnik.com/to/?guru

Beatnik Village Mailing 
List

The Beatnik Village mailing list is the best way to keep in contact with 
advanced Beatnik Editor users:

http://www.beatnik.com/to/?beatnik-mailing-list

Beatnik Sonified Show-
case

A gallery of some of the best interactive audio work being done with 
Beatnik technologies:

http://www.beatnik.com/to/?showcase

Sonify Your Web Site Adding interactive music and audio to your own Web sites is a snap with 
Beatnik's information and tools. You can program it yourself in HTML 
and JavaScript, or use authoring tools that support Macromedia Dream-
Weaver, Macromedia Director, Adobe GoLive, and NetObjects Fusion. 
For a comprehensive guide to Beatnik technologies and tools, visit:

http://www.beatnik.com/to/?products

Beatnik Central To learn about all things Beatnik, visit the main Beatnik Web site:

http://www.beatnik.com
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Built-In Instruments

This section lists the Instruments in the General MIDI and Beatnik Special banks.

Beatnik playback software generally includes two Built-In Instrument banks: Bank 0 contain
General MIDI Instruments, and Bank 1 contains Beatnik Special Instruments. Every Instrum
bank contains both Melodic Instruments and Percussion Instruments. In most cases, these 
instruments are kept in a disk file named patches.hsb (or some variation on that name). 

This section lists all the Melodic and Percussion Instruments in the Built-In General MIDI a
Beatnik Special banks.

Topics:
Built-In Melodic Instruments

Built-In Percussion Instruments

Note: Bank 2 is reserved for Custom Instruments in RMF files.

Built-In Melodic Instruments
Melodic instruments are selected by MIDI Bank Select and Program Change messages. 

MIDI Program
Number

Bank 0: General MIDI
(Melodic)

Bank 1: Beatnik Special
(Melodic)

0 Piano Soft Piano

1 Bright Piano Reflection Piano

2 Electric Grand Flange Piano

3 Honky Tonk Piano Octopus Piano

4 Electric Piano 1 Flange Electric Piano

5 Electric Piano 2 Tremolo Electric Piano

6 Harpsichord Chorus Harpsichord

7 Clavinet Ondioline

8 Celesta Curious Chime

9 Glockenspiel Swirly Bell

10 Music Box Echo Bell

11 Vibraphone Vibraphone 2

12 Marimba Soft Marimba
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13 Xylophone Percolator

14 Tubular Bell Reverse Bell

15 Dulcimer Percussive Piano

16 Hammond Organ Rot. Speaker Organ 1

17 Perc Organ Bright Perc Organ

18 Rock Organ Growl Organ

19 Church Organ Chorus Church Organ

20 Reed Organ Sawteeth

21 Accordion Expressive Accordion

22 Harmonica Corny Harmonica

23 Tango Accordion Squeeze Box

24 Nylon Str Guitar Acoustic Bass Gtr

25 Steel String Guitar Mute Guitar 2

26 Jazz Electric Gtr Chorus Jazz Guitar

27 Clean Guitar Tremolo Guitar

28 Muted Guitar Echo Mute Bass

29 Overdrive Guitar Grungey Guitar

30 Distortion Guitar Flange Guitar

31 Guitar Harmonics Flange Guitar Stab

32 Acoustic Bass Dark Syn Bass

33 Fingered Bass Jungle Bass

34 Picked Bass Jungle Bass 2

35 Fretless Bass Chorus Bass

36 Slap Bass 1 Synth Slap Bass

37 Slap Bass 2 Lowrider

38 Syn Bass 1 OB Bass

39 Syn Bass 2 OB Bass 2

40 Violin Synth Violin

41 Viola Robot Threat

42 Cello Formula 1

43 Contrabass Deep Bass Stab

44 Tremolo Strings Trill Strings

45 Pizzicato Strings Cello Stroke

46 Orchestral Harp VibHarp
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47 Timpani Tuned Drum

48 Ensemble Strings  sfz Strings

49 Slow Strings  Moving Strings

50 Synth Strings 1 Heads of Space

51 Synth Strings 2 Slow Synth Strings

52 Choir Aahs Slow Choir Aahs

53 Voice Oohs Pulsing Voices

54 Syn Choir Cloudscapes

55 Orchestra Hit Hype Orch Hit

56 Trumpet Accent Trumpet

57 Trombone Accent Trombone

58 Tuba Mellow Trombone

59 Muted Trumpet Muted Trumpet 2

60 French Horn French Horn Swell

61 Brass Ensemble Brass Ensemble 2

62 Syn Brass 1 Syn Brass 3

63 Syn Brass 2 Syn Brass 4

64 Soprano Sax Lyrical Sax

65 Alto Sax Accent Sax

66 Tenor Sax Slow Sax

67 Baritone Sax Staccato Sax

68 Oboe Lyrical Oboe

69 English Horn Soft Lead Synth

70 Bassoon Staccato Bassoon

71 Clarinet Smooth Clarinet

72 Piccolo Accent Piccolo

73 Flute Lyrical Flute

74 Recorder Mello Breath

75 Pan Flute Peruvian

76 Bottle Blow Breath Echoes

77 Shakuhachi Apparition

78 Whistle Humorous Whistle

79 Ocarina Strobes

80 Syn Square Wave Teletronic
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81 Syn Saw Wave 5th Pulse

82 Syn Calliope Moon Jelly

83 Syn Chiff Ricochet Pad

84 Syn Charang Rock Radiation

85 Syn Voice Solo Vox 2

86 Syn Fifths Saw 5th Saw Drone

87 Syn Brass and Lead Lead Synth 2

88 Fantasia Fantasy Bells

89 Warm Pad Slow Warm Pad

90 Polysynth Polysynth 2

91 Space Vox 50's Sci-Fi

92 Bowed Glass Watery Glass

93 Metal Pad UFOs

94 Halo Pad Soprano

95 Sweep Pad Refractions

96 Ice Rain Comet Tails

97 Soundtrack Soundtrack 2

98 Crystal Friendly Data

99 Atmosphere Analog Sequence

100 Brightness Luminous Voice

101 Goblins Goblins 2

102 Echo Drops Tick Blok

103 Sci Fi Droplet

104 Sitar Droplet 2

105 Banjo Video Game 1

106 Shamisen Video Game 2

107 Koto Digi-Dodo

108 Kalimba Fairy Godmother

109 Bag Pipe Alarm

110 Fiddle Hoverbug

111 Shanai Crickets

112 Tinkle Bell Beatnik

113 Agogo Teletype

114 Steel Drums Carriage Return
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115 Woodblock Typewriter Key

116 Taiko Drum Cash Register

117 Melodic Tom Thru Phone Chirp

118 Syn Drum Whipped

119 Reverse Cymbal Pop Click

120 Guitar Fret Noise Metal Chirp

121 Breath Noise Poing

122 Seashore Metal Spray

123 Bird FlyBy 1

124 Telephone FlyBy 2

125 Helicopter Cosmic Ray

126 Applause SampHold

127 Gunshot SampHold 2
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Percussion instruments are usually accessed by means of MIDI notes played on the Drum
nel (MIDI channel 10). The table below shows what instrument is produced by each MIDI n
By default, the General MIDI percussion instruments (Bank 0) are used for the Drum Chann
use the Beatnik Special percussion instruments on the Drum Channel instead, send a MID
Select message on channel 10, with bank number 1.

Ordinarily the Drum Channel is in Percussion Mode, where there’s a different instrument for
MIDI note number (pitch), all playing at natural pitch. However, the Drum Channel can also
put into Pitched Percussion Mode (so can all of the MIDI channels). In Pitched Percussion 
sending a MIDI Program Change message selects any one of the percussion instruments, 
in the table below, and sending MIDI note messages of different pitches will play the select
instrument at corresponding pitch transpositions.

Note: In the Beatnik Special Bank, percussion instruments 0–45 (C-1 – A2) repeat ins
ments 46–90 (A#2 –  F#6). 

MIDI Note
or

Program
Number

MIDI Note
Name

Bank 0: General MIDI
(Percussion)

Bank 1: Beatnik Special
(Percussion)

0 C-1 (Empty) tablaesque_lo

1 C#-1 (Empty) tablaesque_hi

2 D-1 (Empty) nine_inch_kick

3 D#-1 (Empty) hippishake

4 E-1 (Empty) ScienceTom

5 F-1 (Empty) click

6 F#-1 (Empty) rvs cymb pan long

7 G-1 (Empty) rvs cymb pan med

8 G#-1 (Empty) rvs cymb pan short

9 A-1 (Empty) woodstick

10 A#-1 (Empty) electrobrite

11 B-1 (Empty) Slo Laser

12 C0 (Empty) Ufo-by

13 C#0 (Empty) air snare

14 D0 (Empty) weird snare

15 D#0 (Empty) flange snare
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16 E0 (Empty) ping drum

17 F0 (Empty) itchy-scratch

18 F#0 (Empty) itchy-scratch 2

19 G0 (Empty) hi_metallic_snare

20 G#0 (Empty) noise echo

21 A0 (Empty) buzzy hit

22 A#0 (Empty) rez hat

23 B0 (Empty) bucket hit

24 C1 (Empty) icecube

25 C#1 (Empty) explosive kick

26 D1 (Empty) mutant cowbell

27 D#1 Hi-Q Temple Bell

28 E1 Slap Hi Temple Gong

29 F1 Scratch Push Thuddy Kick

30 F#1 Scratch Pull LoBell

31 G1 Sticks sinechirp

32 G#1 Square Click hollow_metal_hit

33 A1 Metronome Click woodblock

34 A#1 Metronome Bell reverse cymbal

35 B1 Low Kick tablaesque_slap

36 C2 Kick sonarblip

37 C#2 Rimclik sinehit

38 D2 Electric Snare sineblock

39 D#2 Handclap Krelltone

40 E2 Acoustic Snare sine_kick

41 F2 Tom Low hi-tone*

42 F#2 Closed Hi-Hat hi-click

43 G2 Tom Hi Gate-tone

44 G#2 Pedal Hi-Hat chem-tone

45 A2 Tom Hi dub_kick
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46 A#2 Open Hi-Hat tablaesque_lo

47 B2 Low Mid Tom tablaesque_hi

48 C3 High Mid Tom nine_inch_kick

49 C#3 Crash Cymbal 1 hippishake

50 D3 High Tom ScienceTom

51 D#3 Ride Cymbal 1 click

52 E3 Chinese Cymbal rvs cymb pan long

53 F3 Ride Bell rvs cymb pan med

54 F#3 Tambourine rvs cymb pan short

55 G3 Splash Cymbal woodstick

56 G#3 Cowbell electrobrite

57 A3 Crash Cymbal 2 Slo Laser

58 A#3 Vibraslap Ufo-by

59 B3 Ride Cymbal 2 air snare

60 C4 High Bongo weird snare

61 C#4 Low Bongo flange snare

62 D4 Mute High Conga ping drum

63 D#4 Open High Conga itchy-scratch

64 E4 Low Conga itchy-scratch 2

65 F4 High Timbale hi_metallic_snare

66 F#4 Low Timbale noise echo

67 G4 High Agogo buzzy hit

68 G#4 Low Agogo rez hat

69 A4 Cabasa bucket hit

70 A#4 Maracas icecube

71 B4 Short Whistle explosive kick

72 C5 Long Whistle mutant cowbell

73 C#5 Short Guiro Temple Bell

74 D5 Long Guiro Hi Temple Gong

75 D#5 Claves Thuddy Kick
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76 E5 High Wood Block LoBell

77 F5 Low Wood Block sinechirp

78 F#5 Mute Cuica hollow_metal_hit

79 G5 Open Cuica woodblock

80 G#5 Close Triangle reverse cymbal

81 A5 Open Triangle tablaesque_slap

82 A#5 Shaker sonarblip

83 B5 Jingle Bell sinehit

84 C6 Bell Tree sineblock

85 C#6 Castanets Krelltone

86 D6 Mute Surdo sine_kick

87 D#6 Open Surdo hi-tone*

88 E6 (Empty) hi-click

89 F6 (Empty) Gate-tone

90 F#6 (Empty) chem-tone

91 G6 (Empty) dub_kick

92 – 93 G#6 – A6 (Empty) (Empty)

94 A#6 Brush Snare High (Empty)

95 B6 Brush Snare Low (Empty)

96 – 127 C7 – G9 (Empty) (Empty)
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Live MIDI Input

How to work with the Beatnik Editor’s continuous MIDI Input.

Notes:
Beatnik Editor version 2.0 Users: You no longer need to use a MIDI sequencer to route a
connected MIDI controller (such as a keyboard) to the Beatnik Editor’s Live MIDI Inpu
Just select the device in the Preferences dialog.

Beatnik Editor version 1 Users: The Beatnik Editor’s MIDI Input feature now operates all 
the time – there’s no longer any need for the Link to Sequencer command that appea
earlier versions. Just select the right MIDI Input source in the Preferences dialog box.

If you don’t have any Session documents open, Live MIDI Input won’t work. That’s because 
the Beatnik Editor keeps all its Instruments in Session documents, and it can’t play M
notes when it doesn’t have any Instruments to play them on.

Mute Buttons Affect Live MIDI In. In the Player window, if a MIDI channel’s Mute button is 
on, then live MIDI notes arriving on that channel won’t be heard. The channel Solo buttons 
also affect Live MIDI Input.

Instrument Changes Require a Click on the Onscreen Keyboard. When you select a new 
Instrument in a Session window, the Instrument name will appear immediately in the Key-
board Instrument display of the Player window; however, the Instrument will not be activate
until you click a note on the onscreen keyboard. As a result, any Live MIDI Input notes
received on channel 1 during that interval will continue to sound with the previous chan
Instrument.

Topics:
About Live MIDI Input

Setting Up for Live MIDI Input

Mac OS
Windows

Working with Live MIDI Input

About MIDI and Instrument Programs
Coping with Latency

About Live MIDI Input
The Beatnik Editor’s Live MIDI Input feature gives you a way to send notes, Controller mess
like pitch bend, Program Changes, and any other MIDI messages to the Beatnik MIDI Synt
sizer inside the Beatnik Editor. This means you can use MIDI to audition and play Beatnik I
ments and control the mix and reverb, at the same time you’re editing your Samples and 
Instruments in the Beatnik Editor. When you realize that live MIDI input can also come from
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MIDI sequencer program, you’ll see that the Beatnik Editor is an environment where you ca
develop your notes, your patches, and your mix all at the same time – so music-making is 
and you’re much more productive.

These incoming MIDI messages can come from many different sources, falling into two ma
groups:

• Pieces of software running on the same computer – usually a MIDI sequencer program

• External MIDI sources – Keyboard devices, other controllers, and other computers.

Connecting with pieces of software running on the same computer doesn’t require any MID
interface hardware, just some MIDI system software to connect the two programs (see Setting Up 
for Live MIDI Input, below).

If your computer has the right MIDI interface hardware, MIDI input can also come from any
external MIDI device – a MIDI keyboard, a MIDI electronic drum set, or a MIDI program run
ning on a second computer with its own hardware MIDI interface. This is the way you play 
Beatnik Editor’s synthesizer from an external keyboard, not just the onscreen keyboard in t
Player window.

Often you’ll want to use both approaches at the same time. The preferred set-up for many 

Beatnik MIDI Synthesizer

Audio Out

L

R

Beatnik Editor

Onscreen

MIDI

Program

Your Computer

Sequencer

Live
MIDI
Input

KeyboardSongs

Beatnik MIDI Synthesizer
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L
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Beatnik Editor
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Live
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MIDI
Interface

Other Computer

MIDI
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MIDI
Interface

MIDI
Sequencer
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MIDI
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MIDI
Keyboard

Your Computer
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posers and arrangers is to run both the Beatnik Editor and a MIDI sequencer program at th
time, on the same computer, and use a MIDI keyboard for easier note entry. This approach
requires a hardware MIDI interface:

Setting Up for Live MIDI Input
To use Live MIDI Input, you’ll need to install the appropriate system MIDI software drivers, 
then in the Beatnik Editor Preferences dialog box select your desired MIDI input source. This 
procedure depends on your operating system, and on which MIDI hardware and software y
have.

Mac OS
The Beatnik Editor’s Live MIDI Input feature, like all MIDI software for Mac OS, requires the
use of a separate MIDI routing software package: the Open MIDI System (OMS), and for us
Mark of the Unicorn’s Performer, the FreeMIDI package. These packages allow MIDI sequ
ers, or other programs, to recognize the Beatnik Editor and send MIDI event streams to it.

To set up a Mac OS computer for Live MIDI Input in the Beatnik Editor:

1. If your situation requires a hardware MIDI hardware interface, get one.

Many different models and brands are available. See your favorite computer or music
for a consultation.

2. Get the appropriate system MIDI routing software for your computer: 

We support the Open Music System (OMS). Users of Mark of the Unicorn’s Performer
also need FreeMIDI. They can both be downloaded from the Web.

• OMS is available at:

http://www.opcode.com/downloads/
For best results, make sure to get version 2.1 or greater.

MIDI
Interface

Your Computer

MIDI

Program
Sequencer

MIDI
Keyboard

Beatnik MIDI Synthesizer

Audio Out

L

R

Beatnik Editor

Onscreen

Live
MIDI
Input

KeyboardSongs
MIDI

Cable
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• FreeMIDI is available on your Performer CD, or at:

http://www.motu.com/english/download/
If either of these sites are inaccessible, do a Web search using your favorite search en

3. Install your software and optional hardware from steps 1 and 2, following their provided
instructions.

4. In the Beatnik Editor, go to the Preferences dialog box and in the Choose MIDI Input Device 
listbox, select OMS.

5. If you want to feed the Beatnik Editor’s Live MIDI Input with a MIDI sequencer program
running on the same computer, see also Linking to Your Sequencer.

Windows
Note for Windows 2000 and NT Users: You should be prepared for a certain amount of irre
ularity in live MIDI event timing, as these operating systems are optimized for server p
cesses, not real-time media presentation.

To set up a Windows computer for Live MIDI Input in the Beatnik Editor:

1. If your situation requires a hardware MIDI hardware interface, get one.

Many different models and brands are available. See your favorite computer or music
for a consultation.

2. If you want to feed the Beatnik Editor’s Live MIDI Input with a MIDI sequencer program
running on the same computer, get an inter-application MIDI connection driver.

Beatnik recommends you use MIDI Yoke:

http://www.midiox.com/myoke.htm
3. Install your software and optional hardware from steps 1 and 2, following their provided

instructions.

4. In the Beatnik Editor, go to the Preferences dialog box and in the Choose MIDI Input Device 
listbox, select the appropriate item.

On a typical Windows machine equipped with a Sound Blaster Live! Card, this is oftenSB 
Live! Midi UART. If you’re using MIDI Yoke, select that instead.

5. If you want to feed the Beatnik Editor’s Live MIDI Input with a MIDI sequencer program
running on the same computer, see also Linking to Your Sequencer. 
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Working with Live MIDI Input
Live MIDI Input is very simple to use. Whenever the Beatnik Editor is running, the external M
source feeds the Beatnik MIDI Synthesizer, subject to the controls in the Player window:

• The Beatnik Editor’s MIDI Input is available at all times; that is, whenever the Beatnik Ed
is running, the Beatnik MIDI Synthesizer will respond to the live MIDI input source you’v
selected in the Preferences dialog box. 

• Live MIDI input can access all 16 MIDI channels, providing that the Player window’s chan-
nel Mute buttons are off. 

• The channel Solo buttons in the Player window also apply to live MIDI Input.

• The Player window’s sampling rate, channels (mono/stereo), and reverb controls also af
notes arriving from the live MIDI input.

• Selecting Channel 1 Instruments: When you select a new Instrument in a Session window, 
Instrument name will appear immediately in the Keyboard Instrument display of the Player 
window; however, the Instrument will not be activated until you click a note on the onscr
keyboard. As a result, any Live MIDI Input notes received on channel 1 during that inter
will continue to sound with the previous channel 1 Instrument.

• When playing the Beatnik Editor Instruments live from a MIDI keyboard, you’ll notice so
latency – when you press a key, there's a short delay before the note triggers, usually a
20 milliseconds. This latency can be very irritating when trying to play complex musical 
sages. Unfortunately, latency is unavoidable due to the system software that routes MID
sages between applications, and the Beatnik Editor’s audio output buffering that preven
sound from breaking up when your computer is very busy. See also Coping with Latency, 
below.

Tip: Rather than playing the Beatnik MIDI Synthesizer in real time, we recommend yo
your live MIDI playing and sequence recording on instruments other than the Beatnik 
tor. Then, once the MIDI performance is recorded in the sequencer, assign the same t
play back through the Beatnik Editor. 

About MIDI and Instrument Programs
If you’re new to MIDI and music on computers, you may want to read the following descript
of how MIDI programs and MIDI channels relate to the musical Instruments you hear when
song is played.

• In MIDI, Instruments are called Programs, and every one of the 16 MIDI channels can h
different Program at any given time. To select the Instrument for a channel, you'll need to
the Beatnik Editor a MIDI Program Change event on that channel. The Instruments are
bered 0 through 127, as they appear in the Instruments window.This is how all of MIDI w
not just the Beatnik Editor.

• In MIDI, Instruments are grouped into Banks of up to 128 Instruments each, and MIDI P
gram Change events always select an Instrument from the current Bank. All Beatnik pla
software includes three different Banks:

Bank 0 is Beatnik’s General MIDI Bank
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Bank 1 is Beatnik’s Special Bank
Bank 2 is the User Bank, containing any Custom Instruments you make

To access these Banks in your sequences, you'll need to send a MIDI Bank Select com
(controller 0) to the Beatnik Editor. For further details, see the heading Program Change and 
Bank Select in the section For Musicians.

Coping with Latency
As mentioned above, there will be a noticeable delay between the Beatnik Editor’s receipt 
MIDI note and the time you hear the corresponding note. This can present some difficulties
here are a few tips on making the best of the situation:

• When recording a MIDI performance into your sequencer, if you want to play on the Be
Editor MIDI synthesizer despite the delay, then make sure your metronome or click trac
also assigned to the Beatnik Editor MIDI synthesizer – otherwise, your live performance
be recorded out of sync with the other tracks.

• Another recording trick: Try reducing the tempo of your sequencer to a very slow speed 
recording your performance, then restore the proper tempo when you’re ready for playb
this works for your playing style, it will minimize the effect of the latency, making it much
easier to stay in time.

• Sync is also an issue when playing your sequence back. Because of the latency, if you 
MIDI sequence with some tracks assigned to the Beatnik Editor synthesizer and other t
assigned to other MIDI instruments, then the tracks assigned to Beatnik will play late – o
sync. So, if exact synchronization is important to you, don’t drive both the Beatnik Editor
thesizer and other MIDI instruments at the same time, from the same MIDI sequence.

Note: Some MIDI sequencers offer instrument-by-instrument lag correction – for exam
Cubase’s ‘delay’ setting. If you really want to align the Beatnik Editor synthesizer with 
other MIDI instruments (and your music has a constant tempo), this feature can be us
compensate for the latency. 

• With enough practice and patience, many musicians have been able to learn to do a pr
good job of compensating for the latency.
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Trademarks

Beatnik’s Trademark Notices 
Beatnik®, Beatnik PlayerTM, Beatnik Xtra ProTM, Beatnik ActionSet ProTM, Beatnik Music 
ObjectTM, Beatnik Basic EZ SonifierTM, Beatnik Action Plug-InTM, Beatnik EditorTM, Beatnik 
Editor ProTM, Beatnik Converter ProTM, Beatnik Audio EngineTM, Mixman®, Mixman Stu-
dioTM, Mixman StudioProTM, Mixman DJ MegamixTM, Mixman RadioTM, D*PlateTM, Mixman 
SingleTM, Mixman Studio VSTTM, My MixzoneTM, Mixman eMixTM, SoundiscTM and the DJ 
Head, Bug, and all other Beatnik logos are either registered trademarks or trademarks of Beatnik, 
Inc. in the United States and/or other countries.

Acknowledgement of Other Parties’ Trademarks
Macromedia, Authorware, Director, Lingo, Flash, ShockMachine, ShockWave, SoundEdit 16, 
and Xtra are trademarks or service marks of Macromedia, Inc. which may also be registered in the 
United States and/or internationally.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpo-
ration in the United States and other countries; Netscape Communicator is a trademark of 
Netscape Communications Corporation, and may be registered in other countries. 

Apple, Mac, AppleTalk, and QuickTime are trademarks of Apple Computer, Inc., registered in the 
U.S. and other countries. Mac OS is either a trademark or a registered trademark of Apple Com-
puter, Inc.

Microsoft, Windows, Internet Explorer, DirectSound, and WebTV are either registered trademarks 
or trademarks of Microsoft Corporation in the United States and/or other countries.

ProTools is a registered trademark of Digidesign, a Division of Avid Technology. Sound Designer 
II is a trademark of Digidesign, a Division of Avid Technology.

Cubase and VST are registered trademarks of Steinberg Soft-und-Hardware GmbH.

Performer, Digital Performer, and FreeMIDI are trademarks of Mark of the Unicorn, Inc.

Vision and Studio Vision are trademarks of Opcode Systems, Inc., a subsidiary of Gibson Guitar 
Corp.

Cakewalk is a registered trademark of Twelve Tone Systems, Inc.

Logic Audio is a registered trademark of Emagic Soft und Hardware GmbH.

Aladdin Systems, StuffIt, and StuffIt Expander are trademarks of Aladdin Systems, Inc. 

All other products and company names mentioned in this document may be trademarks of their 
respective owners.
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